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1.1

Introduction

Eye4Software Hydromagic is an hydrographic survey software tool, which can be used to map areas
using a GPS and echosounder. Use the software to import, view and edit your maps, display your
position and to record depths (create soundings). The software will work with almost any GPS and
echosounder, and can be used on any desktop, laptop or netbook computer running Windows 7 or
higher.

Since version 7.0 there is also the possibility of monitoring dredge operation. In order to use these
features, you need to purchase the Hydromagic Dredging edition as well.

Some application examples:

Record depth data using a GPS and echosounder;

Show your current position and depth on a loaded map;

Convert your soundings to a regularly spaced XYZ data (DTM);

Convert your soundings to different file formats;

Show cross-sections and calculate wlumes;

Design and generate theoretical DTM's (channel design);

Create depth contours and save them as ESRI shapefiles;

Add comments, symbols or routes to your maps;

Perform realtime positioning on research and hydrographic suney vessels;
Fishing industry, for instance to navigate inside the assigned fishing parcels;
View GIS features on shapefiles, CAD and S57 (ENC) data;

UL S

Supported Hardware

Supported Hardware

The list below is just an indication, the software will probably work with more models then the ones that
are displayed below.

Supported Echosounders

NMEAO0183 Compatible Echosounders;
Cee Hydrosystems Ceestar;

Cee Hydrosystems Ceeducer pro;
Elac Hydrostar LAZ4300;

Elac LAZ4100;

Elac STG 721C;

Innerspace Technologies 440S;
Innerspace Technologies 448;
Innerspace Technologies 449;
Innerspace Technologies 455;
Innerspace Technologies 456;
Knudsen 320 series;

Navitronic Navisound 2000;
SyQwest Bathy 500DF;

SyQwest Bathy 500MF;
SyQwest Bathy 1500C;

Simrad EA200 series;
Simrad EA300 series;
Simrad EA400 series;
Simrad EA500 series;
Simrad EA600 series;
STN Atlas Deso 11;
STN Atlas Deso 14;
STN Atlas Deso 15;
STN Atlas Deso 17;
STN Atlas Deso 20;
STN Atlas Deso 22;
STN Atlas Deso 25;
STN Atlas Deso 30;
STN Atlas Deso 35;
STN Atlas Deso 350M;
Reson Navisound 110;

AN N N NN YN N O N N NN
AN N N NN YN N O N N NN
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Ohmex SonarMite;

Odom DigiTrace;

Odom EchoTrac DF3200 MK II;
Odom EchoTrac MK Il

Odom EchoTrac CV100;

Odom EchoTrac CV200;

Odom EchoTrac CV300;

Odom EchoTrac CVM;

Odom HydroTrac;

Odom HydroTrac II;

AN NN N N N N NENEN

Supported GPS Receivers

ANENENENEN

Trimble RTK Receivers;
Supported Tide Receivers

v MGB Tech MTU821-D;
v" MGB Tech MTU821-W;
v Ohmex TidaLite;

v Vyner MK2;

Supported AIS Receivers

AdvanSea AIS RX-100;
Digital Yacht AIS100;
Digital Yacht AIS200PRO;
Digital Yacht AIS200N2K;
Digital Yacht ANT200;
Digital Yacht iAIS;
EuroNav AIS-2-NMEA;
EuroNav AIS-2-USB;
Furuno FA30;

Icom MXA-5000;

Nasa AIS Engine 1;

Nasa AIS Engine 2;

Nasa AIS Engine 3;
Smart Radio SR161;

AN N N N N N NN NN

Supported Motion Sensors

v' TSS1 Compatible Motion Sensors;
v" SBG Systems SBGO01;

Supported Total Stations

NMEAQ0183 Compatible GPS Receiwers;
NMEAO0183 Compatible DGPS Receivers;
NMEAO0183 Compatible RTK Receivers;

Garmin USB GPS receiwers using the PVT protocol;

ANENENENENEN

Reson Navisound 205;
Reson Navisound 210;
Reson Navisound 215;
Reson Navisound 420;
Reson Navisound 630DS;
Unabara Hydrobook
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2.1

v' Total stations supporting the pseudo NMEA GGA format;
v' Total stations supporting the Trimble Geodimeter format;

Configuration

Installation
System Requirements

The software requires a system which is capable of running Microsoft Windows Vista or later. It will not
work on earlier versions of this operating system.

The software is available as both a 32 and 64 bit version. Which one to use depends on the operating
system you are running.

The 32 bit version will run on both 32 and 64 bit operating systems, but when running a 64 bit Windows
version, we recommend using the 64 bit version of the software.

When you are going to post-process soundings (3D, contour generation, matrix generation etc.), we
recommend a computer with at least a dual-core processor and 2 Gigabyte of free RAM. You will also
need sufficient space on the hard disk to store maps, soundings and matrix files.

Installation

To start the installation, and you own a hardlock or dongle, run the setup_hydro_full.exe downloaded
from the website, or from the program CD.

When you want to try the software, and you do not have a dongle yet, you should run the
setup_hydro.exe which is a demo version with some exporting and printing functions disabled.

It is recommended to run the setup program as Administrator, as shown in the image below:

© 2015 Eye4Software B.V.
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Marme Date modified Type Size

| (1 setup_hydrpsw= 22O 2140 DK Anafication 13,606 KB |

f  Edit with Notepad++
p

ﬁ TortoiseSVN k

[ @ Add to archive...
5 g Add to "setup_hydro.rar”

% Compress and email...
g Compress to "setup_hydro.rar”" and email

Restore previous versions
Send to J

Cut
Copy

Paste

Create shortcut
Delete

Rename

Properties

Just follow the steps of the setup program. After setup has completed, the software will start
automatically.

2.2 Activation
Activation
Dongle
Eye4Software Hydromagic is protected against unauthorized use by an (USB) dongle or other software
protection device.
To run this software, the dongle has to be plugged to an USB port, and should not be removed until the
software has been shut down.

Getting version and licensing information

In order to get information on the version used and the licensing status of the product, select the "About

© 2015 Eye4Software B.V.
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Hydromagic..." option from the "Help" menu.

A dialog box will be displayed containing licensing status, dongle serial number (if applicable) as well as
the version and build number.

Please provide this information when contacting technical support.

About Eye4Software Hydromagic Survey “

HYDRONY/\GIC

Eyed4Saoftware Hydromagic Version 7.0.64,50225
Copyright {(C) 2002-2015 Eye45oftware B.V.
http: [fwvew. eyedsoftware, com

Reqistered Version (5/M: 2-2338939)

Visit Wehsite, ., Crder Mow... Activation Code. .,

Dongle Form Factors

When ordering a new Hydromagic license, an USB dongle will be shipped to the address supplied during
the ordering process.

If you don't have any USB ports available for an USB dongle, we can offer the following alternatives:

v PC-Card
v  Express Card
v' CF-Card
v SD-Card
v" micro SD-Card

Please contact sales for more information on these alternatives. Please note that an additional fee may
apply.

© 2015 Eye4Software B.V.
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2.3 Hardware Configuration

2.3.1 Configuring an NMEA0183 compatible GPS
NMEAO0183 GPS and RTK Receivers

The most important device required for this software to work, is a GPS or RTK receiver.
At this moment, all GPS and RTK receivers with a NMEAQ0183 compatible data output are supported.

The GPS is used to get position, elevation, course, speed and information on GPS quality and / or
precision.

When using a RTK receiver in RTK fixed mode, you should be able to get real time tide information as
well.

In order to connect a GPS receiver, you need to hawve at least one available serial port. If there is no port
available,

you can add a serial port by using an USB-to-Serial converter or a NMEA0183 data combiner equipped
with an USB port.

Because an USB-to-Serial convertion can cause minor delays (latency) in the serial communication, we
recommend to use a multiport serial adapter instead.
Multiport serial adapters are available as PCI cards as well as PC-Cards for use in laptops.

In addition to NMEAQ183 data over a serial device, Hydromagic is able to read NMEAQ0183 data over
TCP/IP connections.

This allows you to transfer data over for instance an Ethernet or WiFi connection. Protocols supported
are TCP and UDP.

When using such a converter, make sure it is connected at the time you are going to configure the GPS.
When you have no control on which sentences are sent by the device, it is recommended to only select
the GGA and VTG options in the NMEA0183 settings.

NMEAO183 Echosounders

Most echosounders these days do support their own proprietary output format as well as the more
standardized NMEAO183 protocol.

If your echosounder does not support the NMEAO0183 protocol, you should be able to configure it using
one of the plug-ins shipped with Hydromagic.

© 2015 Eye4Software B.V.
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In order to connect an echosounder, you need to have at least one available serial port. If there is no port
available,

you can add a serial port by using an USB-to-Serial converter or a NMEA0183 data combiner equipped
with an USB port.

When using such a converter, make sure it is connected at the time you are going to configure the
sounder.

In addition to the serial communications setup, you also have to check the echosounder offset
configuration.

Supported NMEAQO183 sentences for GPS devices

Hydromagic is able to decode the following NMEAQ0183 sentences used by GPS and RTK devices:

| Sencenee 1 [bescription ]

$GPGGA Global Positioning System Fix Data, Time and Position
$GPGLL Geographic Position - Latitude and Longitude
$GPGSA GPS DOP and Active Satellites

$GPGSV Satellites in view

$GPRMC Recommended Minimum Navigation Information
$GPVTG Track Made Good and Ground Speed

$GPZDA GPS Time

$PTNL,GGK Trimble RTK positioning data and ellipsoidal height

Supported NMEAO183 sentences for sounders

Hydromagic is able to decode the following NMEAO0183 sentences used by echosounder devices:

[ Sentanee ] [Beseription ]

$SDDBK Depth below keel
$SDDBS Depth below surface
$SDDBT Depth below transducer
$SDDPT Depth and keel offset

Configuration

To add a NMEA0183 compatible device to the configuration,
select "Preferences..." from the "Options" menu and select the "Devices" tab:

© 2015 Eye4Software B.V.
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| Devices

In the devices tab, click the "Add..." button to load a NMEAO0183 plugin.
You can load a maximum of four NMEA0183 plugins at the same time.

© 2015 Eye4Software B.V.
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Select Device “
Driver Filename Version e
CEE HydroSystems CEESCOPE plugin Ceescope.dl 7.0.64, 50306
ELAC Hydrostar LAZ4300 Echosounder Plugin LAZ4300.dll 7.0.64, 50306
ELAC LAZ4100 Echosounder Plugin LAaZ4100.dll 7.0.64.50306
Garmin LISE PYT plugin for Hydromaagic garminush, dll 7.0.64, 50306
Geodimeter Total Station Plugin Geodimeter.dl 7.0.64, 50306
Hydromagic AIS plugin AIS.dll 7.0.64,50306
Hydromagic LadderSensor Plugin £1 LadderSensor 1.4l 7.0.64, 50306
Hydromagic LadderSensor Plugin £2 LadderSensorZ.dll 7.0,64, 50306
Hydromagic LadderSensar Plugin #3 LadderSensor3.dl 7.0.64. 50306
Hydromagic MMEAD 183 plugin #2 nmeai0oo 2. di 7.0.64, 50306
Hydromagic NMEAD183 plugin #3 nmeal003. dil 7.0.64, 50306
Hydromagic MMEAD 183 plugin #4 nmealtoo4, dil 7.0.64, 50306
Hydromagic Simulator Plugin Simulator. dil 7.0.64,50225
InnerSpace 443 Plugin for Hydromaagic InnerSpace44s.di 7.0.64,50306
Knudsen 320 Plugin for Hydromagic Knudsen320.dll 7.0,64, 50306
OceanSdence Z-Boat Plugin for Hydromagic zboat.dll 7.0.64.50306
Odom DigiTrace Plugin for Hydromagic DigiTrace. dll 7.0.64, 50306
Midnm FrhnTrar SATORT Blonin far Hudramanic ErhrTrar Al 7n 64 snane Y
| & OK I # Cancel

Next, select the first available NMEA0183 plugin in the "Select Device" dialog that appears after clicking
the "Add..." button

Device Settings

After the plugin has been loaded, a configuration dialog is displayed where you can pass the required
information to the plugin.

© 2015 Eye4Software B.V.
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Connection Type

The NMEAO0183 plugin supports two types of connection types: serial and TCP/IP.
When a device is connected through an USB or serial connection, you select the "Serial" option.

In cases where the device is connected using an Ethernet cable or WiFi connection,
you have to select the "TCP/IP" option from the "Connection Type" drop down box.

When switching between the "Serial" and "TCP/IP" connection type, the function of the edit and
selection boxes in the "Connection" section will change as can be seen in the two screenshots abowe.

Serial Port

Use this drop down box to select the COMxx number of the serial port the device is connected to.
This can be either a regular serial port, or a virtual serial port, which are used with USB to Serial and
Bluetooth adapters.

Serial Speed

The default serial baudrate for NMEAO0183 devices is 4800bps. However, some hardware use other
speeds (for instance, an AIS receiver will use 38400).

When configuring a RTK receiver, the serial speed can sometimes deviate from the standard. 9600,
19200 and 38400 bps are mostly used on these devices.

Serial Format

You can leawe this setting at it's default value. Devices that use NMEAO0183 protocol with other settings
are very rare.

Socket Type

Use the "Socket Type" dropdown box to select the TCP/IP protocol used. Possible values are "TCP" and
"UDP".

Please refer to the hardware vendor on which option is supported. Most devices support both protocols.

Host IP

The IP address of the device. This value is required only for TCP connections.
For UDP connections, just provide a valid port number.

Host IP Port

Enter the IP (TCP or UDP) port number the device is listening on here.
For most wireless NMEAQ183 devices, the port 10110 is used, which is the reserved port for NMEA0183.

Latency
Latency (sometimes called lag) is the time between a measurement has been made (for instance a
position fix, or depth) and when the serial data is received by the application.

If this value is know for a certain device, you can enter it here to get more accurate soundings.

NMEAOQ0183 Settings

© 2015 Eye4Software B.V.
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CRC Check

Some devices support a NMEA0183 CRC checksum. If you want to make use of this, enable this option.
When a sentence does not contain a CRC, the CRC check will be skipped, so it is safe to leave this
feature on.

Talker ID

Use this option to filter NMEAO0183 sentences by talker ID. It sometimes happens that both echosounder
and GPS devices are transmitting GPS sentences, in this case you can either select the GPS or
echosounder by specifying "GP" or "SD" in this field.

Sentences

To select which NMEAO0183 sentences will be decoded, and which ones will be ignored on this channel,
click the "Select sentences..." button.

The dialog that appears allows you to select which sentences are used. For most GPS devices,
selecting only the GGA sentence will suffice.

If you choose to use the heading and speed calculated by the GPS device, you should also select the
VTG sentence.

For a echosounder, you should use either the DBS, DBT, DBK or DPT sentence.

NMEAOD183 Sentences
o GGA GP5 - Global Positioning System Fix Data
o GLL GP5 - Geographic Position, Latitude [ Longitude
o RMC GPS - Recommended minimum specfic GP5/Transit data
af VTG GP5 - Track made good and ground speed
o DA GPS - Time and Date
of GsA GPS - GPS DOP and active satellites
o Gov GPS - GPS satellites in view
o GGK GP5 - Trimble: Time, position, position type and DOP
o DEBK Echosounder - Depth below keel
of DBS Echosounder - Depth below surface
o DET Echosounder - Depth below transducer
& DPT Echosounder - Depth and transducer offset
o HDG Heading - Heading Deviation and Variation
o’ HDM Heading - Heading Magnetic
& HDT Heading - Heading True
&) Select Al || &) Select None & 0K ¥ Cancel

© 2015 Eye4Software B.V.
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Testing the device(s)

When ewverything has been configured correctly, and the device has been turned on, you should have
some green values in the data view window.

Mavigation Data x

Latitude N 51.203878
Longitude E 004.357623

Northing 5673373.12
Easting 0594843 .86

Sounder Hi 200m
Northing 0210434 54 SounderLo  2.00m
Easting 0149221 83 Corrected  2.00 m

Serial Communications Monitor

You can always check whether data is coming in by running the serial communications monitor.

To start this monitor, select the "Preferences...” option from the "Tools", and select the "Devices" tab.
Select the device you want to monitor and click the "Monitor..." button.

2.3.2 Configuring hardware using plugins
Using Plugins

By default, Hydromagic can be used with most NMEAQ0183 devices.
To add support for devices not using the NMEAQ183 protocol, plugins are used.

Plugins are small programs that are loaded into the memory when Hydromagic starts.
The main advantage of using plugins, is that the main program hasn't to be replaced each time a new

device is used.
Instead, a new plugin is installed and loaded by the main program.

© 2015 Eye4Software B.V.
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Plugins are installed into the "Plugins" folder in the installation directory during setup.
Both the Hydromagic Suney and Hydromagic Dredging editions share the same plugins.

Configuring Plugins
To configure and select the plugins to use, you can open the plugins configuration window by selecting

the "Preferences..."” option from the "Tools" and selecting the "Devices" tab. The following window should
appear:

Map | Miscellaneous | Alarms | ECDIS
Units and Formats | Devices | Calibration

Device

Q Hydromagic Simulatar Plugin

ﬂ Hydromagic AIS plugin

@ Hydromagic NMEAD 123 plugin 21
o Hydromagic NMEAD 183 plugin #2

@ Add... ,;;;J Remove... || & Corfigure.., | B2 Monitor...

ok || Cancel Apply

The "Devices" tabs displays the currently loaded plugins along with their status.
When opening this tab for the first time, it will probably be empty.

The status of the plugins is displayed by icons and can have one of the following values:

& Running The plugin is running and is receiving valid data from the hardware

© 2015 Eye4Software B.V.
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Waiting for data

i The plugin is running and is currently waiting for data.
& Eror

The plugin failed to load because either the serial port could not be opened,
or a TCP connection could not be established with a TCP/IP device.

Adding a plugin

To add a plugin, simply click the "Add..." button and select the desired plugin from the list that appears
next.

Please note that each plugin can only be loaded once, meaning that as soon as a plugin has been
loaded,
it won't be displayed in the list of available plugins anymore.

After selecting the plugin to load, depending on the plugin, the configuration options of the plugin are
displayed.
Configure the mandatory options such as serial port or TCP/IP connection and click "OK" to confirm.

Select Device EX
Driver Filename Versiaon iad
CEE HydroSystems CEESCOPE plugin Ceescope.di 7.0.64, 50306
ELAC Hydrostar LAZ4300 Echosounder Plugin LAZ4300.dll 7.0.64, 50306
ELAC LAZ4100 Echosounder Plugin LAZ4100.dll 7.0.64,50306
Garmin USE PVT plugin for Hydromagic garminusb. dll 7.0.64.50306
Geodimeter Total Station Plugin Geodimeter.dl 7.0.64,50306
Hydromagic LadderSensor Plugin #1 LadderSensor 1.dll 7.0.64, 50306
Hydromagic LadderSensar Plugin £2 LadderSensor2.dl 7.0.64,50306
Hydromagic LadderSensaor Plugin £3 Laddersensor3.dl 7.0.64, 50306
Hydromagic MMEAD 183 plugin #3 nmead003, dil 7.0,64, 50306
Hydromagic MMEAD 183 plugin #4 nmeal004, dil 7.0.64, 50306
InnerSpace 443 Plugin for Hydromagic InnerSpace44s.di 7.0.64, 50306
Knudsen 320 Plugin for Hydromagic Knudsen320,dll 7.0.64, 50306
Orcean5cence Z-Boat Plugin for Hydromagic zhoat.dl 7.0.64,50306
Cdom DigiTrace Plugin for Hydromagic DigiTrace. dil 7.0.64, 50306
Odom EchoTrac SET/DET Flugin for Hydromagic EchoTrac.dll 7.0.64, 50306
Cdom ME3 Ethernet Plugin for Hydromaagic OdomME3.dl 7.0.64,50306
Chmex SonarLite Plugin for Hydromagic SonarLite.dl 7.0.64, 50306
Ohmex SonarMite Plugin for Hydromagic SonarMite. dll 7.0.64.50306
Dhmew Tidal ite Tide Barsiver Bhinin Tidal ite All TN A4 BNAA o
# Cancel

Configuring a plugin

It is possible to change the configuration of a plugin after it has been loaded.
Just select the plugin in the list and click the "Configure..." button.

© 2015 Eye4Software B.V.
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When the connection parameters has been altered, it is required to restart the plugin.
The software will detect this automatically and ask you whether to restart it or not.

Removing a plugin

Plugins can be unloaded from the memory when no longer needed.
To unload, select the plugin you want to remove and click the "Remowe..." button.

Reloading a plugin

When a plugin has failed to load or isn't working properly because of faulting hardware,
you might want to try to reload the plugin after you fixed the problem.

To do so, right click on the plugin and select the "Reload Plugin" option as shown below:

Map | Micellaneous | Alarms | ECDIS
| Devices | Calibration

[+ Hydromagic AIS plugin €9 Add Device...
ﬂ Remave Device...
j Configure Device...

@ Monitor Device..,

2 Reload Plugin

Troubleshooting

16
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When a plugin fails to load for some reason, an error icon is displayed.

To get more information on what caused the plugin to fail, you can check the Event Log.

The Event Log can be displayed by selecting the "Show Event Log..." option from the "Help" menu.

In most cases, the plugin could not be loaded because either the serial port is already in use,

or in case of a TCP/IP connection, the connection was blocked by a firewall.

Monitoring Serial Communications

When a plugin has been started successfully, but incorrect or no data is displayed in the Data View,

you can check the incoming serial or TCP/IP data using the "Serial Communications Monitor".

To start this monitor, select the plugin to monitor and click the "Monitor..." button.

You can change the device to be monitored by using the selection box.

Serial Communications Monitor
Received o
[18:41:02.752] |ATVDM, 1,1,,B, 133A 1200000r8BVP 3p<FCs:02D 1U,0%25
[18:41:02.746] |AIVDM, 2,2,7,A, 38858888380, 2723
[18:41:02,740] 1AIVDM, 2,1,7,A,58157 " D2D6veKLA3: 21= @V 18u@PESPU @PF 2222 1@BhREG4n;0ALUDME354hHE, 0207
[18:41:02.734] |AIVDM, 2,2,5,A,AhH383863838880, 2773
[18:41:02.725] 1AIVDM, 2,1,5,A, 58157 D2DGvekLA3: 21=@V 18U @PESPU@PF 2222 1@BhREG4n; 0AUDME35,0%5C
[18:41:02.722] 1AIVDM, 1,1,,B,H3uUILQMMNgHTp@H58Trg <D000, 2%31
[18:41:02.245] IAIVDM, 1,1,,A, 13ug5J0vhD0OnEC)QOI2N3B710° RQ, 0¥51
[18:41:02.241] |ATVDM, 2,2, 1,B,wvwt,0=15
[18:41:02.233] |AIVDM, 2, 1, 1,B,802R SPhOGhGP <aWfR =Db 21 15hf0SEuOwggw =wnSwe DwwwawwwsAwwnsom, 0%65
[18:41:02.235] |AIVDM, 2,2,7,B,wvwt, 0510
[18:41:02.237] 1AIVDM, 2, 1,7,B,802R SPhOGhK2niVITEDD 18et?ROSEUOwWgggswnSwe FwwwwwwsAwwnSom, 0= 1F
[18:41:02.228] IAIVDM, 2, 2,4, A, wwwit, 0510
[18:41:02. 22351 1ATVDM.?_1.4_4 807R SPhGhKRniVITENR 18e17R IAFCwnanswnSwes TumwwwwwsAwwnSom 0 *1F e
Hydromagic AIS plugin LY Q Clear = Pause
2.4 Dredging Configuration
24.1 Dredging hardware

Configuring dredging hardware

In order to calculate dredging depths and to show the actual position of your dredging equipment,
hardware like inclination, pressure, motion and tilt sensor might be needed.

Sensors are configured by using plugins. Depending on the sort of dredger, one or multiple plugins have
to be loaded.

In addition to loading the plugins, you might have to select which sensor is attached to which segment of
your dredging equipment (ladder, tube, vessel...).

Assignment of the sensors is done in the configuration screen for your dredger, and can be found in the
following chapters of the manual.
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More information on some of the plugins shipped with Hydromagic can be found in the "Plugins" chapter.
Loading dredging sensor plugins

To select the plugins to be loaded, select "Preferences..." from the "Options” menu, and select the
"Devices" tab.

Click the "Add..." button to show a list of available plugins and select the plugin to load.

When you want to load multiple plugins, just repeat the step abowve until all plugins are loaded.

Unloading dredging sensor plugins

When a sensor is no longer needed, you can unload the plugin as follows:
Select "Preferences..." from the "Options" menu, and select the "Devices" tab.
Next, select the plugin you want to unload and click the "Remowe..." button.

Single segment cutter dredger

Single segment cutter dredger

To setup Hydromagic Dredging for use on a single segment cutter dredger, make sure you have loaded
the required plugins as described in the previous chapter.

When all plugins are loaded and configured, proceed to the dredging preferences by selecting
"Preferences..." from the "Options" menu and clicking on the "Dredging" tab:
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[ Preferences ﬁw
Miscellaneous | Map | ECDIS | Alarms

Units | Devices | Dredgng | RIK | Grid

Dredger Setup

Dredager Type: Cutter Dredger Single Ladder -

E 6,; Corfigure dimensions and sensaors...

Dredaging Logs

Minirmum depth: 0.50 meter

Logging interval: 5 seconds

[ K ] [ Cancel Apply

i

Select dredger type

Select the dredger type, which is a "Cutter Dredger Single Ladder", from the drop-down list,
and click the "Configure dimensions and sensors..." button to proceed with the configuration.
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i B
Cutter Dredger with single ladder I&J
Ladder
Length: 11.25 Meters
Vertical sensor; Hydromagic LadderSensor Plugin #1 + [ |Reversed
Horizontal sensor: Hydromagic LadderSensor Plugin #1 -+ [ |Reversed
Vesszel Shape File; vessel_3d,xml
Ladder Shape File: ladder_3d. xmi
Browse... l & Editor...
Dimensions
Draft: 0.61 Meters
Dredge Head (Width):  0.00 Meters
Dredge Head (Height): 0.00 Meters
The "Wessel Shape File' can be selected under "Preferences” == "Map”.
g Draftis the height difference between the ladder and the water surface.
[ Aams... | Eo OK H X Cancel I
L

Entering the dredging parameters

To calculate the correct dredging depth and to display the dredging vessel in one of the digging views,
you have to set some dredging parameters,

such as ladder length, the plugins used to get the sensor data as well as the Vessel Designer shapes.

Ladder length

It is important to enter the correct ladder length. Entering an incorrect value here will result in calculating
an invalid dredging depth !

Sensors

Use the dropdown boxes to select the sensor used for the vertical and horizontal motion of the ladder.
Please note that some sensors can provide both a vertical and horizontal motion. In this case, select the
same plugin for both sensors !

Vessel shape files

The shape files can be generated using the Vessel Designer which is shipped with the Hydromagic
software.
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It allows you to import a 3D vessel shape from AutoCad, modify it and conwert it to a vessel shape file.

When generated shape files, please note that the units hawve to be in units.
To start the "Vessel Designer”, simply click the "Editor..." button.

Without shape files, the dredging depth will be calculated, and the vessel's position will be shown
on the map, but you won't be able to use the digging views.

Software Configuration

Echosounder Offset

Introduction

The echosounder offset can be used to correct the difference between the depth outputted by the
echosounder, and the real depth.

This offset is also called static or fixed draft. Dynamic draft (depending on the speed of the vessel) can
be corrected when processing your raw data files.

The transducer of the echosounder measures the water level from the bottom of the transducer to the
bottom of the river.

The height of the water which is above the bottom of the transducer has to be added to the echosounder
output, and can be entered here.

Most echosounders have the option to enter the distance between the water surface and the transducer,
so in this case you do have to disable this option, or you can use it for other corrections.

Entering the echosounder offset

To enter an offset for the echosounder, select "Preferences..." from the "Option" menu.
In the dialog that appears, select the "Calibration" tab. You should see the following dialog:
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Unitsand Formats |  Devices | Calibration

Echosounder Calibration

Apply echosounder offeet (fixed draft)

Transducer offset; | 0,30 Meters

Motion Calibration

[| Echosounder outputs heave corrected depths
IUse motion sensor offsets

Heave offeet: 0.00 Meters

Pitch offset: dearees

Roll offset: dearees
@ Reset ||© set

Heading Sensors

Ise True heading (GPS)

The value entered is added to the depth (both high and low frequency depths) reported by the
echosounder.

To subtract from the sounders value (in case of depth below keel), just prefix the value with the minus
sign "-".

To disable the correction, just remowve the tick from the "Apply Echosounder Offset" checkbox,
or click the "Reset" button to load the defaults.

Raw data files

Please make sure the echosounder offset is measured and entered into the software before
recording any data.

The depth written in the raw data files is the depth corrected with the echosounder offset !

Using RTK
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When you are measuring the elevation of the river bed using a RTK receiver, and the offset between the
transducer and GPS antenna is fixed, you can just enter this offset in the RTK settings tab.

Howewer, we recommend to fill out both the antenna and transducer offset separately in case you ever
need the absolute water depths.

NMEAO0183 compatible echosounders

When using a NMEAOQ183 compatible echosounder, whether to enter an offset depends on the
NMEAO0183 sentence(s) used to retrieve the depth data.

$SDDBK Depth below keel Enter the distance between the keel of the ship and the water
surface.

$SDDBS Depth below surface No correction is needed, as the depth is measured from the
water surface.

$SDDBT Depth below Enter the distance between the transducer and the water
transducer surface.
$SDDPT Depth The offset configured in the echosounder is used.

Motion sensor calibration

Motion sensors

Since Hydromagic version 6.0, the software has built in support for motion sensors.
Motion sensors can be used to correct your soundings for heawe, pitch and roll.

In Hydromagic, motion sensors are configured using hardware plugins supplied with the software.
Supported devices include Teledyne TSS, SBG Systems, IMU and compatible hardware.

Motion sensor calibration

A motion sensor can be calibrated in the "Motion Calibration" section of the preferences window.
To open this tab, select "Preferences...” from the options menu, and select the "Calibration” tab.

The following window should appear:
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Preferences “

Map Miscellaneous Alarms ECDIS Grid
Units and Formats Devices Calibration RTK

Echosounder Calibration

Apply echosounder offset (fixed draft)
Transducer offset; | 0,30 Meters

@ Reset
Motion Calibration

[| Echosounder outputs heave corrected depths
Use motion sensor offsets

Heave offset: 0.00 Meters
Pitch offset: 0,00 dearees
Roll offset: 0,00 dearees

@' Reset gj} Set
Heading Sensors

Ise True heading (GPS) W

Cancel

15
=

Echosounder heave offset

Heawe is used to correct the vertical motion of the vessel, caused by for instance, waves.

It is important to disable heave compensation by a motion sensor when heawe is corrected within the
hydrographic echosounder.

For this, select the "Echosounder outputs heave corrected depths" check box. The heave offset box will
be disabled.

Motion sensor offsets

To use offsets for your motion sensor, or to tare / calibrate your device,
enable the offsets by checking the "use motion sensor offsets" check box.

Use the motion sensor offset fields to correct the roll (x), pitch (y) and heave (z) offsets outputted by a
motion sensor.

Enter the heawe offset in the vertical units used by your project (normally meters), the pitch and roll
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offsets are always in degrees.

In case you want to tare your sensor, just click the "Set" button to set all values automatically
when the sensor is connected and the vessel is stable (for instance when docked).

To disable calibration, click the "Reset" button to set all values to their defaults.

When done, just click "OK" to apply the values. In the data view the heawe, pitch and roll values should
now contain valid values.

Vessel shape and offsets

Introduction

Using the built in "Vessel Editor" you can specify how the vessel should be drawn on the map. It also
allows you to set the exact location of the sensors, like transducer and GPS antenna.

The position of the sensors is used to calculate the offset between the GPS position and the transducer
position when the vessel's heading is known.

The vessel Editor

To start the "Vessel Editor" utility, open the preferences dialog by selecting "Preferences..." from the
"Options" menu.

In the preferences dialog, select the "Map" tab, and click the "Editor..." button as shown in the
screenshot below:

© 2015 Eye4Software B.V.



Configuration 26

Units and Formats | Devices | Calibration
Map | Micellaneous | Alarms | ECDIS

Distance Rings
Show distance rings
Ring Interval

Ring Calor:

Course Line
[ ]5how course line
Line Calar:

Line Width:

Miscellaneous

Show scale on map Show Morth-indicator

Map Background

Lse the following map background color;

Vessel shape, color and offsets

File: | C:'\ProgramData'HydroMagiciyesselwessel3, xml |

Color: || ||E| ||_-'1 Browse... ||.g.5’ Editar... |

The vessel editor will be started and will display the vessel as specified in the "File" field. If no vessel file
has been specified yet, it opens with a blank project.

You will notice three circles labeled "TXD", "PIV" and "GPS". The "TXD" circle can be dragged onto the
ship to mark the location of the transducer, the "GPS" circle is used to mark the location of the GPS
antenna.

The "PIV" circle is used in the dredging version only, and is used to mark the location where the dredging
equipment is mounted to the vessel.
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a Eye4Software Hydromagic - Vessel Editor - o IEH

File VWiew Maodify Options Cursor Help
DEH R L L L@ EIERIN Y [k
Object View 2@ | . & a F i
E|_ Vessel

=+l Shapes
£ | Polyline
..... % -3.75,+10.00,+0.00
..... 1 -1.25,+15.00,+0.00
..... T +1.25,+15.00,+0.00
..... % +3.75,+10.00,+0.00
..... * +3.75,-10.00,+0.00
% -3.75,-10.00,+0.00
..... % -3.75,-7.50,+0.00
..... % -3.75,+10.00,+0.00
=~ | Polyline
..... 1 -2.50,-7.50,+0.00
..... 1 +2.50,-7.50,+0.00
..... T +2.50,-0.00,+0.00
..... 1 -2.50,-0.00,+0.00
..... 1 -2.50,-7.50,+0.00
=- . Polyline
..... 1 -1.25,+1.25,+0.00
..... 1 +1.25,+1.25,+0.00
..... 1 +1.25,+10.00,+0.00
..... 1 -1.25,+10.00,+0.00
..... 7 -1.25,+1.25,+0.00

() W
518

3Kl

Ready X -15.00¥: +5.00 M/A M/A

Loading designs

Hydromagic is shipped with a couple of example vessel files. To load one of these files into the vessel
editor, select the "Open Design..." option from the "File" menu.
By default, all vessel designs are stored in the "C:\ProgramData\Hydromagic\Vessel" folder.

Importing AutoCAD drawings

it is possible to design your vessel shape in AutoCAD and import it in the Vessel Designer. Make sure
you use meters as units in AutoCAD, and the center of the ship is at coordinate 0,0.

From AutoCAD, sawe your design as DXF file, and import it into the Vessel Designer by selecting "Import

DXF" from the "File" menu.

Adding and modifying features

To add a line segment or polygon to the design, select "Draw Polyline" from the "Cursor" menu.
To change the location of a single point, you can either drag the point around using the mouse, or alter
the coordinates manually by right clicking the point, and select the "Edit Vertex..." option.

Removing features
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Existing segments can be modified by using drag and drop. To remowve features from the design, right
click on the shape in the "Object View" windows, and select "Remove Polyline".

To remowe a single point (vertex) from a line segment or polygon, right click the point and select the
"Remowve Vertex..." option from the context menu.

Grid options
To change grid options, select "Grid" from the "Options™ menu. Using the grid options, you can display a

grid which can be used as guidance when placing objects.
The grid can also be used to snap objects to, both options can be enabled or disabled.

Grid _

Grid Spacing

¥-Spadng: | 2.50 meters
Y-Spacing: | 2.50 meters

Draw and Drag

Snap to grid
X-Spadng: | 2.50 meters
Y¥-Spadng: | 2.50 meters

oK Cancel

Saving designs

After the design has been completed, and the GPS and transducer locations have been selected, you
can sawe your design by selecting "Sawe Design..." from the "File" menu.

Now you can close the "Vessel Editor" and select the design in the Hydromagic Survey software. When
a valid GPS position is available, the ship will be drawn on the map using the specified vessel shape:
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254 System Settings
System Settings

The system settings window allows you to adjust some system wide settings, such as date and time
formats and power saving behaviours.

To access the system settings window, first select the "Preferences..." item from the "Options" menu to
open the preferences dialog.

In the preferences dialog, select the "Miscellaneous” tab, and click the "Setup..." button in the "System
Settings" section as shown below:
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Units and Formats | Devices |

Map | Miscellaneous | Alarms |

Mavigation View

Click the "select...” button to specify which values
should be wvisible in the Navigation View window.

Map Footer

Setup which additional data to display
upon printing of the map.

Chart annotation

Setup chart annotation for echosounders
which suppaort this feature.

Auto Save

Enable a timer to save your work periodically
to prevent data loss.

System Settings

System settings, like date/tme formats,
sreensavers etc.

The system settings dialog

After clicking the "Setup..." button, the following dialog appears:

30
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System Settings “
Windows Screensaver

Disable Windows Screensaver activation

When this option is chedked, the Hydromaagic software protects the Windows
Screensaver from activating, Please note that this option will anly work when the
default Windows Screensaver without password protection is used,

Windows Powersaver

[«| Disable Windows Powersaver activation;

When this option is checked, the Hydromaaic software protects the
Windows QOperating System from putting the monitor into sleep,
It does not pratect from putting the system into sleep or standby mode,

Time Farmats

This function lets you define the date and time formats used in

dizlogs, views and logfiles. o Setup..

w 0K # Cancel

Windows Screensaver

When the "Disable Windows Screensaver activation” option has been selected, Hydromagic prevents
Windows from starting the screensaver as long as the Hydromagic application has focus.

Please note that this option only works when a screensaver without password protection is used. This
options prevents situations where your screen blanks when you do not touch the mouse or keyboard for
some time when performing a survey.

Windows Powersaver

When the "Disable Windows Powersaver activation" option has been selected, Hydromagic prevents
Windows from putting the monitor or laptop display in sleepmode as long as the Hydromagic application
has focus.

This options prevents situations where your screen blanks when you do not touch the mouse or
keyboard for some time when performing a suney.

Time Formats
Use this option to specify the time and date formats used in Hydromagic for log files, exported ASCII

data, screendumps and printing.
Click the "Setup..." button to access these settings.
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Time and Date Formats “

Date and Time Formats

Language: English (United States) ¥
Date (short): Mfdfyyyy ¥

Date (Jong): dddd, MMMM d, yyyy (v

Time:; h:mm:ss tt W

Preview

Date (short): 3/10/2015
Date (Jong): Tuesday, March 10, 2015

Time: 0:50:03 PM

You can use this dialog box to set your preferences for date and time
vy formats that are used throughout the software and exported data.

L Cancel

To change the time and date formats, select your language and country using the "Language" selection.
After selecting the language, the dialog displays the possible date and time formats for this language.

You can preview the settings in the "Preview" pane. To apply the settings, click "OK".

2.6 Geodesy Configuration
2.6.1 Manage Ellipsoids

Introduction

To open the "Manage Ellipsoids" window, select "Options" => "Coordinate Systems" => "Manage
Ellipsoids..." from the menu. Using this window, you will be able to view, delete or modify existing
ellipsoid definitions, or to add your own. For a list of ellipsoids that are already in the database, click
here.
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Select Ellipsoid | x |

Select Ellipsoid

EPSG Ellipsoid £

7018 Everest 1330 Modified

f019 GRS 1980

7020 Helmert 1908

7021 Indonesian Mational Spheraid

International 1924

7024 Krassowsky 1940

7025 MWL 9D

WY Mlammine 104°F X

& Add & Modfy || & Delete...

Ellipsoid Properties

Ellipsoid Mame: International 1'524
Semi-major Axis: 6378338.000 @
Inverse Flattening: | 297.00000000000000 NG

Click here for a list of most commonly used ellipsoids around the waorld

.ﬁ? oK .ﬁ Cancel

Ellipsoid List

When clicking an item in the list, its parameters are displayed below the list. You can edit these
parameters by clicking the "Modify" button.

Deleting an ellipsoid

You can delete an ellipsoid definition, by selecting an item from the list and clicking the button "Delete".
The software will show a popup to confirm that you are sure you want to delete. Please note that you
cannot delete ellipsoids that are used in a datum definition.

Modifying an ellipsoid

You can modify an ellipsoid by clicking the "Modify" button after you selected an ellipsoid from the list.
After clicking the button, the "OK" button text will change to "Sawe". Clicking the "Sawe" button will save
the modifications, clicking "Cancel" will keep the old data.

Adding an ellipsoid

To add a new ellipsoid definition, click the "Add" button. When adding a new definition, it is required to
specify a name for this ellipsoid, otherwise it cannot be saved. Other required fields are "Semi-Major
Axis" and "Inverse Flattening". Click the "Sawe" button to store the newly created ellipsoid, by clicking
cancel the input is ignored and you will return to the list.
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2.6.2 Manage Map Datums

Introduction

To open the "Manage Datums" window, select "Options” => "Coordinate Systems" => "Manage Map
Datums..." from the menu. Using this window, you will be able to view, delete or modify existing datum
definitions, or to add your own. For a list of datums that are already in the database, click here.
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Datumn Selection

EPSG Datum

4202 AGDEG
AGDES (NTv2)
4203 AGDE4
[ | AcDs4 (nTv2)
4901 ATF (Paris)
4122 ATS77
4143 Abidjan 1987 i

@ Add || Modfy | | @ Delete. |

Datum Properties

Name: | AGD84 (NTv2)
Ellipsoid: | Australian Mational Spheroid

Prime Meridian: | Greenwich

Conversion Properties

Conversion: NTw2

Grid File: | National 84 (02.07.01).asb

Translation ¥: 0.000 | {meters)

Translation ¥: 0.000 | {meters)

Translation Z: 0,000 | {meters)

Rotation : 0.000 | {arc seconds)

Rotation Z: 0.000 | {arc seconds)

Scale Factor:

|
|
|
RotationX: | 0.000 | (arc seconds)
|
|
|

0.000000 | (ppm)

Click here for a list of most commonby used geodetic datums around the word

& OK || X Cancel |

Supported Transformations

In Hydromagic, you need to set the transformation parameters to convert to WGS84 for each newly
created datum. The following transformation methods are supported:

v" None (no transformation needed);
v" Molodensky (3 parameters);
v' Bursa Wolf (7 parameters);
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v NADCON;

v HARN/HPGN;
v NTW2.

Grid Files

The last three methods mentioned above do not require parameters, but you have to specify a valid grid
file. For NADCON and HARN/HPGN, files for North America are shipped with the product. To add your
own NADCON, HARN or NT\2 files, just copy the file to the "NADCON" or "Ntv2" folder in the "Program
Data\Hydromagic" installation directory.

S A

MNadcon

SN

Home Share View 0
= ut R R, 5 B selectall
== |Mu) Copy path o i - '—7""( select none
: b Paste short Copyto  Rename Prop'erties UEI Invert selection
1ar £ = el
"’(_j) - 7T « HydroMagic » MNadcon v O Search Madcon 2
alaska.las ethpgn.las @ lahpgn.las nehpgn.las schpgn.las wohpgn.las
|| alaska.los || ethpgn.los |_|lahpgn.los |_|nehpgn.los |_|schpgn.los |_|wohpgn.los
alhpgn.las flhpgn.las mdhpgn.las njhpgn.las sdhpgn.las wshpgn.las
| |alhpgn.los | |flhpgn.los |_|mdhpgnlos | |njhpgn.los || sdhpgn.los | |wshpgn.los
arhpgn.las gahpgn.las mehpgn.las nimhpgn.las stgeorge.las wthpgn.las
|| arhpgn.los |_|gahpgnles | |mehpgnlos | |nmhpgnlos | |stgeorgelos | | wthpgn.les
azhpgn.las hawaii.las mihpgn.las nvhpgn.las stirnc.las wwhpgn.las
|_|azhpgn.los || hawaii.los |_|mihpgn.los |_|nvhpgn.los |_|stlrnc.los |_|wvhpgn.los
cnhpgn.las hihpgn.las @mnhpgn.las nyhpgn.las stpaul.las w_b,rhpgn.las
|_|enhpgn.les || hihpgn.los |_|mnhpgnles | |nyhpgn.los |_|stpaul.los |_|wyhpgn.los
cohpgn.las iahpgn.las mahpgn.las ochhpgn.las tnhpgn.las
|| cohpgn.los | |iahpgn.los | |mohpgnlos | |ohhpgn.los |_|tnhpgn.los
conus.las ilhpgn.las mshpgn.las okhpgn.las uthpgn.las
|_|conus.los __|ilhpgn.los |_|mshpgnlos | | ckhpgn.les |_|uthpgn.los
cshpgn.las inhpgn.las nbhpgn.las pahpgn.las vahpgn.las
|_|cshpgn.los |_|inhpgn.los |_|nbhpgn.los |_|pahpgn.los |_|vahpgn.los
emhpgn.las kshpgn.las @ nchpgn.las prvilas wihpgn.las
__|emhpgnles | kshpgnlos | |nchpgn.los || prvilos |_|wihpgn.los
eshpgn.las kyhpgn.las ndhpgn.las pvhpgn.las wmhpgn.las
|_|eshpgn.los | |kyhpgnlos | | ndhpgn.los || pvhpgn.los | |wmhpgn.los
110 items o[~
Datum List

When clicking an item in the list, its parameters are displayed below the list. You can edit these
parameters by clicking the "Modify" button.
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Deleting a datum

You can delete an datum definition, by selecting an item from the list and clicking the button "Delete".
The software will show a popup to confirm that you are sure you want to delete. Please note that you
cannot delete datums that are used in a grid definition.

Modifying a datum

You can modify a datum by clicking the "Modify" button after you selected a datum from the list. After
clicking the button, the "OK" button text will change to "Sawe". Clicking the "Sawe" button will save the
modifications, clicking "Cancel" will keep the old data.

Adding a datum

To add a new datum definition, click the "Add" button. When adding a new definition, it is required to
specify a name for this datum, as well as the ellipsoid used. Other fields are optional and are defaulting
to 0.0 when not used.

Please note that the XY and Z translations have to be entered in Meters, the XY and Z rotations are
entered in arc seconds. If you have a datum definition that uses radians, you hawe to convert from radians
to arcseconds first: 1 radian = 206 264.806 arcseconds.

Click the "Sawe" button to store the newly created datum, by clicking cancel the input is ignored and you

will return to the list.

Manage Map Grids

Introduction

To open the "Manage Grids" window, select "Options" => "Coordinate Systems" => "Manage Map
Grids" from the menu. Using this window, you will be able to view, delete or modify existing grids
definitions, or to add your own. For a list of map grids that are already in the database, click here.
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Grid List

Country or Region EPSG Grid Mame

& Anguilla 2000 Anguilla 1957 [ British West Indies Grid
H antigua and Barbuda 2001 Antigua 1943 [ British West Indies Grid
& Dominica 2002 Dominica 1945 [ British West Indies Grid
B4 Grenada 2003 Grenada 1953 [/ British West Indies Grid
@l Montserrat 2004 Montserrat 1958 [ British West Indies Grid
St Kitts and Nevis St. Kitts 1955 / British West Indies Grid
Pl st Luda 2006 St. Luda 1955 [ British West Indies Grid
i+l st vincent and the Gren... 2007 St. Vincent 45 [ British West Indies Grid
I*l canada 2008 MAD27(CEQF7) | SCoPQ zone 2
I+l canada 2009 MANIFICEOTT § SCAPO 7ane 3 “'

@ Add || o Modfy || @ Delete.. |

Filter Grid List

Filter by country: |Nu country selected |||_-1 Select... || 3{ Reset |

Filter by datum: |Numapda1um selected |||_1 Select... | { Resst |

Selected Grid Properties

Mame: | St. Kitts 1955 f British West Indies Grid

Projection: Transverse Mercator

Country: | St Kitts and Nevis il Select...

Daturn: | 5t. Kitts 1955 Select...

False Northing: | 0.000 False Easting: | 400000.000

Center Latitude | 0.00000000 Central Meridian | -62.00000000

Parallel North: | 0.00000000 Parallel South: | 0,00000000

Azimuth: | 0.00000000 Rectified Grid Angle: | 0.00000000

Scalefactor: | 0.993500

Horizontal Units; ~ Meters v Vertical Units:

Click here for a list of most commonly used ards around the word

Grid List

When clicking an item in the list, its parameters are displayed below the list. You can edit these
parameters by clicking the "Modify" button. The map grid list can be sorted by clicking on the list
columns. You can sort the list by country, grid name and geodetic datum used. A map grid definition is
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displayed by the flag of the country where it applies to. If a grid can be used in multiple countries /

regions, instead of a flag, a globe is displayed.

Deleting a grid

You can delete an datum definition, by selecting an item from the list and clicking the button "Delete".
The software will show a popup to confirm that you are sure you want to delete. When clicking "Yes" the

grid has been deleted.

Modifying a grid

You can modify a grid by clicking the "Modify" button after you selected a grid from the list. After clicking
the button, the "OK" button text will change to "Sawe". Clicking the "Sawe" button will save the

modifications, clicking "Cancel" will keep the old data.

Adding a grid

To add a new grid definition, click the "Add" button. When adding a new definition, it is required to
specify a name for this grid, as well as the datum and projection used. Depending on the chosen
projection, the input fields are enabled or disabled. The table below shows what fields are required for the

different projections:

Projection

Lambern Conformal Conic 1 SP
Lambern Conformal Conic 2 SP
Lambenrn Azimuthal Equal Area

Transverse Mercator
Cbligue Stereographic
FPuolar Stereographic
Oblique Mercator
Hotine Oblique Mercator
Swiss Oblique Mercator

Albers Equal Area Conic

Mercator 15P
Mercator 23P
Mollweide
Eckert IV
Eckert VI
Cassini
Krovak

X

MoH M M M M M M M M M M M X X N =

MoH M N M M M M M M M H M KX X N =

HMoOoM M M oM M M M O H K N =

M oM M M M M XM M K M M H M H XK ¥ =

SCALE FALSE N FALSE E LAT 0 LON_O PAR 1 PAR 2 A7l RECTGRD

X o =
X = ="

Selecting a country is not required, but the country can be used to sort lists by country, if the grid does
not apply to a simple country, just select "Earth", "Europe”, "Asia" etc... When you want to use other
units for the Northing and Easting values calculated ( default is Meters ), you can also select the units to
be used. Please note that when changing this, you also have to enter the False Northing and False

Easting in these units. Units currently supported are:
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Meters

Kilometers
International Foot
British Foot
Clarke's Foot

Gold Coast Foot
Indian Foot

British Foot (Sears)
U.S. Suney Foot
Link

Clarke's Link
British Link (Sears)
U.S. Suney Link
Statute Mile

U.S. Suney Mile
Chain

Clarke's Chain
British Chain (Sears)
U.S. Suney Chain

AN N N N N N N N N N N N N NN

Click the "Sawe" button to store the newly created grid, by clicking cancel the input is ignored and you
will return to the list.

2.6.4 Manage Geoids

Introduction

In Hydromagic, a geoid model is used to calculate the separation between the local vertical datum and
the WGS84 ellipsoidal height.
Each geoid model is in fact a simple binary file containing separation values in a regularly spaced grid.

The geoid files hawve the file extension ".geo" and are stored in the "\ProgramData\Hydromagic\Geoids"
folder on your harddrive.

To access the "\ProgramData\Hydromagic" folder, please select the "Open Program Data Folder..."
option from the "Help" menu.

To open the "Manage Geoids" window, select the "Coordinate Systems" => "Manage Geoids" option
from the "Tools" menu.
Using this tool, you will be able to add new, remowe or alter geoid definitions in the built in database.

Please note that not all geoids are installed by default. Geoid models that are configured, but not
installed, are displayed in red.

These geoids can be downloaded from our website: http://www.eye4dsoftware.com/hydromagic/
documentation/geoid-models/

© 2015 Eye4Software B.V.


http://www.eye4software.com/hydromagic/documentation/geoid-models/
http://www.eye4software.com/hydromagic/documentation/geoid-models/

41

Eye4Software Hydromagic 7.0

=
L=8061
1 EbEE
Els01s
B s020
Els017
Bls01s
LN
B 2054
Al 8056

5001

Geoid

GEOID12A Conus Grid 8
HEFOS

ITG2009

MAPGEQ 2010 - SADSS
MAPGED 2010 - SIRGAS
MEXICOS7 - Central
MEXICOS7 - East
MEXICO97 - West
MORGED

MM2000

Mormaal Amsterdams Peil (M.A.P.)

Geoid Properties

Marme:
Country:
File:

Click here for a list of downloadable geoid models on our Hydromagic wehsite.

|© Add || Mody || @ Delete..

| Mormaal Amsterdams Peil (N.A.P.)

| Metherlands

| rdnap.geo

Please note that genids displayed in red are not installed. For more information
on how to install additional gecid models, please dick the link above.

Geoid List

Select ...

Browse...

& OK | X Cancel |

When clicking an item in the list, its parameters are displayed below the list. You can edit these
parameters by clicking the "Modify" button.
The altered parameters can be saved by clicking the "Sawe" button, or discarded by clicking the "Cancel"

button.

Deleting a geoid

You can delete a geoid definition, by selecting an item from the list and clicking the button "Delete".
The software will show a popup to confirm that you are sure you want to delete the selected item.
Please note that the geoid file will not be deleted and can still be used.

Modifying a geoid

You can modify a geoid model by clicking the "Modify" button after you selected a geoid model from the
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2.6.5

list.
After clicking the button, the "OK" button text will change to "Sawe". Clicking the "Sawe" button will save
the modifications, clicking "Cancel" will keep the old data.

Adding a geoid

To add a new geoid model definition, click the "Add" button. When adding a new definition, it is required
to specify a name for this geoid as well as the file containing the separation values.

Click the "Sawe" button to store the newly created datum, by clicking cancel the input is ignored and you
will return to the list.

Manage Countries

Introduction

To open the "Manage Countries" window, select "Options" => "Coordinate Systems" => "Manage
Countries..." from the menu. Using this window, you will be able to view, delete or modify existing
country / region definitions, or to add your own. The use of countries / regions is not required to perform
calculations. It is only added to provide a mechanism to sort the map grids by the region or country they
are used for.
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Select Coutitry Bl
Select Country
== Netherlands @' Morthern Mariana Islands
=§= Netherlands Antilles afe Norway
[ Mew caledonia ) Oceania
mll New Zealand = Cman
== Micaragua Pakistan
= Miger E Palau
B B vigeria E= Palestine Territory
@Nive ®" Panama
| Norfolk Island Bl Papua Mew Guinea (PNG)
I Morth America m= Paraguay
< >
& Add. || & Modfy.. | &Remove..
Country Properties
Country Name: Metherlands
Flag image: ML.png Browse. ..
To add your own flag symbuols, please copy the file(s) containing the images (FNG
; 16x16) to the "Flags” folder. To locate the "Flags”® folder, select the "Open
ProgramData Folder™ option from the "Help®™ menu,
£ Cancel

Country

When clicking an item in the list, its parameters are displayed below the list (country hame and flag
filename). You can edit these parameters by clicking the "Modify" button.

Deleting a country

You can delete a country definition, by selecting an item from the list and clicking the button "Delete".
The software will show a popup to confirm that you are sure you want to delete. Please note that you
cannot delete countries that are used in a grid definition.

Modifying a country

You can modify a country by clicking the "Maodify" button after you selected a country from the list. You
can for instance translate the country name to your own language, or modify previously created regions.
The flag associated with the country or region can be changed by clicking the "Browse" button. How to
add your own symbols or flags is described in the "Adding a country” section below. After clicking the
button, the "OK" button text will change to "Sawe". Clicking the "Sawe" button will save the modifications,
clicking "Cancel" will keep the old data.
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Adding a country

To add a new country definition, click the "Add" button. When adding a new definition, it is required to
specify a name for this country. Specifying a symbol or flag for this country is optional, when no image
has been specified a globe is displayed in the grid list. If you want to add your own symbol, convert this
symbol to a 16x16 PNG Image file and copy this file to the "Flags" folder in the program directory. You
can select a flag or symbol by clicking the "Browse" button. The software ships with flags for most
countries around. Click the "Sawe" button to store the newly created datum, by clicking cancel the input
is ignored and you will return to the list.

3 User Interface Features

3.1 Projects
Hydromagic Projects

In Hydromagic, a set of background maps, raw data files, soundings, map overlays and dredging logs are
organized as projects.

Each project has its own projection settings, surveyor name and project description associated with it,
and is stored in a separate folder on the disk.

The settings of the project are saved into a "Hydromagic Project File" with ".hpf' extension.
These files are stored as XML and can be altered using any text editor application.

Some folders, like "Draft", "Maps", "Reports"”, "Tides" and "Velocity" are provided to keep the project
organized.

The folders "Logs", "Matrices"”, "Modified", "RawData" and "Soundings" are required to run the software
and should not be removed or renamed !

Hydromagic projects can be shared by Hydromagic Survey and Hydromagic Dredging.

____Folder __Jpescripton | Required |

Maps Folder to store imported and dow nloaded maps No
Matrices Folder used to store matrices generated from soundings or dredging matrices Yes
Raw Data Folder w here raw data files are recorded during hydrographic surveys Yes
Modified Folder w here modifications to raw data files are stored Yes

Soundings Folder w here soundings generated fromraw data files are stored Yes

Logs Folder w here dredging logs are w ritten by the Hydromagic Dredging softw are Yes

Draft Folder to store draft files generated by the draft file editor No

Tides Folder to store tide files generated by the tide file editor No
Reports Folder to store PDF reports generated by one of the volume calculation tools No
Velocity Folder to store sound velocity files No
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Home Share View
= X cut

[#5] Copy path
E| Paste shortcut

Copy Paste

|_E| Copyto

Clipboard Org

®©

Mame

-

T | « Hydromagic » Friesla

-

| Draft
A Logs

=f Rename :

anize

nd »

Date modified

2/19/2015 7:36 PM
2/19/2015 7:36 PM

m Mave to ?{ Delete = rn E:

Mew
older

Mew

W

Y]

Type

File folder
File folder

~ 0
D G~ HHselectan
(&

Prop frtles I_'@

o5 Select none
=] :
I:IE Invert selection

Open Select

Search FriesLand

o

Size

| | Maps

3/16/2015 %33 AM

File folder

| Matrices

| Modified

| RawData

. Reports

| Soundings
1 Tides

L Velocity

|| FriesLand.hpf

11 ez 1 item selected

Creating a new project

3972013 %14 AM
37972015 9:14 AM
3/9/20159:14 AM
3/9/2015 914 AM
3/9/2015 9:14 AM
2/19/2015 .36 PM
2/19/2015 T:36 PM
3/13/2015 815 PM

File folder
File folder
File folder
File folder
File folder
File folder
File folder
HPF File

The first thing to do when start working with the software, is creating a project. That is, of course, when

there is no project available to load.

To create a new project, select "New Project..." from the "File" menu in either the Hydromagic Survey or

Hydromagic Dredging application.

:| File | Edit View Tools Options Survey
B | import Map... b
;q @ Download Map... ’
[ New Project... ctri=n ||
E : Cpen Project... Clrl+ >
bl | save Al Ctrl=5

When a project is currently loaded, it will ask you whether you want to save changes and unload it.
The following dialog is displayed. Just fill the required fields and click the "Create" button to create an

empty project.
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Create new project “
Project Properties
Project Mame: Demo Project
Project Location: C:\UsersiLeon\DocumentsiHydromagic),  Browse...
Map Projection: Amersfoort [ RD Mew . Select...

Project Description: Demo Project

Surveyor: Leon Steijger

When creating a new project, a new subfolder with the project name will be created under the

1y folder which is spedified in the project location field. The description and surveyor fields are optional.

X Cancel

Project Name

Enter a name for the project. This name is also used as the folder name for the project on the disk.
Please note that this name can't contain one of the following characters: / |\ *: ? " < >,

Project Location

You can select the location where the project is stored here. By default the "Hydromagic" folder under
"My Documents" will be selected.

Howe\er, it is safe to change this location and use your own instead.

Map Projection

Select the map projection which is going to be used in this project by clicking the "Select..." button.
Please note that you cannot change the map projection once the project has been created.

Project Description

You can enter a description for the project here. The use of this field is optional.
The value of this field can be selected as part of the map footer text.

Surveyor

You can enter the name(s) of the surveyor(s) here. The use of this field is optional.
The value of this field can be selected as part of the map footer text.

Import Hydromagic version 5.x projects

You can use Hydromagic version 5 projects in version 6 or 7. Please note that in version 5 all data was
recorded directly to the sounding files, so you won't be able to filter the sounding data using the
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Sounding Wizard.
To import a version 5 project, select "Import" => "Import Project (5.x)..." from the file menu.

In the dialog that appears you only have to select the old project file as well as the location and name of
the new project.
Finally click "OK" to start the conwersion project.

Convert Hydromagic Project “

Old Project Settings (version 5.x)

Project file: C:\Tempi\Weerwater_COBA.gmp

Mew Project Settings (Version 6.x)

Project name: | Weerwater _COBA

Project folder: | C:YUsers\Leon'\DocumentsHydromagich, | Browse...

You can use this conversion tool to import a project saved in Hydromagic 5.0, 5.10r 5.2
rg into the new Hydromaaic 6.0 which is using a different file and folder structure.

o OK # Cancel

Project Explorer

Your project and it contents can be viewed and modified using the "Project Explorer". It can be used to
download maps, import maps or data, remove items and many more.
For more options, just right-click with your mouse on an item to get a popup menu.

Backing up projects
Using the "Project Explorer" it is possible to backup or archive your entire project with just a couple of
mouse clicks.

To do so, right click the project root in the "Project Explorer" and select the "Archive project..." option.

A file dialog will appear allowing you to set the name and location of the output file.
The backup can be written as ZIP, TAR or ISO file. Click "OK" to generate the file.
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! File Edit View Tools Options Survey Navigati

NS | EEEE S GE

Project Explorer o =
=-i
--IIJ' I_ E-].f MNew praoject... Ctrl+N
--(I:l | & | open project... Ctri+=0
"‘I’ = @. Import project..
(- ]
- L] Q Save project... Ctrl+5
. Ej Archive project... |
s L2 Show containing folder...
@ | Show project properties...

Open project folder

To open a Windows Explorer window containing the contents of the project, right click the root of the
project in the "Project Explorer" and select the "Show containing folder...".

This might come in handy when, for instance, you want to manually copy or backup files from or to your
project.

File Edit View Tools Options Survey Mavigs

DEH R BB R SRS

Show containing folder...

Project Explorer o x
= : '
--'I:l = E MNew project... Ctri=M
@ [ | Open projedt... Ctrl=
(In,_ Import project...
- [
: =l save project... Ctrl=5
: = |-_§_j Archive project...

Show project properties...

Alter project properties

This function can be used to alter some project properties like the Surveyors name and the project
description.
It is not possible to change the projection, units and project name once a project has been created.
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To show or modify these properties, right click the root of the project in the "Project Explorer" and select
the "Show project properties...".

When done editin

g, just click the "OK" button to store the modifications.

File Edit View Tools Options Survey Maviga

EEEIIEY L e

Project Explorer o =
EHS_' mﬁ Mew project... Ctri+N

- || |
D ject... Cirl+ O
B@ i = - Open proje rl+
-G || @ Import project...
@ gl
H . H Save project... Ctrl+5
--'I'.'L |
m'- Ej  Archive project...
- || = | Show containing folder...
TR = : _
5 Show project properties...
wa D |

Surveyar:
Projection:
Hortizontal Units:

Vertical Units:

Friesland

C:Users\eon'\Documents\Hydromaagic\Friesland

Demo project created in Friesland (Sneskermeer) for the release of version 6.0

Leon Steijger

Amerzfoort / RD Mew

| Meters

| Meters

© 2015 Eye4Software B.V.



User Interface Features 50

3.2 Toolbar

Toolbar

The toolbar contains a selections of the most common used features, so they can be accessed with a
single mouse click. The toolbar can be fully customized, it is for instance, possible to remove buttons
which are never used. This makes the program more user-friendly.

DEHm  EERR B SEE S d0LLLL I BAXCE A- Bl @@ K| ®u <2 3 s A2 d e B

_euton |Funcion

el e -l -

CHEEE s

=

s oo o E

Asks to save the current project, closes it and starts a new one.

Asks to save the current project, closes it and opens an existing project.

Sawes the current project.

Sends the map, as displayed on the screen, to the printer.

Import a map, and add it to the current project.

Import a matrix, and add it to the current project.

Import a sounding, section or boundary from an ASCII data file.

Import a sounding from a NMEAQ0183 log file.

Start the map downloading tool to download maps and add them to your project.
Exports a selection of the current project as KML file (Google Earth).

Exports a sounding, matrix, boundary or shoreline as an ASCII data file.

Sawes the current view as an image file (JPG/GIF/PNG/TIF or BMP).

Adjust the drawing order of maps in the project.

Set cursor mode to "pan", allowing you to drag the map around using the mouse.
Set cursor mode to "info", click an object to show more information (vector maps only).
Set cursor mode to "zoom in", click the map to zoom in.

Set cursor mode to "zoom out", click the map to zoom out.

Set cursor mode to "zoom window", select a rectangle on the map to zoom.
Zoom to extends of all items in the project.

Rotate the map 15 degrees counter clockwise (CCW).

Undo rotation (north up).

Rotate the map 15 degrees clockwise (CW).
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3.3

B &G E E e

Rotate the map clockwise (CW) by specifying the rotation in degrees.

Measure area, perimeter, bearing or distance.

Boundary drawing tool. Starts drawing a boundary on the map. Right click to save.
Shoreline drawing tool. Starts drawing a shoreline on the map. Right click to save.
Draw the map in course up mode. Click again to switch back to north up.

Zoom to current location. Map will be zoomed to vessel's position.

Preferences. Open preferences window.

Start / Stop recording raw sensor data (starts a new raw data file).

Pause recording raw sensor data.

Activate previous cross-section or planned line (used for helmsman display).
Activate next cross-section or planned line (used for helmsman display).

Toggle between depth and elevation mode (only available when sounding has tide
information).

Start the sounding generation wizard, allows you to convert raw data into soundings.
Reset position, sounder or speed alarm(s).

When active, the drag-and-drop feature will be disabled (locked).

Edit depth color and legend settings.

Show wersion and licensing information.

Display the offline user manual.

Accelerator Keys
Accelerator keys

An accelerator key is a key on your keyboard that you can press to quickly access a menu or function.
This can be used for often used functions, such as start or stop recording a sounding.
When using an accelerator key, you do not longer have to use the mouse while trying to navigate your
vessel at the same time.

Default accelerator keys
A couple of accelerator keys are already defined after installation of the software.

These keys provide direct access to the functions in the "Survey” menu as shown below:
Accelerator keys are supported since Hydromagic version 5.2.

Survey l Mavigation Cursor Help

.: @ Toggle Recording Fa "E'. pC]

| Previous Section F11

¥ Mext Section F12

T
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Adding and modifying accelerator keys

In addition to the standard accelerator keys, there is a possibility to add keys by your own, to modify
accelerators, or to reset all accelerators to their default values.

To do so, click the small arrow at the right of the toolbar, and select the "Customize..." option as show
below:

SERA B T OIH -

Add or Remove Buttons - Standard 1

Customize...

In the dialog that appear, click the "Keyboard" tab to access the accelerator configuration:

- =z

Customize
| Commands | Toolbars | Keyboard | Menu | Ciptions

Categony: Set Accelerator for:

ISunre:r - ] [ Default - I g

Commands: Cument Keys:
Create new sounding F9 B
Mark location —
MNext Section B
Previous Section ks

Toggle Recording
Press New Shortout Key: Reset Al

Description:
Record Sounding

Close

b

To create a new accelerator, for instance, the F1 key to access the offline help program, select the menu
item you want to associate with the F1 key as described in the following steps:

¢ For the "Category" drop down box select "Help", and for "Commands" select "User Manual...";

¢ Click the "Press New Shortcut Key" field with your mouse;

¢ Now press the key you want to use, this can also be a combination of keys, for instance, CTRL + F9,
in this case we just press F1,

¢ Click the "Assign" button to select the key;

¢ Finished, you can now click the "Close" button to save your changes.
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3.4

After performing the steps abowe, you should see something like this:

P

=

Customize
| Commands | Toolbars | Keyboard | Menu | Options |
Categony: Set Accelerator far:

Commands: Cumrert Keys:

About Hydromagic... Fl
Open Program Data Folde

Show Evert Log...

| Help v| |Defaut - §

Press New Shortout Key:

4 | 1] [ k

Description:
Start User Manual

b

To reset all accelerator keys to their default values, just click the "Reset All" button.

Data View

Introduction

The data view is used to display all incoming data from the hardware.

The data view is integrated in the Hydromagic environment as a docked window.

By default, it is displayed left of the map display.
The following information can be displayed in this view:

Current position in WGS84 latitude and longitude;
Current position in UTM coordinates;

Current position in the selected local grid;
Altitude, course and speed,

(D)GPS fix quality and used satellite(s) count;
DGPS beacon ID and age;

PDOP, HDOP and VDOP;

Motion sensor data: heawe, pitch and roll;
Current Time;

Navigation information;

Dredging information.

AV NN N N N N NN TN
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Mavigation Data =
Latitude N 51°08'39.90"
Longitude E 003°48'51.18"
Morthing 000000000
Easting 000000000
Sounder Hi 210
Sounder Lo 0.00
Corrected 2.10
Manual 0.00
Receiver 0.00
Course 1571°
Ground 0.1 kmh
Sats 10
Fix DGPS Fix
Diff Age 499
Beacon 0000
Time 13:42:42 GMT
PDOP 2.00
HDOP 1.20
VDOP 1.60

Showing or hiding the data view

By default, the data view is displayed as a docked tabbed window. If you want to show or hide this
window, just select the "Navigation Data" option from the "View" menu. Sometimes the windows is
already displayed, but as a tabbed window. You have to select the "Navigation Data" tab to bring the
window to the foreground. This tabs look like the image below:

EAttribute... ||Project E... =% Mavigati...

Ready
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Select items to display

You can easily modify the data view by showing and hiding items. By showing only the needed
information, the display will become more well organized. To select the items to display, right-click on
the data view to show the following dialog. You can just select the items to display, by checking them.

Data View Options.

Display Items

[|Position - Latitude [ Longitude
[|Position - Universal Transverse Mercator
[|Position - User selected grid
[V] Altitude

[#|Depth

[« Tide

[+]Course

[]5peed

[]GPS Statistics

[V]DOP

[ Clock

[ Mavigation Info

[]Motion

[|Dredging

Font Size

You can decrease the size of the font in the
1y dataview in case not all items fit in the view.

@) Select Al || (& Select None

Select Font Size: | 8 w | pixels

i ¥ Cancel

Position - Latitude / Longitude

Your current GPS position in WGS84 latitude and longitude format. It is possible to change the display
format used. The display format can be modified from in the "Units" tab in the preferences window

( "Preferences..." from the "Options" menu ).

Position - Universal Transverse Mercator
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Your current GPS position in UTM (Universal Transverse Mercator). The UTM zone is automatically
detected using your current position, and will also be displayed. The UTM coordinates are displayed in
northing and easting meters.

Position - User Selected Grid

Your current GPS position displayed in either easting and northing or latitude and longitude, depending
on the local map grid used to display the current map. This projection is the same as the projection
displayed in the status bar at the bottom of the screen.

Altitude

Altitude of the GPS antenna. Depending on the GPS, this can be the altitude above sea lewel, or the
altitude abowe the geoid. The altitude can be displayed in meters or feet. The current altitude unit setting
can modified from in the "Units" tab in the preferences window ( "Preferences..." from the "Options"
menu ).

Depth

Displays both the low and high frequency (if applicable) depths returned by the echosounder as well as
the depths corrected with the current (RTK) tide value.

Tide

Displays the current tide value. Depending on the settings, either the manual, RTK or tide receiver tide
will be displayed.

Course

Course calculated by the GPS. Also know as course over ground.
Speed

Speed calculated by the GPS. Also known as speed over ground. The speed can be displayed in miles
per hour, meters per second, knots and kilometers per hour. The current altitude unit setting can be
modified from the "Units" tab in the preferences window ( "Preferences..." from the "Options" menu ).

GPS Statistics

This option can be selected to retrieve more information on the GPS fix. This section in the data view
includes the quality of the GPS fix (no fix, GPS fix, DGPS fix, etc...), the number of satellites used and
some basic information on the DGPS reference station used (not available when using EGNOS/WAAS).

DOP

This option can be selected to enable the DOP (Dilution Of Precision) section in the data view. It shows
PDOP (overall dilution of precision or position dilution of precision), HDOP (horizontal dilution of
precision) and VDOP (vertical dilution of precision).
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3.5

Dredging
Display information on the ongoing dredging process. When using the Hydromagic Dredging edition of

the software, enabling this option will display dredging depth as well as position information on the
dredging equipment used.

Motion

Display motion information received from a motion sensor, IMU or echosounder with built in motion or
heave sensor.
Enabling this option will display heave, roll and pitch information in the data view.

Clock
Just displays the current PC date and time in GMT (Greenwich Mean Time).
Navigation Info

When the software is used in waypoint-to-waypoint navigation, enabling this option will cause the data
view to show bearing and distance to waypoint.

Helmsman Display
Helmsman Display

The helmsman display (also known as LR-indicator) in Hydromagic can be used to display the cross
track error (XTE) when navigating on planned surwey lines.

It provides you with information on in which direction to steer to follow the planned lines as accurate as
possible.

Activating the helmsman display

The helmsman display can be activated by selecting "LR Indicator" from the "View" menu. The display
will be displayed.

The display will now be displayed, however, it won't display any useful information until a valid GPS
position is available and a cross section or planned suney line has been selected.
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File | View | Tools Options Survey Navigation Cursor  Help
P AE Application Look b &ﬁg dﬂ@t_e‘|w|
V' | Tool Bar
v | status Bar

Project Explorer

i

&

Mavigation Data
Attribute Pane

SkyView
Echosounder

LR Indicator

® B5 0 [0

Enable Moving Map

Layers...

&

Activating a survey line

Because the cross track error displayed is calculated from the position of your vessel relative to a line,
you hawe to tell the software which planned suney line you want to follow.

Please note that in Hydromagic, there is no difference between a planned suney line and a cross
section. Cross sections can be used in wolume calculations, cross section displays and as planned
surwey lines.

There are several ways to select a cross section:

¢ Right click on the center of a cross section and select "Activate Section..." from the popup menu;
e Select a cross section by selecting the previous or next section using the F11 and F12 function keys;
¢ Right click a cross section in the project explorer and select "Set Active";
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Zoom In
Zoom Out

Center

Add Waypoint...

Project Waypoint...
Add Comment...

Add Photo...

9
E & W% 0%

SECTIONOOS
ECTIONO103

SECTIONO102
S

Add Corner...

Edit Section...
Add Section...
Remove Section...

Activate Section...
Add Sounding Data..
Add Shoreline Data...

Show in Google Maps

® F B o B

Using the display to steer

When a valid position is available, the difference in heading between the vessel and the line is less then
45 degrees, and a cross section has been selected the helmsman display is indicating the distance
between your vessel and the line, as well as the direction:

Hydromagic - LR Indicator @
100 20 &0 40 20 20 40 &0 20 100

5.87

The value displayed is the distance to the line in the horizontal units selected in the current map
projection.

When the value is displayed in red, it means you are on the port side (left) of the line, and you have to
steer to the steer to the starboard side (right).

When the value is displayed in green, it means you are on the starboard side (right) of the line, and you
have to steer to the port side (left).

The line that is used to calculate the calculate the cross track error (the line that is activated) is
highlighted in yellow on the chart display:
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3.6 Area Measurements
Introduction

The Eye4Software GPS Mapping Studio offers a variety of tools to calculate or measure the area covered
by a sounding, map feature or other object.
The results of area calculations are displayed using one of the following units:

Acres;

Hectares;

Square Meters;
Square Kilometers;
Square Yards;
Square Feet.

ASANENENENEN

Areas are calculated by passing all vertices, or sounding positions, as WGS84 latitude and longitude to
the "Vincenty's Formula", which calculates the distances between the coordinates.

The calculated vectors are passed to a cross-product formula used to calculate the total area of an
object.
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Setting area units

Before performing an area calculation, make sure the correct area units have been set, otherwise it can
happen that you have to do the measurement again (or convert it to another unit). To specify the units
used for area calculation, open the "Preferences" dialog, by selecting "Preferences..." from the "Options
menu. Now click on the "Units and Formats" tab. The following window should now appear:

Use the "Area Units" drop down box to select the correct units, and click the "OK" button to confirm.

Preferences “

Map Miscellaneous Alarms ECDIS Grid
Units and Formats Devices Calibration RTK

IUnits and Formats

Position Format: H DOD,DODDD W
Speed Units: MPH )
Area Units: Square Feet W
Volume Units: Cubic Feet v/
Horizontal Units: Meters

Vertical Units: Meters

MOTE:  Vertical units (altitude and depth), and horizontal units
{distance) depend on the selected local grid.

Depth and elevations

Display soundings as elevations when tide correction is used

[ ]Reverse sign of elevation values in soundings

Measuring the area of a map object

Areas of map objects can be calculated by selecting the corner coordinates of the polygon using the
mouse. To get the best (most accurate) results, make sure that the object is zoomed in at the maximum
zoom lewel while all corners of the polygon remain \isible.
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Now select the "Area" cursor tool by selecting "Area" from the "Cursor" menu. All you have to do is
select all the corners of the object, as shown in the screen shot below:

Area Calculation Mw—

Current Segment

Length: 0.042 lm
Bearing: 91.3 degrees
Palygon

Area; 0.015 Km2
Perimeter: 0,596 km

P m— |

You will notice a blue line drawn around the object. A dialog box appears on top on the map showing the
current area and perimeter of the map object. When you finished measuring, just click the right mouse
button to dismiss the dialog box, and return to the previous mouse mode.

3.7 Alarms
Alarms in Hydromagic

In Hydromagic, alarms can be configured to alert you, or stop recording a sounding or dredging log, when
specified conditions are (not) met.

Alarms can be applied to position, speed, echosounder depth, dredging position, dredging depth and
speed.

To setup alarms, first select the "Preferences..." item from the "Options" menu to open the preferences
dialog.
In the preferences window, please select the "Alarms” tab to setup alarms:
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Units and Formats |

GPS Alarm

Set minimum required number of satellites, GPS Cop
quality or DOP to enable logging. 6? o

Sounder Alarm

Set minimum and maximum echosounder & Setup..
depth.

Speed Alarm

Set this alarm to avoid incorrect soundings by

sounding at a speed which is to high.

GPS alarms

To setup alarms on the GPS / RTK equipment, click the "Setup..." button in the "GPS Alarm" section.

GPS Alarms are available in both the Hydromagic Survey and Dredging editions.

To enable alarms for GPS, check the "Enable alarm on invalid and inaccurate GPS positions" option.

You will now be able to configure other options:

© 2015 Eye4Software B.V.



User Interface Features 64

GPS Alarm H

GPS5 Alarm

Enable alarm on invalid and inaccurate GRS positions.

PS5 Thresholds
Minimum GPS guality value: RTK Fixed )

Minimum GPS satellite count: | &

Maximum HDOP value: 1.5
Maximum DGPS age: i]
Reguire DGPS beacon id: 0
Actions

Pause recording

Sound alarm

Minimum GPS quality value

Use this option to make sure only positions are recorded when the GPS is, for instance, in RTK Fixed or
differential GPS mode.
Possible values include:

v No Fix

v GPS Fix
v DGPS Fix
v RTK Float
v RTK Fixed

When using tide corrections using RTK, it is recommended to use this option with "RTK Fixed" selected,
so you will be notified when RTK tides are disabled.

Minimum GPS satellite count

This options can be used to use only position fixes with a minimum number of satellites in view to ensure
accuracy.

For a valid 2D fix, at least 3 satellites are required, for a 3D fix, you need at least 4 satellites. It is
recommended to set this value to 6 or higher.

Maximum HDOP value

Activates alarm when the HDOP (Horizontal Dilution of Precision) value exceeds a defined threshold.
Recommended value is 2.0
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Maximum DGPS age

The DGPS age indicates the age of the correction data in seconds. When this value goes up, it often
means that the differential GPS or RTK correction signal is temporary lost.
In most scenario's this value will not exceed the value of 5-6. It is recommended to set this value to 10.

Require DGPS beacon id

This option can be used when a DGPS or RTK correction signal is used. When another beacon is
received then the one that is expected, it may result in inaccurate positions, for instance when a
reference station is at a to great distance.

Set this value to the beacon ID that is displayed directly at a successful setup of your reference station.

Sounder alarms

To setup alarms on the echosounder equipment, click the "Setup..." button in the "Sounder Alarm”
section.
Sounder alarms are available in the Hydromagic Surwey edition only.

To enable alarms for sounders, check the "Enable alarm on invalid and out-of-range soundings" option.
You will now be able to configure other options:

Sounder Alarm

Sounder Alarm

Enable alarm on invalid and out-of+range soundings.

Sounder Limits

Minimum Depth: 0,30 Meters
Maximum Depth; 30.0 Meters
Artions

Pauze recording
Sound alarm

Minimum Depth

Sets the minimum depth that is expected to be returned from the sounder. This value is not corrected,
but compared to the raw depth returned.

Maximum Depth
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Sets the maximum depth that is expected to be returned from the sounder. This value is not corrected,
but compared to the raw depth returned.

Dredging alarms
To setup an alarm on the dredging equipment or dredging depth, click the "Setup..." button in the
"Dredging Alarm" section.

This alarm is available in the Hydromagic Dredging edition only.

To enable an alarm for dredging, click the "Enable alarm on invalid dredging data" option.
You will now be able to configure other options:

Dredging Alarm “

Dredging Alarm

Enable alarm on invalid dredging data.

Dredging Alarm Thresholds

Maximum dredging depth: 15.0 Meters
Maximum vertical angle: 23.0 dearees
Maximum horizontal angle: 0.00 dearees
Maximum harizontal offset: 0,00 Meters
Actions

Pause recording

Sound alarm

Maximum dredging depth

The maximum allowed dredging depth for your project. When the dredge head will go below this depth,
the alarm will be triggered.

This alarm depth will be drawn in digging views as a solid red line.

Maximum vertical angle

The maximum allowed vertical angle of any of the segments of your dredging equipment (ladder, tube
etc...).

When the inclination sensor returns a higher angle then the one specified here, the alarm will be
triggered.

Maximum horizontal angle

The maximum allowed horizontal angle of any of the segments of your dredging equipment (ladder, tube
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etc...).
When the yaw sensor returns a higher angle then the one specified here, the alarm will be triggered.

Maximum horizontal offset
The maximum allowed swing (in selected units) of any of the segments of your dredging equipment

(ladder, tube etc...).
When the horizontal dredging offset exceeds this value, the alarm will be triggered.

Boundary alarms
To setup an alarm on the dredging area boundary, click the "Setup..." button in the "Boundary Alarm"
section.

Boundary alarms are available only in the Hydromagic Dredging edition.

To enable an alarm for boundaries, check the "Enable alarm on dredge head location" option.
You will now be able to configure other options:

Boundary Alarm

Speed Alarm

Enable alarm on dredge head location.

Boundary
Select Boundary: ||_g BOUNDARYDOD1 v
Actions

Pauge recording
Sound alarm

Selected Boundary
The selected boundary is used to check the dredging position. When the dredge head is outside of the

selected
boundary, the alarm will be triggered.

Speed alarms

To setup an alarm on the speed of the vessel, click the "Setup..." button in the "Speed Alarm" section.
Speed alarms are available in both the Hydromagic Survey and Dredging editions.

To enable an alarm for speed, check the "Enable alarm on speed limit" option.
You will now be able to configure other options:
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Sreed Al | < ||

Speed Alarm

Enable alarm on speed limit,

Speed Limit

Maximum Speed: 2.3 mph

Actions

Pause recording
Sound alarm

Maximum Speed
The maximum speed of the vessel during surnvey or dredging operations. Due to latency errors, the

recommended speed for performing surveys is 4 km/h.

Alarm options

Pause sounding recording

When the "Pause sounding recording" option is enabled, the recording of the current sounding is
suspended when the alarm is activated.

You hawe to press the record button again to resume recording.

Sound Alarm

When the "Sound alarm" option is enabled, then a sound is played when the alarm is activated.
You can reset the sound by clicking the reset alarm (}K) button in the toolbar.

NOTE: When using sound alarm(s), make sure your sound hardware is enabled and the volume
isturned on.

© 2015 Eye4Software B.V.



69

Eye4Software Hydromagic 7.0

3.8

Query objects
Introduction

The Eye4Software Hydromagic allows you to use the mouse to select a map feature or coordinate on the
map, and to return more information on objects found at this location.

You can use this feature to get more information on a CAD or GIS feature, or to retrieve depth at any
given location (within the boundaries of a loaded or generated matrix).

You can access this feature by clicking the (il putton in the toolbar.

Querying depth values

In order to retrieve depth information using the mouse, make sure a matrix is loaded or generated, and
set to active.

You can activate (which means that is the matrix selected for operations) a matrix by right-clicking it in
the "Project Explorer" and selecting the "Set Active" option as shown below:

File Wiew Tools Options Survey Mavigation Cursor Help

L&@-Q-&ﬁhﬂ@-ﬂ-@ﬂﬁ@ﬁ

PEEIET

Project Explorer o x ]
=-E ﬁroject ] N
@ || Maps
B || Matrices
- || Sound 4 Zoom Matrix E
e W i
i : C;:;pr_: ﬁ:‘ Matrix Properties...
4@ || Photo @ 30 View.. S
[#-¢® | | Bound
@ | Sectiof @ Set Active
G-4E) [ | Shorel

a Remove Matrix...
After selecting the matrix you want to use, set the cursor to "Query Object" by selecting the (il putton in
the toolbar.

You can now click anywhere within the boundaries of the matrix to retrieve depth information. The depth,
interpolated from the four nearest cells, will be calculated and displayed as shown below:
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Query Object Information @
Property Value
El Shape Attributes
X 163927
4 434436
Z 5.74
Convert shape to shoreline o  Conver shape to boundary

When ready, right click on the map to dismiss the dialog and reset the mouse mode to "Pan".
Querying CAD or GIS features

In order to retrieve information on a object or feature on a CAD or GIS map, make sure the map is
currently active.

You can activate (which means that is the map selected for operations) a map by right-clicking it in the
"Project Explorer" and selecting the "Set Active" option as shown below:

File Wiew Tools Options Survey MNavigation Cursor Help

N | EEER MSEE @ @0

®

e

e —————————
Project Explorer o x
= i’foje& | N
=@ Maps 3
LD [ . | =
-4 || Matrig 4~ Zoom Map (2 -
@D - i 5 Map Properties... E:
(-G ] Waypd
@ ] Comn| &) Set Active
-.£& || Photo
&-a [ Bound Bl Convert to matrix...
-G [ Sectio Q Remove Map...
- | Shorel -|

After selecting the map or layer you want to use, set the cursor to "Query Object" by selecting the <img
src="buttons/button_00015.png" border="0" /> button in the toolbar.

You can now click on the object you want to retrieve information for. When an object has been found, the
"Query Object Information" dialog will be displayed:
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3.9

Query Object Information @
Property Value
El Shape Attributes
LAYER MEBEB_VERG_HGTLM
HAMDLE FO
I = Convert shape to shoreline | I :_;; Convert shape to boundary

In this example we are querying a CAD object from a DXF file, so the DXF layer and handle are
displayed.
When ready, right click on the map to dismiss the dialog and reset the mouse mode to "Pan".

Converting CAD or GIS features to shorelines or boundaries

As you may hawve noticed, there are two buttons on the info dialog called "Conwvert shape to shoreline"
and "Conwert shape to boundary".

These functions allow you to import the shape of a boundary or shoreline directly from a loaded CAD or
GIS file.

Just select the object you want to use, and select either the boundary or shoreline option.

Coordinate calculator
Introduction

Eye4Software Hydromagic has a built in coordinate calculator tool, which can be used to conwert a single
projected (easting/northing) or geographic (latitude/longitude) coordinate. This tool can, for instance, be
used to check whether configured map grids and map datum are working correctly. All map datums,
grids and ellipsoids configured in Hydromagic can be used with this conversion tool.

The following calculations are supported:

Convert geographic coordinates to projected coordinates;

Convwert projected coordinates to geographic coordinates;

Transform geographic coordinates between different map datums;

Convert projected coordinates from one coordinate reference system to another;
Conwert geographic coordinates between different latitude and longitude formats.

AN

Start the Coordinate Calculator

You can start the Coordinate Calculator by selecting "Coordinate Calculator..." from the "Tools" menu in
the main window.
After selecting this option, the following window should appear:
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Coordinate Calculator

Source Coordinates

Source Grid:

Source Datum: WGES 84

Latitude: as1| | 00 00.00
Longitude: o4 oo 00,00
Altitude: ' 0.000 | Meters
Destination Coordinates

Destination Grid: . Amersfoort [ RD Mew

Destination Datum: . Amersfoort

Morthing:
Easting:

Altitude: -45.120 | Meters

The built-in Coordinate Calculator can be used to convert a single coordinate, or to test
1y A@map datum or map grid configuration. To use geographic coordinates, select a map datum.

= Swap

. Geographic Longitude [ Latitude

M

Q Clear...

() dd.dddd
i) dd mm.mmm

i® dd mm ss.55

335406.854 | Meters

57624.623 | Meters

ﬁe!e_ct...
S.e!e.ct...
5] Map...

| Select..
~ | Select..

ﬂ.l Map...

%  Cloze

Using the Coordinate Calculator

To perform a coordinate conversion, you have to enter the following information:

AN

Source map datum or map grid,;
Destination map datum or map grid;

Source coordinates, geographic or projected,;

The format used for the geographic source coordinates (optional);

The source altitude (optional);

Source Coordinates section

Source grid

In this field, the name of the source map grid is displayed. When the source coordinate is in geographic
coordinates, the text: "Geographic Longitude / Latitude" is displayed here. To set the source coordinates
to geographic coordinates, you have to select a map datum instead of a map grid.

Source datum
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In this field, the name of the source datum is displayed. When a map grid is selected, this field displays
the map datum used in this map grid. To set the source coordinates to projected coordinates, you have
to select a map grid instead of a map datum.

Source coordinates (X)

Depending on whether you selected a map grid or not, this field is used to enter the source easting (X) or
longitude coordinate. When using a map grid, the units of the X-axis are displayed ( for instance: meters,
feet, links etc... ). When using a map datum, geographic coordinates are displayed as specified with the
radio buttons.

Source coordinates (Y)

Depending on whether you selected a map grid or not, this field is used to enter the source northing (Y)
or latitude coordinate. When using a map grid, the units of the Y-axis are displayed ( for instance:
meters, feet, links etc... ). When using a map datum, geographic coordinates are displayed as specified
with the radio buttons.

Map button

When you click the "Map..." button, the software will convert the source coordinates entered to a
WGS84 geographic coordinates, and displays this position as a marker in a Google Maps web page.
This way you can check whether the correct coordinates have been entered.

Source geographic format

When using geographic coordinates, 3 radio buttons are shown, you can use these buttons to select the
geographic format:

v' Decimal Degrees;
v' Degrees, Decimal Minutes;
v' Degrees, Minutes, Seconds.

When a map grid is selected, these buttons are hidden, and the coordinates are always displayed in
northing and easting (projected) units.

Destination Coordinates section

Destination grid

In this field, the name of the destination map grid is displayed. When the destination coordinate is in
geographic coordinates, the text: "Geographic Longitude / Latitude" is displayed here. To set the
destination coordinate to geographic coordinates, you have to select a map datum instead of a map grid.
Destination datum

In this field, the name of the destination geodetic datum is displayed. When a map grid is selected, this
field displays the map datum used in this map grid. To set the destination coordinate to projected

coordinates, you have to select a map grid instead of a map datum.

Destination coordinates (X)
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Depending on whether you selected a map grid or not, this field is used to display the calculated
projected coordinates. When using a map grid, the units of the X-axis are displayed ( for instance:
meters, feet, links etc... ). When using a map datum, geographic coordinates are displayed as specified
with the radio buttons.

Destination coordinates (Y)

Depending on whether you selected a map grid or not, this field is used to display the calculated
projected coordinates. When using a map grid, the units of the Y-axis are displayed ( for instance:
meters, feet, links etc... ). When using a map datum, geographic coordinates are displayed as specified
with the radio buttons.

Map button

When you click the "Map..." button, the software will conwvert the destination coordinates to WGS84
geographic coordinates, and displays this position as a marker in a "Google Maps" webpage. This way
you can check whether the correct coordinates have been entered or calculated.

Destination geographic format

When using geographic coordinates, 3 radio buttons are shown, you can use these buttons to select the
geographic format:

v' Decimal Degrees;
v' Degrees, Decimal Minutes;
v' Degrees, Minutes, Seconds.

When a map grid is selected, these buttons are hidden, and the coordinates are displayed in northing
and easting (projected) units.

Buttons

Transform

Using the transform button you can perform the actual map grid or map datum conwversion. The source
coordinates are always used as input, and the calculated result is displayed in the destination
coordinates section.

Swap

When clicking the "Swap" button, all the values of the source and destination coordinates sections are
swapped. This allows you to perform a reverse calculation without the need to re-enter all information.

Clear
By clicking the "Clear" button, all fields and settings are reset to their default values.
Close

Closes the window after saving the current settings and values.
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4.1

Map display / Background maps

Loading Maps
Loading Maps

When starting a new project, it is recommended to load a map of the surwey area.
The map can be used as guidance to setup your boundaries, cross sections and route.

Hydromagic supports a large number of both vector and raster map formats including:

v S-57 Electronic Nautical Charts
v S-63 Electronic Nautical Charts
v ESRI Shape Files

v ARC/INFO Export Files

v ARC/INFO Generate Files

v ARC/INFO binary cowerage files
v ARC/INFO ASCI! grid files

v’ Atlas BNA boundary files
v'BSB nautical maps (version 3)
v GeoTIFF files

v/ AutoCad DXF files

v Microstation DGN files

v PNG,GIF,JPEG and BMP image files
v USGS Digital Line Graph files
v OpenStreetMap XML files

v IDRISI vector files

Downloading Maps
When you do not have any maps of your suney area, you can download one by entering the map's

boundaries.
How to do this is discussed in more details in the chapter "Downloading Maps".

Creating a new project

Before you will be able to add background maps, you should have loaded an existing project, or you have
to create a new project.
To do so, select the "New Project..." option from the file menu, fill out the required fields and click "OK".

It is important to provide the correct projection for your new project, because you will not be able to
change this at a later time.
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Project Properties

Project Mame: | Demo Project
L

Project Location: C:\UsersiLeon\DocumentsiHydromagic),

Map Projection: Amersfoort [ RD Mew

Project Description: Demo Project

Surveyor: Leon Steijger

L | When creating a new praject, a new subfalder with the project name will be created under the
# folder which is spedified in the project location field. The description and surveyor fields are optional.

| Create || X Cancel |

Importing maps

Maps are imported into the project, this means that the next time you open the project, the map will be
loaded automatically.

To import a map to the project, select "Import Map..." from the "File" => "Import" menu, as shown in the
image below.

A file open dialog will be presented. By default all supported map formats are displayed.
You can select one or more maps and click "OK" to load them into the project.

After loading maps, you will be able to display your vessels position on the map, add waypoint,
comments and photo's and to start soundings.

File | Edit View Tools Options Survey
f| L import Map... |h [
Tu Download Map... i
| 1 New Project.. Ctri=M
[  Open Project... Ctrl= O
= | save an Ctrl=5
Import +
Export F

A file open dialog will be presented. By default all supported map formats are displayed.
You can select one or more maps and click "OK" to load them into the project.
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4.2

When no filter has been set, and the software doesn't know which format the map is, it will ask as shown
below:

Select Map Format H

Failed to determine the format of the file you are trying to open.
Please select the format below, and dick "OK” to load the map
or "Cancel” to return to the file selection dialog.

AutoCad DXF Drawing File {*.dxf)

BSE Mautical Map File (*.kap)

ESRI Shape File (*.shp)

GeaTIFF | TIFF File (=.tf)

Graphical Interchanage Format File (*.gif)
JPEG Image File (*.jpa)(*.jpeqg)
Keyhaole Markup Language (*.kml)
Microsoft Windows Bitmap File (*.bmp)
Microstation DGM Design File (*.dan)
Portable Metwork Graphics File (*.pnag)
557 Electronical Mautical Chart (*.000)

Loading IHO S-57 ENC's
Introduction

S-57 is a standard for electronic nautical charts defined by the IHO (International Hydrographic
Organization).

S-57 is used for most official hydrographic maps around. Hydromagic supports both unencrypted and
encrypted (S-63) charts.

It is a vector format which contains features (lines, areas and points) and attributes like depth, symbol,
lights etc.

Obtaining S-57 maps
S-57 maps are availble online (for free) for the following countries:

v United States (Inland and coastal waters);
v Austria (Inland);

v’ Belgium (Inland);

v/ Bulgaria (Inland);

v/ Croatia (Inland);

v’ Czech Republic (Inland);
v Germany (Inland);

v Hungary (Inland);

v Netherlands (Inland);
v"Romania (Inland);

v Serbia (Inland);

v Slovakia (Inland);
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v Swiss (Inland).

A more detailed list of sources for S-57 data can be found on our website: http://www.eye4software.com/
hydromagic/gettingencs/.

For other countries, data can only be purchased in S-63 format. For more information on S-63, please
refer to the next chapter.

Loading S-57 maps

S-57 maps can be load into Hydromagic by right clicking "Maps" in the Project View, and selecting the
"Import Map..." option as shown in the image below.

The file extension for both S-57 and S-63 maps is ".000". The software will auto-detect whether the
selected map is encrypted or not.

g Untitled - EyedSoftware Hydromagic

File VWiew Tools Options Mavigation Cursor Help

JEd s GEBL L &L

Project Explorer
. = | Project
[
- ] M| 2} Import Map...
~@ || 50 il  Download Map...
- 5] R
D w2
- E || Comments
43 |__| Photos
4@ | Boundaries
- || Sections

4.3 Loading IHO S-63 ENC's
Introduction

IHO S-63 is a standard for encrypting, securing and compressing electronic nautical charts, also known
as ENC's. The standard is using CRC32, SHA1, DSA and Blowfish algorithms to ensure protected
delivery of nautical charts. Most commercial ENC's on the market today are protected using the S-63
standard.

Each software installation contains an unique hardware id which is encrypted and cannot be read by the
user. Charts purchased for this software will work on this installation of the software only. The hardware
id is encrypted using the OEM and manufacturer id forming the 'Userpermit’ which is used to purchase
ENC's.

Purchasing ENC's
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S-63 ENC's can be purchased through your local marine supplies dealer, or online reseller. In order to
purchase ENC's you need the 'Userpermit’, and register it with the online chart store or your local
reseller. Because the hardware id is encrypted in the Hydromagic registration code or hardlock, it is only
possible to use S-63 ENC's in registered versions of the software. It is not possible to load these charts

when using a trial version.

Obtaining the userpermit

To obtain the userpermit for your software installation, select the "S63 ENC Permits..." option from the
"File” menu, as shown in the screenshot below:

i Untitled - EyedSoftware Hydromagic

: Filei'u'iew Tools Options

Mavigation Cu

‘| 2 import Map...

P _j Mew Project

,_j Open Project...
lﬂ Save Project

Save Project As...

Import
Export

% 563 ENC Permits...

Print...
[ | Print Preview
Print Setup...

3 ChUsersh..\rotterdam.gmp

Exit

Ctri+M
Ctri+0
Ctri+5

Ctri+P

1 Citemphbbd\antwerpen.gmp
2 Chitempibbd\ClippingTest.gmp

4 OtempibbdyFluessen.gmp

g

s

This will launch the "S63 ENC Permits" dialog, which contains the userpermit, and can be used to
activate purchased ENC's. When you are using a registered version of the software, the dialog should

contain the userpermit which can be used to purchase ENC's.
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-

563 EMC Permits

User Permit

User Permit:

51ABAS3E31D3BD5B000BD4704636 |__|_| Copy

MOTE:

Certificate:

Status:

MOTE:

Scheme Administrator Certificate

Loaded Permits

The user permit is required to order ENC's from your chart supplier or online chart store.
Please note that encrypted EMC's can only be used with registered versions of this software.

C:\Program Files (x858)\Eye4Software\HydroMagic\Program\IHO.CRT

Succes

The server administrator certificate is used to authenticate the ENC's loaded.
Do not change this, except when the currect certificate has expired, or the SA is not IHO.

Cell Mame

Expires on Status

[}Q. Load Pemits... ” @ Bemove. ..

[ 0K | % Cancel |

L%

Activation of purchased ENC's

When purchasing ENC's you will receive a "PERMIT.TXT" file from your reseller containing the 'Permits’
for the purchased ENC's. After importing this file, you will be able to load these. To do so, relaunch the
permits dialog by selecting "S63 ENC Permits..." from the "File" menu.

You can now load the "PERMIT.TXT" file, by clicking the "Load Permits..." button, and selecting the
received permit file. You only have to do this once, imported permits will be stored until the software is

reinstalled.

When the file has been imported successfully, you will see something like this:
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563 EMC Permits

E=X=)

User Permit
User Permit: E1D0OEBS FEDBE27E8FGBEOCAI34636 |:|_| Copy
MOTE: The user permit is required to order EMC's from your chart supplier or online chart store.

Scheme Administrator Certificate

Certificate:

Status:

MOTE:

Loaded Permits

Please note that encrypted EMC's can only be used with registered versions of this software.

C:\Program Files (x858)\Eye4Software\HydroMagic\Program\IHO.CRT

Succes

The server administrator certificate is used to authenticate the ENC's loaded.
Do not change this, except when the currect certificate has expired, or the SA is not IHO.

Cell Name Expires on Status e
& NL400110 6/30/2013 Succes
@ NL400127 6/30/2013 Succes
@ ML400123 6/30/2013 Succes i
@ NL400125 6/30/2013 Succes =
& ML400125 6/30/2013 Succes
@ NLA015496 6/30/2013 Succes
@ ML501324 6/30/2013 Succes 4
@& ML50132B 6/30/2013 Succes
@ MISN1334 BIA0/2013 SHCres b

[ s Load Pemits... :H & Remove..

|« oKk [ X cancel |

L

In most cases the reseller can supply you with a "ENC Base CD" containing all the charts for your
region. If not, you can download the charts, depending on your reseller, from Primar or IC-ENC.

When the ENC's and permits are correctly installed, just select "Import Map..." from the "File" menu,
and select the ENC you want to load. When trying to load an enc that has not been purchased, you will
receive error SSE 11 as shown in the table below.

When an error occurs during the import of permits, or when loading an ENC, you will receive one of the
errors described in section 4.4.5. In case of an error, contact your ENC reseller.

e

SSEO1
SSEO02
SSEO03
SSE04
SSEO05

Self Signed Key is invalid.

Format of Self Signed Key file is incorrect.

SA Signed Data Server Certificate is invalid.
Format of SA Signed DS Certificate is incorrect.

SA Digital Certificate (X509) file is not available. A valid certificate can be obtained from
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e

SSEO06

SSEOQ7

SSEO08

SSEO09
SSE10

SSE11
SSE12
SSE13

SSE14

SSE15

SSE16

SSE17

SSE18
SSE19

SSE20

SSE21

SSE22

SSE23

SSE?24
SSE25

SSE26
SSE27

the IHO website or your data supplier.

The SA Signed Data Server Certificate is invalid. The SA may have issued a new public
key or the ENC may originate from another senice. A new SA public key can be obtained
from the IHO website or from your data supplier.

SA signed DS Certificate file is not available. A valid certificate can be obtained from the
IHO website or your data supplier.

SA Digital Certificate (X509) file incorrect format. A valid certificate can be obtained from
the IHO website or your data supplier.

ENC Signature is invalid.

Permits not available for this Data Sener. Contact your data supplier to obtain the correct
permits.

Cell Permit not found. Load the permit file provided by the data supplier.
Cell Permit format is incorrect. Contact your data supplier and obtain a new permit file.

Cell Permit is invalid (checksum is incorrect) or the Cell Permit is for a different system.
Contact your data supplier and obtain a new or valid permit file.

Incorrect system date, check that the computer clock (if accessible) is set correctly or
contact your system supplier.

Subscription senice has expired. Please contact your data supplier to renew the
subscription license.

ENC CRC value is incorrect. Contact your data supplier as ENC(s) may be corrupted or
missing data.

Userpermit is invalid (checksum is incorrect). Check that the correct hardware device
(dongle) is connected or contact your system supplier to obtain a valid userpermit.

HW_ID is incorrect format.

Permits are not valid for this system. Contact your data supplier to obtain the correct
permits.

Subscription senice will expire in less than 30 days. Please contact your data supplier to
renew the subscription license.

Decryption failed no valid cell permit found. Permits may be for another system or new
permits may be required, please contact your supplier to obtain a new license.

SA Digital Certificate (X509) has expired. A new SA public key can be obtained from the
IHO website or from your data supplier.

Non sequential update, previous update(s) missing try reloading from the base media. If
the problem persists contact your data supplier.

ENC Signature format incorrect, contact your data supplier.

The permit has expired. This cell may be out of date and MUST NOT be used for Primary
NAVIGATION.

This ENC is not authenticated by the IHO acting as the Scheme Administrator.

ENC is not up to date. A New Edition, Re-issue or Update for this cell is missing and
therefore MUST NOT be used for Primary NAVIGATION.
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4.4

4.5

Supported Raster Formats

Supported Raster Maps

Raster maps are basically bitmap images. They only contain some image data, and in some cases
(GeoTIFF) some georeferencing information. These maps do not support high zoom lewvels, because they
are limited by the number of pixels the map is stored in.

You can load a raster map into your project by selecting "File" => "Import" => "Import Map..." from the
menu.

GeoTIFF Files

. GeoTIFF files are based on the TIFF (Tagged Image File Format) standard. This format
. allows you to insert all sorts of tags into an image file. GeoTIFF uses this to store
information on calibration info and / or projection information in the file. When you try
to load a map that only contains the calibration info (XY boundaries and scale
information), you will be asked to set the projection parameters for the map.

JPG, GIF, TIF, BMP and PNG Image Files

It is possible to use your own images to project routes, waypoints, tracks and
realtime position on. These images can be downloaded from the web (for instance,
image created with Google Earth or maps exported from OpenStreetMaps.org, or
created by scanning paper maps. To use these images, they have to be calibrated in
order to be used. This can be done by selecting some well known coordinates on the
map, or by entering the boundaries of the map. For more information about calibrating
these maps, see the Calibrating Maps Tutorial. When a file has an associated "World
File" the map is calibrated using this information.

BSB Nautical Charts

SEe ~ — BSB map files are raster charts designed especially for nautical charts. They are used
e i by seweral authorities like NOAA. Nautical maps can often be downloaded for free in
' the BSB format. When loading BSB files in GPS Mapping Studio, the map is
displayed directly, because all geo info is included in the map. BSB maps use
Lambert Conformal Conic, Mercator and Polyconic projection.

Supported Vector Formats

Supported Vector Maps

Vector maps are files that contain objects instead of image data. A typical example of an object can be
a line, point, polyline, polygon and more. Sometimes these objects are also associated with some
userdata or a row in a datatable. Because the vector objects drawn at runtime, there is no limitation on

the zoomlewel like rastermaps.

You can load a rastermap into your project by selecting "File" => "Import" => "Import Map..." from the
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menu.

AutoCad DXF files

DXF stands for Drawing eXchange Format, and was developed by AutoDesk and is
used in AutoCad software products. It is a vector format, this means the file contains
objects rather then just image information ( pixels ). AutoCad DXF files are not
designed to store georeferencing information, so after loading a DXF map, you will be
asked to set the projection parameters.

Microstation DGN files

DGN is a vector format used in Microstation CAD software. The software currently
only supports the ISFF (Integraph Standard File Formats) DGN format. The newer V8
DGN format is not supported yet. In ISFF format, all objects are stored as blocks into
a single file. Each Microstation design file starts with a TCB element, containing
global information on the file, like scale, units and extends.

ESRI shape files

ESRI shapefiles are vector maps often used to exchange data between GIS and CAD
applications. Like DXF files, it contains objects rather then image information. An
ESRI shapefiles consists out of 3 parts, a .shp, .dbf and .idx file. The databse and
index files are ignored by GPS Mapping Studio, it only uses the .shp file which
contains the map objects. The .dbf database file is only used by GIS applications.
Map calibration info is extracted from the shp file. When loading an ESRI shapefile,
you have to set the projection parameters by hand.

4.6 Downloading Maps
Introduction

In circumstances where an electronic nautical map or CAD drawing of your surveying area is not
available, you can use the map download functionality offered by Hydromagic.

It allows you to use street maps or satellite imagery from Google, Bing or OpenStreetMaps as
background image for your project.

Tiles are downloaded from the provider of choice, merged into a map image and geo-referenced to the
projection you are using in your project.
Therefore you have to select the map projection you are going to use before downloading any maps.

Please note that storing map tiles locally breaks the terms of service for a couple
of popular data providers like Google, Bing, and ArcGIS Online.
Use this function at your own risk !

Download Map Tool
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It is only possible to download maps once you loaded or created a project. To create a new project,
select "New Project..." from the "File" menu.

To start the map downloading tool, right click the "Maps" folder in the "Project View" and select the
"Download Map..." option from the popup menu as shown in the image below.

In case you didn't select a map projection for the project yet, you will be asked to do so, if not the
download tool is displayed.

4

.iFiIelEdit View Tools Options Survey

| |Lg | Import Map... tI
1} E

Pl &y Download Map...

Mew Project... Clrl+N
COpen Project... Ctrl+= O
Save All Crl+5

- W e

Import L4

Export k

The tool allows you to download street maps or satellite imagery from the following 5 providers:

v OpenStreetMaps;

v  ArcGIS Map Senice;
v Nokia OVI Maps;

v  Google;

v Bing (Virtual Earth).

Setting area and options

In order to download maps, you have to select the area you need a map for, and which provider you want
to use.

Use the "Information Source" selection box to select the provider and the type of map (streets or
satellite).

The next step is to select the area. Select the smallest area as possible, because the smaller the area,
the higher the zoom level and lewel of detail.

You hawe to enter the upper-left and lower-right WGS84 coordinates of the area you are suneying in.
Because the maps are downloaded as 256 x 256 pixel tiles, it is likely that the actually downloaded area
is a bit larger then the requested area.

You can obtain the coordinates by using a map viewer like Google Earth or others.

Finally, select the name of the output file (the file where the map is stored) and whether to add the map
to the project directly.

Depending on the type of map you are using, the image is stored as PNG (streetmap) or JPG(satellite)
file.
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Information Source

Source: |G CpenStrestMaps b |

Map Boundaries

E 004, 108253658" : E 004,11552197"

M 51.92788181" E M 51.92338807"

[ | Show position in Easting / Morthing coordinates

Output File

File: | <ciick Browse..." to select output file> || EL Browse..

Add generated map to project after creation

i Storing maps locally breaks the terms of service for a couple of popular data
providers like Google, Bing, and ArcGIS. Use this function at your own risk !

i 0K || X Cancel |

Area selection tools

As an alternative to enter the coordinates manually, you can calculate boundaries from a waypoint,
sounding, boundary, current location or an address.
To do so click the "Calculate..." button. The following dialog will appear:
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Select Download Area “

Map Area Selection

() Use current GPS position as center

(®)Use address as center: s Find Address..
'1::1' Lse waypoint coordinates as center: M WETOD1

() Caloulate map boundaries from raw data file: , RAWO0001

(i Calculate map boundaries from sounding: , SMDGO0001

() Calculate map boundaries from boundary: gl BOUMDARYDOO1

Map Dimensions

Width: | 500.00 m Height: | 500.00 m

« 0K # Cancel

The first three options (GPS Position, Address and Waypoint) can be used to specify the center of the
map. To calculate the map extends, you have to enter the map dimensions.

When using the last two options (sounding or boundary), the map dimensions entries are disabled, and
the boundaries are copied directly from the area covered by the selected sounding or boundary.

Please not that when using the "Find Address..." tool, make sure you are connected to the internet in
order to perform a Geo-Coding lookup.

Download

To start downloading, just click the "OK" button. Please note that you have to be connected to the
internet at this moment.

The download progress is shown in the status bar. First, the tiles are downloaded and merged into a
larger images, which is geo-referenced using the projection set.

When downloading has been completed, and the "Add generated map" options has been checked, the
map will be added to the project and displayed.
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4.7

L ... %

100

Changing drawing order
Changing map drawing order

In cases where a map (partially) covers another map, you can control the sequence in which the maps
are drawn.

When using multiple maps, always draw vector maps on top of raster maps (unless the raster maps have
transparency).

You can also use this option to place vector maps on top of a matrix created by Hydromagic

Map Order Tool

To change the map order, select "Layers..." from the view menu. The "Map Display Order" dialog
appears:
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4.8

Map Display Order H

Layer Mame

\Eg fluessen, duf
Ll FriesLand. dxf

bR |

|| StartEiland. jpg

. Move To Front =1 Move To Back

o DK

Click the "Mowe To Front" or "Move To Back" buttons to change the drawing order.
Changes will be applied directly. To accept the order, click "OK" to close the tool.

Adding waypoints to the map
Introduction

A waypoint can be defined as a marked position on a map, somewhere on the earth, with known
coordinates. A waypoint can be part of a route. In GPS receivers, a waypoint is a point that can be
selected as a coordinate to navigate to, or it can be used to just display a symbol on a map.

Creating a waypoint

In Hydromagic, there are multiple ways to create waypoint. You can create one manually from the
waypoint list, click on the map or create by applying a projection from a known waypoint or GPS
position. The easiest way is by clicking on the map. We will demonstrate in a few steps how to do this.

Zoom and pan over the map until you find the position you want to place a waypoint. Click the right
mouse button, when pointing the mouse to the position, and select the "Add Waypoint" option. The "Add
Waypoint" window will appear.
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Edit Waypoint Ex
Waypoint
Mame: WPTOO3
Marthing: 559644, 54 "’E" Find Address...
Easting: 178838.45
Symbol: ¥ Mavaid, Red v
Display: Symbol & Mame W

Description: | A simple waypoint

Show position in northing [ easting coordinates

Waypaint Label
FgColor: ( | vl
BgColor: E' [ ] Transparent

Proximity Waypoint

[ Proximity Waypaint Distance: | 0.00

o QK % Cancel

You will notice that the position of the waypoint is already filled. In this window, you can set some
additional information about the waypoint, like the comment, the name, the symbol to be used on the
map etc. The proximity waypoint option will be discussed in a later tutorial, it is mainly used to alert you
if you are within a specific distance from the waypoint.

Waypoint Properties Window

Name

Use this field to set the waypoint name. When creating waypoints, the software will auto generate the
waypoint name in the range "WPT001" ... "WPT999". You can choose your own name, but please note,
that in case you want to upload the waypoint to your GPS receiver, you have to keep the maximum
waypoint name length of your GPS receiver in mind. The name must be unique: you can not create more
then one waypoint with the same name.

Latitude and Longitude position

These positions are prefilled when you create the waypoint from the map. If you are creating the waypoint
from the waypoint list, the current position is used. You can change these fields to display the Northing
and Easting position using the currently selecting map grid, by checking the "Show position in Northing /
Easting coordinates” check box.

Symbol
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The software contains over 160 different symbols that can be used to display your waypoint on the map.
When uploading the waypoint to your GPS, the same symbol is used, so you must be sure that the
symbol you choose is also present in the GPS device. The default waypoint symbol is the "Black
Rectangle" that is supported by any GPS receiwer.

Description

You can add a description for the waypoint here. When uploading the waypoint to the GPS receiver,
depending on the model you are using, the description will be displayed truncated on your GPS receiwer.

Waypoint Label

Using the "BgColor", "FgColor" and "Transparent” options, you can modify the colors of the waypoint
label on the map. When transparent is selected, the background color is ignored, and only the text is
displayed on the map.

Proximity Waypoint

If you want to act this waypoint as a proximity point, enable this function. Please note that not all
receivers support this option. When enabled, your GPS will alarm you if you are withing a certain range
from the waypoint.

Saving the Waypoint

After modifying the waypoint properties, click "OK". When using the settings from the screenshot abowe,
the waypoint will look like this:

WWETOO

Modifying or moving the Waypoint

To modify the Waypoint after you placed it on the map, you can use either the waypoint list, or right click
on the waypoint, and select "Waypoint Properties”, as displayed below:

To move the waypoint, click on it and just drag it around on the map. When you release the mouse
button, it's new position is saved.
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ZoomIn
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Edit Waypoint...
Add Waypoint...
Remove Waypaoint...
Project Waypoint...

Add Comment...
Add Photo...
Add Corner..,
Add Section...
Add Trackpoint...

Show in Google Maps
Find Map

The Waypoint List

92

To view a list off all Waypoints, you can open the Waypoint list, by selecting "View" => "Waypoints"

from the menu.

From this list, you can remowe, add, modify, export and zoom to Waypoints.
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Waypaint Morthing Easting
G M WPToo1 559918.52 173510.93

D M WRTO02 539995.28 177948.30
@ ¥ WPTD03 559644, 54 178838.45 A simple waypoint

= OO x 9 |%| L H

Projecting Waypoints
Projecting a waypoint

When projecting a Waypoint, you basically create a Waypoint on a certain distance and heading from a
known position. In Hydromagic, there are multiple ways to project a waypoint. You can project the
waypoint from another Waypoint, a position on the map, a manually entered position or the current GPS
position. In this tutorial, we will project a Waypoint, using another Waypoint as a reference.

To open the "Project Waypoint" window, select the "Tools" => "Project Waypoint" option from the menu.
The following window will appear:
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Project Waypoint
From Waypoint
Waypoint: WPTO01 . Select...
From Position
Marthing: 20965903.67 | | 4@ GPS
Easting: 374256.28

Show position in grid coordinates

Distance and Bearing
Distance: 100,000

Bearing: 45.0

In this window, you will find 2 buttons, a "Select..." button, to select the source Waypoint, and a "GPS"
button which can be used to automatically enter the current GPS position as source location. For this
example, we will use another waypoint, so we click the "Select..." button and choose a Waypoint from
the list. If there is no Waypoint in the list, you can walk through the Creating Waypoints tutorial to create
a one. Once you selected a Waypoint, the coordinates of this Waypoint are copied into the Latitude /
Longitude fields.

For this example, we will create a new Waypoint at 100 meters and a 45 degrees course from the
selected Waypoint. After we entered these values, we click "Project...".

Saving the waypoint

A "Waypoint Properties" window will appear with the location of the projected Waypoint already entered.
You can now modify the waypoint's attributes such as name and symbol. Please note, that when a new
Waypoint is created, by default the symbol and label properties are copied from the last created
waypoint. This might be very handy when creating multiple waypoints that should use the same
attributes. When done, click "OK" to save the waypoint.
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Waypoint
Name: | WPTOO3

Northing: | 559544.54

Easting: | 178838.45
Symbol: |3l€ Navaid, Red
Display: | Symbol & Mame

Description: | A simple waypoint

Show position in northing [/ easting coordinates

Waypaint Label
FgColor: ( | ]
BoColor: || | [ Tansparent

Proximity Waypoint

[ 1Proximity Waypeint

Ready !

When looking at the map, you will find the "WPT002" waypoint projected at an angle of 45 degrees and a
distance of 100 meter from the selected waypoint.
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4.10 Adding comments to the map

Introduction

In Hydromagic, it is possible to add comments or labels to your maps. You can use comments or labels
to, for instance, mark places, or to add extra comments about the map before printing it. You can place
comments using any color or Windows font, with or without background.

Adding a comment

T are multiple ways to add a comment. You can create one manually from the comment list, or click on
the map to place a comment at the current mouse position. The easiest way is by clicking on the map.
We will demonstrate in a few steps how to do this.

Zoom and pan over the map until you find the position you want to place a comment. Click the right

mouse button, when pointing the mouse to the position, and select the "Add Comment..." option. The
"Add Comment" window will appear.

Mew Comment [i:?-J

Comment

Latitude: M 35°51'10.09"
Longitude: W 124°15'32,527
Comment: A Sample Comment

Show position in northing [ easting coordinates

Display

FgColor;

BgColor:

Font: M Comic Sans M5 -
Size: 24 -

A Sample Comment

« OK ||<:5€ Cancel

L

You will notice that the position of the comment is already filled out. In this window, you can add a
comment to store with the map. You can also change the fore- and background colors and the font used
to draw the comment on the map.

© 2015 Eye4Software B.V.



97

Eye4Software Hydromagic 7.0

Comment Properties Window

Latitude and Longitude position

These positions are prefilled when you create the comment by right clicking on the map. If you are
creating the comment from the comment list, the current position is used. You can change these fields
to display the Northing and Easting position using the currently selected local grid (if set), by checking
the "Show position in Northing / Easting coordinates" check box.

Comment

Enter the comment here. It will be appear on the map exactly as you entered it in the "Add Comment"
dialog.

FgColor

The color used to draw the text and border. If the transparent option has been selected, no border is
drawn.

BgColor

The color used to draw the text background. When the transparent option has been selected, this values
is ignored.

Font

Use this drop down box to select the font for the comment. All installed Windows fonts are displayed.
Please note that when the project is transferred to another PC, which does not hawe this font installed,
another font is used.

Size

Use this drop down box to select a font size. You can see the result in the preview pane at the bottom of
the dialog.

Saving the comment

After modifying the comment properties, click "OK" to add the comment to the project. When using the
settings from the screenshot above, the comment will be displayed on the map like this:
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Modifying or moving the comment

To modify the comment after you placed it on the map, you can use either the comment list, or right
click on the comment, and select "Edit Comment...", as displayed below:
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FYLFETLL" 1
S ZaomIn

: d5:) Zoom Cut

éf? Center

<¥ Add Waypoint...
<% Project Waypaint...

U3 Edit Comment...

'.'4-:;,- Add Comment...
-e,a Remove Comment..,
B2 Add Photo..

@) Add Trackpoint...

| el Show in Google Maps

gl | Find Map

To mowve the comment, click on it and just drag it around on the map. When you release the mouse
button, it's new position is saved. This option will only work, when drag-and-drop is enabled (look for the

"lock" button in the toolbar).

NEH = EER SRR IINOLL,LL D4 € ¢h CCR I B-BR-|X @

The Comment List

i[2]g®

To view a list off all comments on the map, you can open the comment list, by right clicking on the
"Comments" folder in the "Project Explorer" and selecting "Manage Comments...". From this list, you

can remowe, add, modify, export and zoom to comments. If the "Project Explorer" isn't visible, you can
show it by selecting "Project Explorer” from the "View" menu.
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4.11

F -

Comments I&J
Comment Latitude Longitude

& Comment 3 M 52715'06.69" E 006°42'04,45"

@& Comment 2 M 52%15'06.537 E 006°42'14. 15"

G Comment 1 M 52%15'10, 26" E006%42'11,94"

GE A Sample Comment M 52%15'15. 707 E 006%42'03.63"

F O Q0 S P e H [ oKk |3 cance |

L%

Adding photos to the map

Introduction

In the Hydromagic, it is possible to add references to image files, like photo's on your maps. The image's
will be showed on the map as a camera icons. When clicked, the photo will appear. Possible application
examples include:

v’ Store images of buildings in your GIS datasets;
v' Store underwater photo's or sidescan sonar images in your nautical maps;
v/ Store images of terrain features in your topographic maps;

Adding a photo

In Hydromagic, there are multiple ways to add a photo. You can create one manually from the photo list,
or click on the map to store a photo on the current mouse position. The easiest way is by clicking on the
map. We will demonstrate in a few steps how to do this.

Zoom and pan over the map until you find the position you want to place a photo. Click the right mouse
button, when pointing the mouse to the position, and select the "Add Photo..." option. The "Add Photo"

window will appear.
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[ Add Photo e |

Properties

Mame: PHOTOQOD01

Northing: 20231181 4% Find Address...
Easting: §5035.77

Description:  Beautiful Lighthouse

[¥] show position in northing [ easting coordinates

Photo
Preview: -
File: C:Wsers\Public\Pictures\Sample Pictures\Lighthouse.jpg

[.I_r_ Show... H . Browse.. |

fe OK |[H Canu:el]

L

You will notice that the position of the photo is already filled. In this window, you can add a name and
comment to store with the photo. Also, you hawe to select an image file by clicking the "Browse..."
button. At this moment, JPEG, GIF, BMP, TIF and PNG files are supported.

Please note that only the path to the image is stored in the project file. In case of a backup, you have to
backup the image files manually. Once the images are moved or deleted, the images can no longer be
viewed from the map.

Photo Properties Window

Name

Use this field to set an unique name for your photo. This name is also displayed on the map below the
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camera icon and in the project view. It is not possible to create more then one photo with the same
name.

Latitude and Longitude position

These positions are prefilled when you create the photo by right clicking on the map. If you are creating
the photo from the photo list, the current position is used. You can change these fields to display the
Northing and Easting position using the currently selected local grid (if set), by checking the "Show
position in Northing / Easting coordinates" check box. To find the position using geo-referencing, click
the "Find Address..." button. You need to have an active internet connection to use this feature.

Description
You can add a description for the photo here. This field is optional and can be kept empty.
File

Displays the full path to the image file. Click the "Browse..." button to select (another) file, or click the
"Show..." button to view the photo in the "Windows Photo Viewer" application.

Saving the photo

After modifying the photo properties, click "OK". When using the settings from the screenshot abowe, the
photo will be displayed on the map like this:
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Modifying or moving the photo

To modify the photo after you placed it on the map, you can use either the photo list, or right click on the
waypoint, and select "Edit Photo...", as displayed below:
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7

s

il L

o W 2o

2® & F&E

Zoom In
Zoom COut

Center

Add Waypoint...
Project Waypoint...

Add Comment...

Edit Photo...
Add Photo...

Remove Photo...

Add Trackpoint...

Show in Google Maps
Find Map

To mowe the photo, click on it and just drag it around on the map. When you release the mouse button,
it's new position is saved. This option will only work, when drag-and-drop is enabled (look for the "lock"
button in the toolbar).

DS 8 BEL GEROICOLLLAL DECE ¢$h QCRIB-5&- X 0 7 A[3]3 O

The Photo List

To view a list off all photo's on the map, you can open the photo list, by right clicking on the "Photos"
folder in the "Project Explorer" and selecting "Manage Photos...". From this list, you can remowe, add,
modify, export and zoom to photos. If the "Project Explorer" isn't visible, you can show it by selecting

"Project Explorer" from the "View" menu.
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Manage Photos

Mame Latitude Longitude

@D Foto 1 M 52%15'45,85" E 006%41'52,27°
G Foto 2 M 52%15'41.067 E 006°41'47.50"
G Foto 3 M 52%15'43,51" E 006=42'02,29
GE» Foto 4 M 521512527 E 006%42'10.57"
G Foto 5 M 52%15'58,42" E 006°4327. 44"

F O Q0 S P e H [ oKk [ cancel |

L%

4.12 Creating Boundaries

Boundaries

A boundary is required when using volume calculations. It is also used to specify for which area we want
to create a matrix or contours, or to specify a clipping region for certain graphical operations.

The easiest way to create a boundary is by drawing a polygon on the map, but it is also possible to enter
the coordinates by hand.

Create by using the mouse

To start a new boundary, just click "Boundary Drawing Tool" button in the toolbar: ( k).

Secondly, use the mouse to select the corners of the area by left-clicking the on corner locations in the
map. When finished, click the right mouse button to store the boundary. The new created boundary
should now appear in the "Project Explorer". By default a new boundary is named "BOUNDARY XXXX'
where "XXXX' is the number of the boundary. Boundaries are drawn as red, dotted lines. The boundary
points are drawn as red rectangles.
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Modify by using the mouse

To modify a created boundary, regardless whether it has been created by entering coordinates or by
using the mouse, can be modified by dragging it's corner point around. First, you have to activate the
boundary you want to alter. This can be done by right-clicking on the boundary name in the "Project
Explorer", and selecting the "Set Active" option. It is only possible to drag the points around when the
"Disable Drag and Drop" options is turned off (enabled by default). This can be done from the "Cursor"
menu.

Create by entering coordinates
When your client has supplied a list of coordinates for the area you have to suney, you can also create a

boundary by manually entering these points. To do so, right-click the "Boundaries” folder in the "Project
Explorer* and select the "Add Boundary..." option. The following dialog will appear:
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: -
Edit Boundary m

Boundary Properties

Mame: BOUMDARYOOD2

Width: 0 meter Height: 0 meter

Perimeter: 946 meter Area: 22377 meter
Record# Morthing Easting i
Qo001 474570.92 244130.45
Qoooo2 474576.52 244148, 54
Qo003 474534.41 2944100.71 &
Q00004 474024.21 244356.74 1
000005 474635.06 244365.62
00a00s 474045.86 2449434.03
0oaoo7 474639.99 249499.49 =i
00aoos 474038.68 244523.17
0oaoos 474038.02 244534, 35
00ao 10 474038.68 244556.39
0ooo11 474599.21 244545.21
0oao12 474599.21 244539, 29
i T o T s ATACOS 95 TAACTIC A o
= O E e 0 2 LB |« oK || ¥ cancel |

b

The table shows the coordinates of the corners of the boundary. The toolbar at the bottom of the dialog
allows you to insert, delete or alter the coordinates.
This dialog can also be used to modify boundaries created by using the mouse, or to rename a
previously created boundary:

| Buton Runcion

B @ a0l

Edit the selected coordinate.

Add a new coordinate to the list.

Insert a new coordinate before the selected coordinate.

Deletes the selected coordinate(s).
Clears the list (delete all coordinates).
Reload the list.

Show selected coordinate on the map.

Toggle coordinates between WGS84 and local grid.

Removing a boundary

A boundary can be removed by right-clicking on the boundary name in the "Project Explorer" and by
selecting the "Remowe Boundary..." option. After a confirmation, the boundary will be removed from the
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4.13

project.

Cross Sections
Cross Sections

In Hydromagic, cross sections are used to create a theoretical 3D design of the area you want to use to
perform volume calculations. The sections are in fact lines from shore to shore containing depth or
elevation information relative to the distance from the shores or riverbanks.

By using a boundary, it is possible to auto generate cross sections from bank to bank (automatic
placement). It is also possible to place them by dragging the sections at the correct place by using the
mouse (manual placement).

Automatic placement

Using automatic placement, cross sections will be generated to fill a specified boundary. The direction
of, and the distance between the sections can be selected. To use automatic placement, select the
"Generate Sections" option, by right clicking the "Sections" folder in the "Project Explorer". The following
dialog will appear:

i .
Generate Sections I&J

Setlings
Line Direction: 345 dearees
Line Interval: 10.0 meter

Section Mame Prefix: DK

Clipping Area: | DELDEMN_KADE b

[« OK Haai Cancel]

e

For the "Line Direction" you will normally specify the heading perpendicular to the shore or riverbank. You
can measure the direction of the shore using the built in "Distance and Bearing" tool.

The "Line Distance" depends on the size of the area, in this example we leawe it to the default value, 10.0
meters.

Use the section name prefix when you have multiple sets of sections. The software will start the names
of the generated sections with this prefix, so it is more easy to determine to which set a section belongs.
In this example, we will use "DK" as prefix for the section names.

Finally, select the area you want to use as clipping area for the sections. To start generating cross
sections, fill in the required fields and click "OK". The cross sections are now calculated and displayed
on the map:
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Manual placement

In some cases, the automatic placement will not suffice, for instance for irregular areas or at places the
river makes a turn. You can then make use of manual placement (eventually in combination with

automatic placement).
To create a new section, right click the position of the new cross section, and the following dialog will

appear:
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Edit Cross Section

Section Properties
Mame: Dk0043 Length: 100.00 meter
Azimuth: 45.0 degrees
Location
Start X: 243340.90 End X: 243411.61
Start: 474676.53 End : 474747. 249
Profile
Crozs Section
-20.00
-la .00
-12.00
-2.00
-4.00
0.0a
4.00
.00
12.00
1&.00
20.00
= —_ [ ) () fu LA (a0 | (] pu] =
: [} [} [} [} [} [} [} [} [} [}
=2 o] o o o o o] o o o =2
[} [} [} [} [} [} [} [} [} g
s Bt H.: Auta.. I [E&i Swap J “™ Previous Mead
It:-’-" DK Hﬁ Cancel ]

L

Enter a name for the newly created section and click "OK" (we will discuss the other options of this
dialog in the next chapter). A new section will be created with a default length and azimuth. You can use
the mouse to rotate, resize and mowve the section in the right place.

Moving, resizing and rotating cross sections

After automatic or manual placement, you will notice that a single cross section is drawn as a dashed
purple line with 3 anchor points. You can select these points with the mouse to move or rotate the cross

section using the map.

By dragging the center point of the cross section, you can drag and drop it to the new position. In order

to rotate or resize it, use either one of the start and end points of the cross section.

Please note, that in order to drag and drop any objects on the map, you have to disable the "Disable

drag and drop" option from the "Cursor" menu.
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Delete cross sections

There are two ways to delete a single cross section:

1. Right-click the center anchor point of the cross section in the map, and select "Remove Section" from
the popup menu;
2. Right-click the cross section name in the "Project Explorer" and select "Remowve Section.

To delete all cross sections, right click the "Sections" folder in the "Project Explorer" and select
"Remowe All...". After confirmation, all cross sections will be removed from the project.

4.14 Cross Sections from CAD
Cross Sections from CAD
Instead of placing cross sections by hand, it is also possible to import them directly from an AutoCad
DXF project.
To use this method, please make sure you use a separate AutoCad layer for these lines.

Import

To start importing the line data used to create sections, select the "Generate sections from DXF..."
option by right clicking the "Sections" folder in the project view.
If the project view is not visible, you can show it by selecting "Project Explorer" from the "View" menu.
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P

Generate Sections from CAD file

Select CAD file

<dick 'Browse..." to select an input file

Filename:

Select layer(s) containing the sections to import

[-_ Browse...

@ SekecAl |[© Select None |

Options
Section Mame Prefix:  SECTION (optional)
Clipping Area: ] nja

 OK || % Cancel |

A

File

First, you hawe to click the "Browse..." button to select a CAD file. At this moment, only AutoCad DXF

files are supported.

If your AutoCad file is in DWG format, you can export it to DXF by using the DXFOUT command in

AutoCad.

When a valid file has been selected, the layer names will be loaded and displayed in the dialog.
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Generate Sections from CAD file

Select CAD file

Filename: C:\tempibbd\12137_Compleet Fluessen-Heidenskip-Morra. duf || Browse...

Select layer(s) containing the sections to import

»

10

| D1MAMEN

BED Peilgebied

o || BBD Vaarlijnen

BED_Geul .
| BBD_LIIN -0.37

| BBD_LIIN -0.75

| BED_LYM -0.67

| BBD_Onderlegger

m

RRN Vak te ontaoraven -1.97 NAP

@ SekecAl |[© Select None |

Options
Section Mame Prefix:  SECTION (optional)
Clipping Area: ] nja -

[ oK | % Cancel |

L™

Select Layers

After the file has been loaded, you have to check the layer(s) containing the line data used to generated

sections.
You can select one or more layers, please note that only LINE and POLYLINE entities will be converted.
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%

Original DXF file, layer to be imported is colored blue

Options

It is possible to change the prefix of the section names, as well as a clipping area. When a clipping area
(boundary) is selected, all lines will be clipped within this area.

When clipping area is set to "N/A" all lines will be loaded "AS IS".

Starting Import

To start creating lines, just click "OK". After a few seconds you will see the imported lines in your
project.
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Sections generated from DXF file shown above

Channel Design

Channel Design

After placing cross sections, as discussed in the previous chapter (Cross Sections), we need to set the
depth or elevation information of a couple of coordinates along the cross section.

These values are stored as pairs of distance and level data, where distance is the distance measured
from the start of the line.

In order to create a theoretical DTM to be used in wolume calculations, we need these values.

When the depth and the slope of the shore are known, it is possible to calculate depths on the cross
sections automatically.

Calculating profiles

To alter a cross section's profile, just right click on the center anchor point, and select "Edit Section...".
The following dialog ("Edit Cross Section") should now appear:
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i n B
Edit Cross Section [ |

Section Properties

Mame: Dk0043 Length: 100.00 meter
Azimuth: 45.0 degrees
Location
Start X: 243340.90 End X: 243411.61
Start: 474676.53 End : 474747. 249
Profile
Crozs Section
-20.00
-la .00
-12.00
-2.00
-4.00
0.0a
4.00
.00
12.00
1&.00
20.00
o — [2h] (] = L [ | (] pu] —
[} [} [} [} [} [} [} [} [} [}
=2 o] o o o o o] o o o =2
[} [} [} [} [} [} [} [} [} E

7 B ) (B Aton] [ 5w ] =

[t:-’-" OK Hﬁ Cancel]
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When first editing a cross section, you will notice the graph display is empty, this is because no depths
are stored by default. In this example, we will create a channel with a depth of 5 meters and a slope of
50 percent. This means, that for each 2 meters, the bottom depth increases with 1 meter. When the
bottom depth increases with 1 meter for each 4 meter extra distance from the shore, the slope is 25%.
To calculate profiles from this setting, click the "Auto..." button. The following dialog should now appear:
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F =
Generate Section Profile (AUTO) [
Enter channel properties Use these settings for the following sections
Level Min: 0.5 meter .. DKDD42 “..DK0032 "..DK0O22 . DKoD12 .. DKDD02
el s s " DKO041 - DKDO31 " DKo021 DKoo -, DK0oo1
.. DKOO40 ., DKO030 ., DK0O20 ., DKO010
Slope: 50 (0-100) -, DKDO39 ., DKD029 ., DK0019 ., DKDOOg
-, DKD038 -, DKOO28 -, DKOD18 -, DKOODB
. DKD037 -, DKpoz7 . DK0017 -, DKDOO7
.. DKDO36 ., DKD026 . DKDO16 ., DKO00S
., DKDO35 ., DKDO25 ., DK0D15 ., DKODOS
.. DKO034 ., DKD024 .. DKO014 ., DKDOO4
., DKD033 ., DK0023 ., DKDO013 ., DKODO3
4 1T . 3
| @ SelectAl |[© Select None || Select Visible |
i OK | % cancel |
| =

In the left section of the dialog, you can enter the channel design parameters, in the right section, you
can select the cross sections you want to apply these parameters to. In this example, the depth at the
shoreline should be half a meter, at the waterway axis, the depth should be 5 meters. The slope used is
50 percent. Click the "OK" button to apply these settings. The graph display will now look like this:

Cross Section
-1.00
-0.30

0.40
1.10 [\ .

2N /

320 \
380 \ f,_
530
a.00
o w5 L8 bodg no& & 3
=2 g2 [ = o o o] [ o o
=T = =T = T = =~ = B =

You can check the other sections by browsing through them using the next and previous buttons.
Manual editing

In cases where calculation is not usable, for instance when a different slope is used on either sides, or
when a section is not placed between shores, you have to enter the distance and depth values
manually.

To do so, click the "Edit..." button to open the profile editor:

]

The table at the left of the dialog allows you to alter, insert and delete the distance-depth pairs if the
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profile. Changes made, are directly visible in the graphical display. When done, just click "OK"

Checking the profiles

The quickest way of checking whether al profiles have been created correctly, is by creating a matrix
view using the cross sections. To do so, select the "Generate Matrix..." option from the "Sections" folder
in the "Project Explorer".

-

—
Generate Matnx from Sections u

Sections

Indude the following sections:

m

1

| @ SelectMl |[ @ SelectNone || @ Select Visble

Output File
Spacing 1.0 Meters {valid range: 0.1 ... 10.0)
Clipping Area: \_| DELDEN_KADE -

Filename: DKDTM. xyz ="\ Browse..

Please select the coordinate system used in the file,

Select by dicking the "Select” button.

Currently selected:  Amersfoort / RD New

[« oKk |[3 Cancel |

]

Select the correct boundary (in most cases the boundary used for auto placement of the sections), a
filename for the matrix, and the spacing used (can be larger for a test, for volume calculation, use the
same spacing as the matrix created from the sounding). Click "OK" and check the resullt.

© 2015 Eye4Software B.V.



Map display / Background maps 118

5.1

Recording Data

Getting Started

Introduction

Since Hydromagic Surwey version 6.0 and abowe, sensor data isn't recorded directly to a sounding file,
like it used to be in for instance, version 5.2.
All sensor data is now time tagged with millisecond accuracy and stored into a plain ASCII text file.

Advantages of using raw data files

Time Tagging

In a sounding, position values are combined with depth measurements and eventually motion and tide
correction data.

Because data isn't arriving at exactly the same time, the offset between a depth and position reading has
to be calculated.

This is done when generating a corrected sounding file from a raw data file using the "Generate Sounding
Wizard".

Latency

In hydrography, latency is the time elapsed between sending out a ping by the echosounder, and the
time the serial data with the depth value is received at the computer's serial port.

When this value is known (usually between 10 and 100 milliseconds), the delay is subtracted from the
recorded time stamp to get an even better accuracy.

The higher the speed of the vessel during a recording, the bigger the error because of latency will be.
When you are not able to apply latency corrections, don't go to fast !

Data Security
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5.2

Because the raw data is never altered after you complete recording data, you will never loose any data
by performing invalid corrections to your data.

Just use the "Generate Sounding Wizard" again to edit your original data and create a sounding file
which can be used for further processing.

Data Editing

Eye4Software Hydromagic keeps two copies of the raw data files on file. One copy is the original data,
which is never altered, and the second one is the modified data.

You can alter the modified raw data over and over again until your satisfied, and create a sounding file
from it. If the data becomes corrupted, just revert back to the original data.

Hardware Hardware Hardware
Plugin Plugin Plugin

Tide file or RTK tides

raw data
editing

Main Program
S/V, tide and draft (and navigation display)

corrections

conversion

soundings

Dynamic draft and sound
velocity correction files Volume (Contour)
Reports maps

Creating a new singlebeam sounding
Creating Soundings
Before you can create a new sounding it is recommended to perform the following checklist:

You have opened an existing or created a hew project;

Make sure the position is valid, and the GPS has good reception;

Check whether a depth is indicated in the "Data View";

Check the echosounder offset (also known as static or fixed draft);

When using a motion sensor, make sure it is tared;

Check the PC's time and date, this is important when using tide correction;

When using realtime RTK tide information, make sure the antenna offset and correct geoid model
are selected,;

AN NN AN
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v' ltis recommended to enable the "autosawe" function, please see below for more information.

The next step is to load a background map, this is not required, but it can be used to check whether
your position is still correct, and the software is still writing new soundings to the sounding.

More information on importing or downloading background maps is cowered in the Map display section of
this manual.

Recording Raw Data

A sounding is created in two steps. First you are going to record raw data. All position, motion and depth
data is time stamped and stored into an ASCI file.
The second step is to correct the raw data and generated soundings from it;

Start Recording

When you are ready to start your sunwey, just click the "Record" button ("') to start recording all sensor
data to a newly created raw data file.

Raw data files are generated every time you start a new recording. Raw files are named RAWO0001,
RAWO0002, RAW0003 etc.

To pause a recording without generating a new recording, just click the "Pause” button () instead.
When clicking the pause button again, the recoding will resume writing data to the same raw data file.

You can record the complete area to a single file, or start a new data file for each surveyed line.

Displaying raw data files

During recording, recorded raw data will be displayed on the map display.

Please note, that at this stage only the uncorrected, unsynchronized raw depth (not elevation!) and
position data is written to the display.

Elevations and corrected values will only be displayed when the raw data has been converted to a
sounding.

To change how raw data files are displayed (as track, positions or depth values), right click on the "Raw
Data" folder in the "Project Explorer" and select the "Display Options..." option.

A dialog box is presented allowing you to specify how all raw data files are displayed on top of the
background map.
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Project Explorer a x
=-._| Project i
=@ [ Maps
L@ g thuisjpg
- || Matrices

oy €3 Remove All Data...
"1;.;. Process Raw Data File(s)...
L.a® -, SNI ] Manage Files...

L Show containing folder..,

£ __| Photos x Display Options...
- || Boundirres

- E» || Sections
- || Shorelines

Autosave option

To prevent data loss, for instance due to a PC crash or AC power failure, it is recommended to use the
"AutoSawe" option.

When this option is enabled all project data (including raw data and sounding files) will be saved at the
specified interval.

To change the autosave option, select "Preferences...” from the "Options" menu, and click the
"Miscellaneous” tab. You will see an "Auto sawe" section at the bottom of this window. Now click the
"Setup..." button in this section. Enable the check box when you want to use autosave, and enter an
interval (minimum 1 minute). Click the "OK" button to apply the changes.

Autosave Options x|

Autosave Oplions

Save current project every | 120 second(s).

Itis recommended to use the autosave function to
r¢  save your recorded survey data automatically.

Manually saving the raw data

Raw data can be sawed at any time by just clicking the "Sawe" button in the toolbar (H). It will be saved
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into the "RawData" folder of your project.

53 RTK Tides

Using a RTK receiver in fixed mode, you have X, Y and Z coordinates with an high accuracy (<2 cm).
Using the Z coordinate (also known as ellipsoidal height), you can calculate the current tide level in real-
time, making it no longer necessary to have a tide gauge connected to the software, or to correct the
sounding afterwards.

In order to calculate tide lewels in real-time, you need a RTK receiver with a valid correction signal.
This correction signal can be provided by a GSM / GPRS ( NTRIP ) senice provider, UHF base station or
your own base station on a known location.

You also need a local geoid model. This is a file containing geoid - ellipsoid separation values for the
area or country you are performing your suney.

Hydromagic ships with a couple of geoid models, including Belgium, the Netherlands and North America.
If no geoid model is available for your area, please contact support.

To perform the calculation, you also need to know the exact distance between the receiving element of
your RTK antenna and the water surface.

To retrieve the ellipsoidal height from your RTK receiver, it should have an NMEAO0183 data output,
supporting either the $GPGGA or $PTNL,GGK sentence as shown in the examples below:

$PTNL,GGK,453049.0,0,3728.455440850,N,12215.253291068,W, 3,9,2.0,EHT35.7424, M*

Trimble proprietary message for RTK position

$GPGGA,042629.00,3242.86076286,S,15133.15384408,E,4,12,1.1,6.573,M,26.799,M,1.0,0000*51

Standard NMEA0183 sentence for GPS or RTK fix data

When the Trimble proprietary NMEAQ0183 message is used, the ellipsoidal height is provided directly in
the sentence, in the example abowe it is in the ellipsoidal height (10) "EHT35.7424" field.
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For standard NMEAO0183, the ellipsoidal height is calculated from the M.S.L. (9) height and geoidal
separation (11) field. In this case the ellipsoidal height is calculated by using the formula below:
In the example abowe, the ellipsoidal height is 6.573 + 26.799 = 33.372 meter.

Ellipsoidal Height = M.S.L. Height + Geoidal Separation

Formula for calculating ellipsoidal height from NMEA0183 GGA sentence
Please not that the M.S.L. ( Mean Sea Level ) height value returned by the GPS is calculated using the

global EGM96 geoid model, and isn't accurate enough to use for your suneys.
This is why you have to provide a local geoid model instead.

RTK Configuration

In order to configure Hydromagic to use RTK tides, open the preferences dialog by selecting
"Preferences..." from the "Options" menu.

To view the RTK configuration, click the "RTK" tab. You should see following dialog:
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Preferences “

Map Miscellaneous Alarms ECDIS Grid
Units and Formats Devices Calibration RTE
RTE tide calculations

IUsing this function, you can use a RTK receiver to calculate real time
tide corrections. The tide level is calculated by using the ellipsoidal
height of the RTK antenna, the antenna height and a geoid model.

IUse Real Time Kinematic (RTK) for real time tide calculation
[ ]1gnore genid model and use MSL height from GPS directly

Antenne Height

Enter the antenne height above the water surface in order to use
RTK tide corrections

Height: | 1.23 | Meters

Geoid model

The geoid model is used to calculate the separation between the
Ellipsoidal height returned by the GPS and the local geoid model.

Model: | GEOIDO3 Conus Grid 3

7, Select...

VertCon vertical datum (1.5, only)

Datum: MAVDES W

Cancel Apply

To enable tide calculation, you have to check the "Use Real Time Kinematic (RTK) for real time tide
calculation" box. When checked, you can alter the other configuration options.

First you have to enter the height of the antenna above the water surface. Make sure to measure this
distance as accurate as possible, an error in this measurement is directly converted to an error in the
tide level. Secondly, select the geoid model used in your area by clicking the "Select..." button.
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B 5028
L=8061
1 EbEE
Els01s
B s020
Els017
Bls01s
LN
B 2054
Al 8056
=—3001

Geoid

GEOID12A Conus Grid 8
HEFOS

ITG2009

MAPGEQ 2010 - SADSS
MAPGED 2010 - SIRGAS
MEXICOS7 - Central
MEXICOS7 - East
MEXICO97 - West
MORGED

MM2000

Mormaal Amsterdams Peil (M.A.P.)

Geoid Properties

Marme:
Country:
File:

@ Add || o7 Modfy || @ Delete

| Normaal Amsterdams Peil (N.A.P.)

| Metherlands

| L1 Select...

| rdnap.geo

| Browse...

Click here for a list of downloadable geoid models on our Hydromagic wehsite.

Please note that genids displayed in red are not installed. For more information
on how to install additional gecid models, please dick the link above.

& OK | X Cancel |

For some area's it is possible to select a vertical reference, like NAVD88, NVGD29, M.S.L. etc.
Please note that this setting is ignored for some countries.

When finished configuring, just click "OK" to apply the settings.

Testing RTK and geoid calculations

In order to test RTK tide calculations, connect and power on your RTK receiver and make sure you have

avalid RTK fix.

The next step is to check the values in the "Navigation Data" window. If this view isn't visible, you can
activate it by selecting "Navigation Data" from the "View" menu.
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Mavigation Data x

Latitude S 32.714601
Longitude E 151.552368

Northing 2226715.22
Easting 2036019.13

MSL 6.47 m
EHT 33.26 m

SounderHi 280m
Sounder Lo 0.00 m
Cormrected 29.55 m

Manual 0.00m
Receiver 0.00 m

RTK 32.35m

Course 3487 °

Ground 0.0 m/s

Sats 13

Diff Age 01

Beacon 0000

Time 04:27:33 GMT
PDOP 2.70

HDOP 0.90
VDOP 2.30

ﬁﬁt‘cributes Pane |7 Mavigation Data

You have to check the following:

v The EHT (Ellipsoidal Height) is displayed in the data view. If missing, check the NMEA0183
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6.1

configuration of your RTK receiver.
v When using the Trimble proprietary NMEA0183 sentence, the M.S.L. field can be 0.00.
v You should have RTK Fix in the GPS Information section.
v The RTK tide value is displayed in green.

Start recording
When the conditions above match, you can just start a new recording and proceed with your survey.

When generating a sounding from your raw data files, you will be able to correct the tide settings if
needed.

Singlebeam Processing

Getting Started

Introduction

In Hydromagic Survey version 6.0 and higher, recorded data is stored as 'raw data files'.

In order to create filtered, corrected and synchronized sounding data, which can be used to calculate
wvolumes,

depth contours, digital terrain models and more, we have to process the previously recorded raw data
files.

The sounding wizard

The sounding wizard is one of the most important tools in the Hydromagic Surwey software
and allows you to convert one or more raw data files into something more useful sounding files.

The wizard leaves the original recorded data intact and creates a second set of data files to track all the
changes you made.

This method allows you to do corrections and filtering over and over again until you are fully satisfied with

the result.
In case the data might become corrupted, just instruct the wizard to start over with the original raw data.

Starting the sounding wizard

After you recorded one or more raw data files, you can combine data from these files into sounding files.
To do so, select the "Generate Soundings..." option from the "Tools" menu.

The wizard will be displayed. You are now ready to create some sounding files.

The first page of the wizard tells us what to expect in the few next steps.
After quickly reading this information, just click "Next" to proceed to the next step.
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Generate sounding(s) from raw data file(s) “

Raw data file(s) conversion tool ‘;‘/

The sounding wizard will guide you through the steps of converting raw data files to soundings.
During this wizard you have to:

- Select the raw data file(s) to convert;

- Provide a tide file or gecid model {optional);

- Provide a sound velocity correction file {optional);

- Draft correction file (optional);

- Correct spikes in depth data using the echogram editor;

After completing these steps, the selected raw files will be converted to sounding files.
Using the sounding files, you can generate matrices, generate contours, export XYZ data or calculate volumes.

Pleaze note that during this process the raw data files will be preserved, and can always be used to generate the
sounding files again in case something goes wrong.

Please dick ™Mext" to start the conversion. ..

Cancel

6.2 Selecting Files
Selecting Files
Next step is selecting the raw data file(s) you want to process. By default all visible files are selected.
The first time you are running the wizard on the files, the "Start editing from original raw data" option is
selected.
This means that you want to start editing the files from scratch.
The second time you run the wizard, and you have made modifications, the "Continue editing modified
raw data" option will be selected
and you can further process your modified files. If you want to start over with the original data, just select

the "Start editing from original raw data" option.

After selecting the files to process, click the "Next" button to proceed to the next step.
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6.3

Select the raw data files used to generate soundings

(") Continue editing modified raw data (®) Start editing from original raw data

|| Raw Data Files
& - RAWDODO1
of - RAWD0002
of - RAW00003
of -, RAWDO0D4
L

-, RAWOD00S
o -, RAWODODG
& - RAWDODDOT
of -, RAWDDOOS
o - RAW00009

| @ SelectAl || @ SelectNone | @ Select Visble

Modified Data
Please note that the original recorded raw data is never altered. All modifications are stored as a copy in
the "Modified" folder of your projects folder on the hard disk.

When you choose to start editing from the original raw data, the modified data of the previous sessions
will be overwritten.

Tide Correction
Tide correction settings
The next step in the conversion process is to define how the sounding is corrected for tides.

If you do not want to use tide corrections, for instance when calculating volumes,
you can skip this step by selecting the "Do not use tide corrections” and clicking the "Next" button.
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Generate sounding(s) from raw data file(s) | x|

Tide correction settings ‘;‘/

(") Do not use tide corrections, do not alter depth values;

(iUse tide gauge or manual measurements as stored in raw data file;

(") Use MSL height from RTK receiver and ignore gecid model;

{"iUse tide correction file (=.tid): =<dlick 'Browse,.. to select a correction file =

Additional (fixed) offset: 0.000 m i Editor... Browse...

Mormaal Amsterdams Peil {M.AP.)

Antenna Offset: 1.230 m

Please select the desired method to calculate height from depths using tide corrections.
ry  Toalter the geoid model or antenna offset, go to the "Preferences” dialog and choose the "RTK” tab.

<Back || Mext:> Cancel

Tide Gauges

If a tide gauge receiver is used, you can select the "Use tide gauge measurements" option.
The software will use the tide observations stored in the raw data file.

Use ellipsoidal height as returned by the RTK receiver

Use this option when a geoid model has been loaded into the RTK receiver.
The software will use this calculated height directly without further corrections.

Use tide correction file

When you want to use tide corrections without special hardware such as a RTK receiver or tide gauge,
you should select this option.

It allows you to create a tide correction file where you can enter the tide observations made during the
suney.

You can start the tide editor by clicking the "Editor..." button. Once completed, sawe the tide file and
select it using the "Browse..." button.

Tide File Editor

The tide file editor can be used to alter previously saved tide files, or to create a new tide file.
To start the tide file editor, just click the "Editor..." button. The following window should appear:
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6.4

File Edit View Tools

Date Tide Observations

BlE*xolEealeo s sa

Use geoid model

When a RTK receiver in fixed mode is used, the height of the antenna is stored into the raw data file as
ellipsoidal height.

By applying a geoid model and an antenna offset, you can calculate the exact tide lewvel for each RTK
position stored in the file.

Draft and Sound Velocity
Draft and sound velocity corrections
If you are not going to use either draft or sound velocity corrections, make sure both check boxes are

unchecked and click "Next".
Keep reading if you want to use one of these corrections.
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Sound velocity and dynamic draft corrections

Use sound velodty correction

Select velodty carrection flle: | C:'\ProgramData'HydroMagicivelodtyexample. vel

Lse dynamic draft correction

Select draft correction file: C:'\ProgramDataHydroMagic\Draft\example. dft

| 4;'\ Editar...

| "J If you want to spedfy a sound velodty or draft correction file, vou can do it here.
\# To create or alter an existing correction file, dick one of the "Editor. .. " buttons.

Sound velocity corrections

An echosounder calculates depth by sending a pulse and measuring the time it takes to get to the

ocean floor and back.
With this time and the speed of sound through the water, the depth is calculated.

For fresh water, the speed of sound is 1500 meters per second, however, for salt water this speed
depends on the salinity, temperature and depth.

Using the sound velocity correction option you can correct your sounding for salt water. Please do not

use this function if this correction is already used in the echosounder.
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File Edit View Tools
Ranges

Depth (m) Velocity (m/s) Velocity vs Depth
1.00 I I I I I

2.00
6.00
10.00
12.00

aootyl |-

Velocity (m/s)

Zdo oo v 2w [Z oK ][ Cancel

Dynamic draft corrections
Dynamic draft corrections can be used to correct the downwards motion of the ship.

For instance, when using a speedboat, you may notice that when the speed increases, the rear of the
ship lowers while the front raises.

This is what we call dynamic draft, and depends on the speed. You can correct for this motions by
creating dynamic draft correction table (speed versus draft).
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File Edit View
Ranges

Speed (kmh)

Draft Corrections

0.00
1.00
3.00
5.00

=3 R x B
i = =]
=] a =]

Speed (kmh)

e a =
w o wn
a a (=1

S Holeeo s s &

6.5 Correcting Data

Correcting data

¥ 0K | X Cancel |

The last step we have to perform before data gets conwerted to a sounding, is to correct the data.
We hawe to filter out spikes, out of range data and invalid position data.

Hydromagic offers multiple tools to correct your data:

v Echogram Editor

v Position Data Editor
v Table Editor

v’ Data Filter

© 2015 Eye4Software B.V.



135

Eye4Software Hydromagic 7.0

6.5.1

Generate sounding(s) from raw data file(s) | x|

Correct your raw data file(s) using editing or filtering ‘;‘/

Edit echogram(s)

Before generating the soundings, please use the "Echogram Editor™ to remove spikes
and invalid values from the depth data.

Edit position data

Using this map display, vou can select and remove incorrect GPS or RTE positions from " Edi
your position data by just selecting the points using the mouse. o

Edit table(s)

Use this tool to edit the data using a table or spreadsheet view > Edt
Lse this tool to alter data which cannot be modified in the echoagram or map display above.

Other tools

Click the "Toals..."” button to show a collection of other data processing tools, like filkering

: =l : A ! : ! " Tools...
time shifting, latency correction, unit conversion, coordinate conversion and mare, e

<Back || Mext:> Cancel

Filter Data
Filter Data

The filter tool can be used to filter out unwanted data. You can use it to delete zero (invalid) soundings,
position data measured with a low DOP, invalid motion sensor data and more.

To start filtering your data, click the "Filter" button from the "Data processing tools collection" screen,
which can be opened by clicking the "Tools..." button on page 5 of the sounding wizard.
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Position Data

Filter position data

Minimum fix status:

Minimurn satellite count:

Maximum HDOF value:

Maximum YDOP value:

Maximum PDOP value:

Depth Data

Filter depth data

Minimum Depth (Hi):

Maximum Depth (Hi):

Minimum Depth (Lao):

Maximum Depth (La):

Motion Data

Minimum heave value:

Maximum heave value:

Maximum pitch value (absolute):

Maximum roll value (absolute):

Configuring filter options

Position data

This option can be used to filter out unreliable position data, for instance when the GPS fix wasn't RTK
fixed, or the DOP value was to high.
Check the "Filter position data" checkbox, and fill out the fields.

Depth data
It is recommended to use this option before the echogram editor, because you can use this to filter out

spikes and zero values.
Just check the "Filter depth data" checkbox and enter the minimum and maximum expected depth for
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6.5.2

the low and high frequency soundings.
Motion data

You only need this feature when using a motion sensor for pitch, roll and heave.

Check the "Filter motion data" checkbox and enter the maximum angles for pitch and roll, and the
expected range for the heave corrections received from either the echosounder or motion sensor.
Skip this option when no motion sensor was used during the suney.

Start Filtering

When all options have been configured, just click the "Apply" button to start the filtering process.
When one of the filters has been applied, a new modified raw data file is written in the "Modified" folder in
your project root.

Echogram Editor

Echogram editor

The echogram editor is used to quickly remove spikes and wid data from a sounding.
To start the echogram editor,just click the "Start..." button in the "Edit echogram(s)" section.

Ethngrdmgcﬁlu( .
B ¥-= W NS PR D Depth (): | Hi& Deptts (Hje | 2.05 |
i RAWD0D10
0w
060
[} =)
L
130 3
|l ..1 i |
bl T LL I o i #HH". B T R
i LTR d \ '.JI " . I,l"--i li‘\l | * I' v
ik | pIJ‘ '{ o whf \“’, " _J?i'j,-’hf £ it il :,"J”ﬁ”.-’\,;l:,;% 'litl" re Y
v 7 i s’ : [ [Hif i AT A TR
s h‘l'_l '.\I| LI \“_,f\{ \ dﬂ -|‘1|J Ll y | | ,\_JI LW'
a.m
0

The Bchogran Editer” can be: used by nenmorve onesanted soundings, Such s nol valoes and spdoes from yoor ssunding, ket select the data yiou wish o nemorae wide pressing the right mo.se bution,
¥ and dick the lefimas? button in the iochar abewe. Torenove out-of range data and nul values, you conuse the finer aplion from the scunding generation wirard as wel.

Lok Fréquency [ Hgh Freguency ) Dual Frguency o 0K

Using the echogram editor

Using the echogram editor is very simple. Just select the data you want to remove and click the remove
button (C).

It is also possible to edit or delete single values using the mouse. You can edit either the low or high
frequency depths with this tool.

When done editing the echogram, click the "OK" button to save your changes. To discard, click "Cancel"
When an echogram has been altered, a new modified raw data file is written in the "Modified" folder in
your project root.

Multiple Frequencies
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The echogram editor allows you to modify both low and high frequency depth measurements.
When dual frequency is selected, you can select both low and high frequency spikes or data for deletion.

When you have problems deleting either low or high frequency data when values are very close to
another,
just switch to single frequency mode using either the "Low Frequency" or "High Frequency" option.

Echogram editor toolbar

B 7% e e 0 m
a b c d e f g hi j k | A o

m
(@) - Remove Selection
To remowve spikes and zero value, you can select the data by clicking and holding the right mouse

button.
When the invalid data has been selected, click this button to remowe it from the data file.

(b) - Filter Echogram

Use one of the built in data smoothing and filtering to remowve spikes and noise from the data.
Supported filter algorithms include median and mean filtering.

(c) - Reload Echogram

Reload the echogram from disk.

(d) - Undo operation

Use this button when you remowved data by accident. This button undo's the last operation.
(e) - Redo operation

Redo an operation which has been undone.

(f) - Scroll to begin

Scroll to the beginning of the echogram, only available when zoomed.
(9) - Scroll back

Scroll back one screen, only available when zoomed.

(h) - Scroll forward

Scroll forward one screen, only available when zoomed.

(@) - Scroll to end

Scroll to the end of the echogram, only available when zoomed.

() - Select the previous data file
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6.5.3

Select to the previous raw data file in the collection of files you are currently editing.

(k) - Select the next data file

Select to the next raw data file in the collection of files you are currently editing.
(1) - Zoom In

Zoom in on the data which is currently visible.

(m) - Zoom Out

Zoom out on the data which is currently visible.

(n) - Zoom All

Reset all zoom operations, shows all data in the file.

(0) - Print Echogram

Send the current echogram view to a printer or plotter.

Position Editor

Position Editor

The position editor allows you to quickly remowve any invalid position measurements from a raw data file.
You can also use this tool to quickly remowve data that is outside the project's boundaries and is no

longer needed.

To start the position editor, just click the "Start..." button in the "Edit position data" section.
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||x: 173495.302 ”v:5592-ae.345

To remove urwanted position data, make a selection while holding the right mouse button and select the lefimost button
in the toolbar to delete, Use the second button to remove position data in- or outside a selected boundary.

|« oK || % Cancel |

Using the position editor

Using the position editor is very easy. Just select the positions you want to remowe with the mouse with

the right button pressed.
When the selection is okay, click the remove selection button to remowve the positions from the raw data

file.

When done editing the positions or GPS fixes, click the "OK" button to save your changes. To discard,

click "Cancel"
When positions has been removed, a new modified raw data file is written in the "Modified" folder in your

project root.

Position editor toolbar
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B S 90 K3 4 LLPL M RAWDO00S X: 178256,193 ¥: 550303,863

a b C d =] f =4 h i i k 1 m mn
(@) - Remove Selection
To remowe invalid or out of bound GPS positions, you can select the data by clicking and holding the

right mouse button.
When the invalid data has been selected, click this button to remowe it from the data file.

(b) - Reload positions

Reload the GPS positions from disk.

(c) - Undo operation

Use this button when you remowved data by accident. This button undo's the last operation.
(d) - Redo operation

Redo an operation which has been undone.

(e) - Select the previous data file

Select to the previous raw data file in the collection of files you are currently editing.
(f) - Select the next data file

Select to the next raw data file in the collection of files you are currently editing.

(9) - Toggle panning

When the panning mode has been selected, you can drag the map around with your mouse cursor while
holding the left mouse button.

(h) - Zoom In

Zoom in on the data which is currently visible.

(i) - Zoom Out

Zoom out on the data which is currently visible

() - Zoom All

Reset all zoom operations, shows all data in the file
(k) - Print Echogram

Send the current echogram view to a printer or plotter

(I) - File Indicator
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Show the name of the file you are currently editing. To change the fole, click the 'e' or 'f button.
(m) - Position Display

Displays the X or easting position of the mouse cursor.

(n) - Position Display

Displays the Y or northing position of the mouse cursor.

6.5.4 Table Editor
Table Editor

The table editor allows you to modify any value, except for timestamps in a raw data file directly.
It is recommended to use this editor only in cases one of the other editor can't be used.
You can also use this editor to analyze and export raw data.

“ EE e e|vr | d RAWDO0003

Time Easting Morthing Ellipsoid
4:14:34.887 PM | 178384.697 559111104 42,272
4:14:35.800 PM | 178385.555 559112694 42,277
4:14:36.888 PM | 178386.248 559114.353 42310
4:14:37.887 PM | 178386.607 | 559116.099 42,313
4:14:38.886 PM | 178386.776 1559117.920 42,330
4:14:30.887 PM | 178386.889 5501197838 42,325
4:14:40.887 PM | 178387124 3321677 42,325
4:14:41.887 PM | 178387.567 | 559123.510 42,318
4:14:42.8860 PM | 178388.293 1559125.186 42,318
4:14:43.880 PM | 178389.216 530126.724 42,323
4:14:44.887 PM | 178390.214 53928.212 42,300
4:14:45.886 PM | 178391.255 | 559129.700 42,299
414:46.886 PM | 178382.239 1559131.239 42,318
4:14:47.887 PM | 178383149 559132815 42,314
414:48.886 PM | 178384.014 539134442 42,314
4:14:45.887 PM | 178354.867 | 559136.100 42,337

Using the table editor

Data in the table editor is sorted per sensor type:
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v Depth

v’ Position

v Heading

v Speed

v GPS information

v Tide

v Motion

v DOP

v Sub Bottom information

You can use buttons (c) and (d) to switch between the different tables.

To alter values in the table editor, just double click a cell in the grid and type the new value.
Press enter, or click another cell with the mouse when done.

In addition to modifying values, it is also possible to delete one or more data rows using the toolbar.
When done editing raw data, click the "OK" button to save your changes. To discard, click "Cancel"

When data has been altered, a new modified raw data file is written in the "Modified" folder in your project
root.

Table editor toolbar

TP EE e 9N | = 4 POSITION RAWOD003

.1 ]

E] b c d e f h i i k |

T
=3

(@) - Select the previous data file

Select to the previous raw data file in the collection of files you are currently editing.

(b) - Select the next data file

Select to the next raw data file in the collection of files you are currently editing.

(c) - Select the previous data table

Select to the previous table in the raw data file. This allows you to switch between data types.
(d) - Select the next data table

Select to the next table in the raw data file. This allows you to switch between data types.

(e) - Remove Selection

To remowve one or multiple data rows, select the rows and click this button to remove them.
This action can be undone by using the undo operation button.

(f) - Empty Table

Remowes all values from a single table. For instance if you want to remove tide or motion information from
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the
raw data file completely. This action can be undone by using the undo operation button.

(9) - Undo operation

Use this button when you removed data by accident. This button undo's the last operation.
(h) - Redo operation

Redo an operation which has been undone.

(i) - Reload

Reloads the table with data from disk.

() - Export

With this function, you can sawe the contents of the current data table directly to a human readable
ASCII file.

(k) - Table
Displays the name of the currently selected data table.
() - File

Displays the name of the file that is currently being edited.

6.6 Generate Soundings
Generate Soundings

When you have corrected your data, configured tides and selected correction files for draft and / or sound
welocity, the software has gathered all the information to combine everything into a sounding file.

In a sounding file, depth, tide, motion and position information are synchronized, and written in fixed
intenvals.

You can choose to write soundings at an interval defined in seconds, use the position fix interval, or you
could use the times at which a depth measurement has been received.
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Generate sounding(s) from raw data file(s) “

Set sounding output options ‘;‘/

Mame Prefix: SMNDG

Record Interval: (@) Calculate a sounding every: 0.25 seconds (0,25 - 10,0)
i) Calculate a sounding for every received position fix;

() Calculate & position fix for every depth measurement;

Do not warn when about to overwrite existing files

Hide raw data files from map after conversion has completed

= Back Cancel

Generate sounding options
Name Prefix

When a raw file is conwerted to a sounding, it will keep the assigned number. Using the name prefix you
can add a prefix to the file name.

For instance, when the name prefix is set to 'SNDG', a raw file named 'RAW0006' will be names
'SNDGO0006' after conversion.

Record interval

The interval at which soundings are calculated. You can use a timed internval or use the same interval at
which the GPS or echosounder sends its data.

The interval depends on the resolution needed and the size of the area. When a raw data file covers a
very large area (>100.000 soundings) it is better to use a lower interval, for instance one second.

Using a very small interval on large data files may slow down other post processing utilities.

Overwrite existing files

Using the wizard it is possible to generate a sounding file over and over again until you are satisfied with
all settings and corrections.

Checking this box will omit a warning message when you are about to overwrite a previously generated

sounding file.

Generate sounding
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When ready, click Finish. After a few seconds, depending on the amount of data, the wizard closes and
the generated soundings will be visible in the project explorer.
From now on, the sounding is also available as a human readable ASCII file in the "Soundings" folder of

your project.

In this example, with the interval of the records set to 0.25 seconds, your sounding should look like this

when opened in the sounding editor:

Edit Sounding “

Sounding Properties

Name: | SNDGD0D10

File: . C:‘n,leers‘.n,Lenn‘nﬂnv:uments‘l,Hydrumagic‘lFriesLandEuundings\,ﬁNDGUUDlﬂ

Comment: GEMERATED FROM RAWOO0010

Time Longitude Latitude ElewHi  Elevlo Tide EHT i
4:25:43.000 PM E 005.75234737 M 53.01969913 1.646 M A 42.243
4:25:43,250 PM E 005.75235331 N 53.01970373 1.672 MA A 42.246
4:25:43.500 PM E 005.75235875 M 53.01970833 1.690 MA MSA 42,245
4:25:43.750 PM E 005.75236413 N 53.01971293 1.690 M A M A 42,252
4:25:44,000 PM E 005.75236963 N 53.01971755 1.696 M A MR 42,253
4:25:44,250 PM E 005.75237506 M 53.01972219 1.716 MA M 42,252
4:25:44,500 PM E 005.75233050 M 53.01972682 1.726 MSA A 42,252
4:25:44,750 PM E 005.75238593 N 53.01973146 1.711 MA MfA 42,251
4:25:45,000 PM E 005.75239142 M 53.01973607 1.699 A A 42.249
4:25:45,250 PM E 005.75239694 M 53.01974064 1.694 MA A 42.245
4:25:45,500 PM E 005.75240248 N 53.01974522 1.690 A MA 42,241
4:25:45.750 PM E 005, 75240800 N 53.01974979 1.690 A A 42,237
4:25:46.000 PM E 005.75241373 M 53.01975422 1.687 M A M 42.234
4:25:45,250 PM E 005.75241964 M 53.01975343 1.677 MA M 42,233 i
O E S T K O = iy |

To get more information on a single sounding record (we also call this a single ping in Hydromagic), just

double click the row you want details on:
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6.7

Sounding Record
Sounding:
Date:

Time:

Sounding Coordinates

Longitude:
Latitude:

[ ] Show position in Easting / Morthing coordinates

Depth Information

Depth (Lo):
Depth (Hi):

Corrections

Tide Correction:
Draft:

Heave:

Pitch:

Rall:

SN (Lo):

SV (Hi):

Additional Information

Speed:
Heading:

Ellipsoidal Height:

Mean Sea Level:

E 005.75238593"

N 53.01973145"

N/A |

1711 |

Importing Soundings

Introduction

The ASCII import function allows you to import soundings written in ASCII format. For instance, to import
a sounding exported from another Hydromagic project, or created with other software.
Please note that because this imported data is not time tagged, you can not correct this data for tides
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and latency using the "Generate Soundings Wizard" !

Importing sounding data

The ASCII import function allows you to import soundings written in ASCII format. For instance, to import
a sounding exported from another Hydromagic project, or created with other software.
Open the "Import ASCII Data" dialog

The dialog can be opened by selecting "File"=>"Import"=>"Import ASCII Data..." from the main menu.
The following dialog will appear:

Import ASCH Sounding n
Data File
File: <dick 'Browse..." to select an ASCII file= || Browse...
Load data as: Sounding v BB View..
Format
Field Separator: Auto W

Mumber of lines to skip from start of file (field header): | 0

4

]

Mumber of fields to skip from start of file: 0 =
Coordinate field order: Easting, Morthing W

Coordinate field format: Decimal (¥

Projection and Units

If the coordinates used in the file are not in WG584 Latitude-Longitude E] ot
Projection, select the projection used by dicking on the 'Select’ button.

Currently selected:  Amersfoort [ RD Mew

The depth data in the file {if available) is stored in: Meters ¥

You can use this tool to import data from generic ASCII files rather then formats supported
rg  directly by Hydromaaic, When importing, please make sure you select the projection used in the file.

Select input file

Click the "Browse..." button to select the file to be imported. All files will be displayed, there is no file
extension filter applied. Some file extensions that are commonly used for ASCII files include: *.ASC,
* TXT, *.LOG and *.CSV. The imported file is never modified by this software. This dialog can also be
used to import boundaries, grids and waypoints. Make sure the "Load data as" options is set to
"Sounding".
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6.8

Field Separator

This value is set to "Auto" by default, which means that the software will try to detect which character is
used to separate the fields in the ASCII file.
In most cases you do not have to adjust this value.

Skipping lines and fields

In cases where the data does not start on the first line of the file (for instance, when header names are
present), you can skip these lines by increasing the "Number of lines to skip value".

The "Number of fields to skip option" can be used in cases where there are fields before the actual XYZ
data, for instance, record Id's.

You can use the "View" button to check if these options apply to your input file.

Coordinate field order

This option is to set the order of the fields in the file. The following is supported:

Latitude, Longitude;
Longitude, Latitude;
Northing, Easting;
Easting, Northing;

YV VVYVY

When a third field is present in the file, it will be interpreted as depth.
Most software stores soundings in XYZ format, so selecting "Easting, Northing" here would probably
work in most cases.

Coordinate field format

When the input files contains values in geographic format (i.e. latitude and longitude), and the
coordinates are stored in degrees, minutes and seconds format, or degrees and minutes format, set this
option to the correct value.

When coordinates are stored in decimal values, leave the "Decimal” option selected.

Projection and Units

The software needs to now which projection is used in the file (only when Northing and Easting
coordinates are used instead of Latitude and Longitude), so it can be referenced to WGS84 coordinates.
When an altitude or depth is present in the file, you also hawe to set the unit used (meters or feet).

Importing the file

Just click "OK" to start reading the file. When all parameters were entered correctly, the imported
sounding will appear in the "Project Explorer".

Importing Soundings from NMEAO0183 log
NMEAO0183 logfiles

This feature allows users to create a raw data file directly from a recorded NMEAO0183 lodfile.
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This can be used to retrieve data from, for instance a remote controlled survey vessel such as the

OceanScience Z-Boat 1800.

This option can only be used when depth and position data is in the same file.

The new importing tool allows you to set the date and in which timezone the sounding was recorded.
This way, together with the time information in the NMEA0183 data, the sounding can be time tagged, so

it can be corrected with a tide file if needed.

NMEAO0183 Import Tool

To start the NMEAO0183 importing tool, select "Import NMEAQ0183..." from the "File” => "Import" menu as

shown below.

2

u Impart Map...
' Download Map...

Mew Project...
Open Project...

LR E

Save All

Impaort
Export

"li" 563 EMC Permits...

Print...
,E, Print Preview

Ctri+M
Ctri+ 0
Ctri+5

Ctri+P

':FiIeIEdit View Tools Options Survey Mavigation Cursor  Help

CIEIERNCIcRRCY,

Import Map...

Import Matrix...

Import ASCIH Data...
Import NMEADT23 Data...

Import Project (5.4...

|

In order to import data, you have to specify a local map projection first. In case you haven't done so, the
application will prompt you to do this now.
After a map projection has been selected, the following dialog should appear:
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Input folder

Input Folder: |C:‘|,Ternp‘u.ogl=i]es | ||;:L Browse... |

Depth

NMEAD 183 Sentence: |$SDDET v| Sounder Offset: | 0.30 m

NMEAD 183 Checksum: | Enabled v

Sounding Date

Date: 3/16/2015 El- |

Timezone: | (UTC+01:00) Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna

FileMame Date modified

Session30. et 8/1/2014 9:53:22 AM

Session3L.txt 8/1f2014 9:52:55 AM

Session 32 txt 852014 7:03:22 PM

Session33.txt 8/6f2014 7:03:18 PM

Session 34 et 8/6f2014 7:03:16 PM

Session35. et 8/6/2014 7:03:14 PM

Session3o. txt 862014 7:08:12 PM

Session37.txt 8/6f2014 7:03:10 PM 25 KB
Session33. et 8/a/2014 7:03:08 PM 503 KB
Session39. et 8/6f2014 7:03:04 PM 3KB w

@ SelctMl || @ SelectNone |2 Refresh | i Convet] X Close |

NMEAO0183 Import Settings

Filename

Select the filename(s) of the file(s) you want to import. Click the "Browse..." button to select the folder
the files are stored in.

Each file will be converted to a separate raw data file when converted.

NMEAO0183 Sentence

Use this settings to select the NMEA0183 sentence used to extract depth from the lodfile.
Possible settings are: $SDDBK, $SDDBS, $SDDBT and $SDDPT.

NMEA0183 Checksum

Use this setting to select whether checksum is used or not.
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It is recommended to set this value to "Enabled", because it will filter out corrupted data sentences.
Sounder Offset

Use this box to set the transducer offset to be used. This is the distance between the bottom of the
transducer to the waterline.

This settings is also called the static draft. It is possible to leave this value zero and correct it later in the
"Sounding Wizard".

Sounding Date

To add correct date and time information to your sounding, you can use the "Date" and "Timezone"
settings.

The time of the positions is stored in the NMEA0183 data as GMT time, so the correct timezone is
required to convert the times to local time.

Starting Import

When ewverything is setup, just click the "OK" button to start the import. You will see a progress indicator
at the bottom of the screen.
When the sounding has been imported successfully, it will be displayed on the screen.

6.9 Exporting soundings
Introduction

Using the ASCII export function, it is possible to export soundings in ASCII format for use in other
applications.

It is also useful to backup separate sounding files from a project, for instance to import them into another
project or just for archiving.

The ASCII import function allows you to import soundings written in ASCII format.
For instance, to import a sounding exported from another Hydromagic project, or created with other
software.

Exporting sounding data

The ASCII export function allows you to export your soundings in ASCII format.
You can use this feature to create backups of your work, or when you want to use the data in other
applications.

To start, open the "Export ASCII" dialog by selecting "File" => "Export" => "Export ASCII Data..." from
the main menu.
The following dialog will appear:
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Export ASCII Sounding / Vector data Bl

Data File

Qutput file: . C:\Templexport.cav - || Browse...

Data To Save: . SNDGOOO 10 hd
Format

Exported Fields; | Easting,Morthing,Depth IE, Select...

Field Separator: | Comma W Indude header containing field names
Projection and Units

In casze you want to perform a coordinate conversion on the exported data 5-' Celeirk

rather then keeping the original prajection, dick the 'Select’ button.
Currently selected:  Amersfoort [ RD Mew

The depth or elevation data {if available) will be stored in: Meters W

|Jse this tool to export your sounding, matrix, shoreline or boundary data as an ASCII file,
ty Inaddition, this tool allows you to perform coordinate or unit conversion on the saved data.

Select output file

Click the "Browse..." button to select the destination folder and filename for the data to export.
First select the folder you wish to store the file into, and secondly, type the name of the file.
Recommended extensions for ASCI! files include: *.ASC, *.TXT, *.LOG and *.CSV.

Select data to save

Using the "Data To Sawe: selection box, you can select which data you want to export to an ASCII file.
It is possible to export soundings, matrices, lines and boundaries.

In this example we want to export a sounding, so we select the desired sounding from this box.

Select format options and field order

The output format is fully customizable, the following fields can be selected for export:

Longitude;
Latitude;

Easting;

Northing;

Depth;

Ellipsoidal height;

VVVYVVYYVY
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Date;

Tide;

Time;

Draft;

Heading;

Speed,;

Sound welocity correction.

VVVVVYYVY

To customize the exported fields, and the field order, click the "Select..." button.
The following dialog will be shown allowing you to select the fields.

Click "OK" to confirm and return to the "Export ASCII" dialog.

Solect Ficlds to Bxport E3
Available Fields; Exported Fields:
Longitude = Easting
Latitude : Morthing
Depth Hi = Depth
Depth Hi (Corrected) Date (short)
Depth Lo Time
Depth Lo (Corrected) 5
Depth (Corrected) s
Ellipsoidal Height
Date {long)
Tide
Draft
Heading
Speed
S/ Correction
Sensor Value #1
Sensor Value #2
Sensor Value #3 W7
IIse this window to select the fields you want to indude in your exported ASCII data.
g Use ">"to add the selected item or "< to remove the selected item.
& OK # Cancel

Select map projection and units

It is possible to store the file using another local grid then the one you are currently using in your
project.

To change the output grid, click the "Select..." button and select the desired map grid or map datum.
In this section you can also specify in which units the depth should be written to the ASCI! file.

Starting the export

Just click "OK" to start writing the file. When all parameters were entered correctly,
the exported file should appear in the folder you selected.
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7.1

Post Processing

Generate and Display Matrix
Introduction

In Hydromagic, a matrix is a collection of regularly spaced depths, which can be projected over the map
as color or text.
This is also known as a digital terrain model or DTM.

During the generation of a matrix from a sounding, the scattered data points are converted to regularly
spaced

data using a TIN (Triangulated Irregularly Network). This TIN is generated using a Delaunay triangulation
algorithm.

All new data points are generated by "filling" the triangles, which have been formed from the scattered
data.

The image below shows a color matrix which has been generated using TIN (data points at 0.25 meter
interval).

Generating a matrix

To generate a matrix, you must have loaded either a valid sounding or a shoreline containing depth or
height information.
Without sounding or shoreline data, it is not possible to generate a matrix.

In order to generate the matrix, you have to specify some settings.
To do so, open the "Generate Matrix" dialog by selecting "Generate Matrix..." from the "Tools" menu:
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Select Source Data
Sounding Data:
Shareline Data:

Sounding Channel:

Output File
Matrix Spacing:
Clipping Area:

Qutput Filename:

Generate matrix from soundings and shorelines

SMNDGO0001; L5, Select..
SHORELIMEDOO1; 53, Select..
Depth (Hi Frequency) W

0,25 m

g BOUNDARYOOO1 W

scuments \Hydromagic\DominicanRep2\Matrices\FracPitl. xyz | Browse..

|se this tool to generate a matrix or OTM of a selection of soundings and f or shorelines.
1y Use the "Select...” buttons to select a set of soundings and shorelines from the project.

Sounding data

Select from which sounding(s) you wish to generate the matrix. By clicking the "Select..." button, you
will be able to select one or more
soundings that will be used to calculate the triangulation from which the matrix or digital terrain model

will be generated.

Shoreline data

Select which shorelines you wish to include in the matrix calculation.
Shorelines can be used to append extra data near the shoreline, or to clip the matrix data along the

shore.

For more info on how shorelines can be used, please refer to the chapter "Entering Shoreline Data™.

Sounding channel

m

You can use this setting to select which data of the sounding is used to generate the matrix.
This can be one of the following values:

Depth recorded with the low frequency channel of your echosounder;

Depth recorded with the high frequency channel of your echosounder;

The difference in depth between the high and low frequency channel (Low - High);
The difference in depth between the high and low frequency channel (High - Low);
Sensor data channel 1;

Sensor data channel 2;

Sensor data channel 3;

The sensor data channels can be used to store either magnetometer data, information on

reflectivity,
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bottom loss or duration of the returned echo(s).
The data that each channel contains can differ, and depends on the echosounder plugin that was used to
record the data.

Matrix spacing

You can select the spacing of the regularly spaced data here. The same spacing is applied to both the X
and Y axis.
The spacing has to be entered in the same units as used for the map projection.

Which spacing to use depends on the zoom scale you are using. For an oveniew of a large area, you
can use 2.5 meter.
When zooming in on a smaller area, the best is to use values between 0.25 and 1.00 meter.

Please note that when using a larger spacing, it will be generated and displayed faster then a more
dense matrix.

Clipping area

Use this to select which clipping area (boundary) has to be applied when generating the matrix. Only
data points within this area will be calculated.

This can be used in cases when only a part of the sounding areas has to be interpolated. When no
boundary is selected, the matrix is only clipped by the extends of the data points.

In addition to boundaries, you can also use shorelines to clip data along the shore, or to generate islands
(or holes).

Output file name

Enter the name of the file that is generated here. This setting is required.

You can enter a simple name (for instance the same name as the sounding used) here, which will be
stored in the default matrix folder.

When you want to store the result elsewhere, use the browse button to select the output folder and file
name.

The data will be added to the current project and stored in a separate ASCII XYZ file at the desired
location.

Generating the matrix

Finally, click the "OK" button to start the process. It should take a couple of second, you can watch the
progress in the status bar of the main window.

After generation, you will notice the matrix has been added to the project. Depending on the
configuration, the newly generated matrix will be drawn over the map.

Displaying the matrix

There are more ways of showing the matrix on the map. In the example near the top of this page, it is
displayed at both colors and text at a 5x5 meter interval.

It is also possible to not show it (and just use the matrix to export data), to show it with colors only

(using the defined color ranges) or to show its depths as text.

To change settings on how the matrix is shown, right click the "Matrices" folder in the "Project Explorer"
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and select the "Display Options" option from the popup menu.
A dialog with all matrix settings will be displayed. It should look like the screenshot below:

Matrix Display Options ﬂ
Matrix Display Options
V| Display Matrices|
[ oisplay matrix as colors {raster):
[w] Display matrix as depths (text):
Interval-X: | 10,00 Meters
Irterval-y: | 10.00 Meters
[v] Display text in color

[ |Hide zero values

|J Colom,., & OK ¥ Cancd

Display Matrices

Using this checkbox you can toggle the displaying of matrix files on the map.
When matrix display is disabled, all other options will be disabled.

Display matrix as colors

When enabling this option, the matrix is displayed as a color grid on top of the map.
The "Colors..." button will also be enabled, so you can start creating the color ranges for your sounding.

Display matrix as depths

Instead of drawing the matrix as a color grid, you can also choose to draw depth values at fixed intervals.
Depending on the size of the matrix, you have to adjust the text internvals in a way that the text's on the
map do not intersect.

The text spacing can be set in horizontal and vertical direction separately.

Display text as colors

When this option has been checked, text is drawn in color, indicating the depth range.
You cannot combine this option with the "Display matrix as colors" option.

Color Ranges
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'@ Add. || @ Deete. ||& Edt. |
|E Save... ||% Load... || Auta... |

Depth Color Legend

| Display in upperdeft corner

In this dialog, you will be able to add, remove or modify color ranges by clicking one of the buttons at the
bottom of the list. To change a range, just double click on it, and change the settings. In case you want
to store the color scheme you designed for other projects, you can store it in a separate XML file using
the "Sawe..." button. Just use the "Load..." button in the other project to retrieve this scheme.

Display color legend

The second section contains the settings for the color legend which is displayed as map overlay when
colors are displayed. You can turn it on or off here.

Generate color ranges
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7.2

Generate Color Ranges H

Generate Color Range

Colors Used: All colors W
Minimum Depth: 0.00
Maximum Depth: | 5.00
Interval: 0.25

[ |Reverse Colors

2 Cancel

It is also possible to create a color scheme using a min, max and step value.

To do so, select the "Auto..." button, and select the lower and upper range, next specify the interval
between the ranges.

This tool will generate max 30 ranges, so it is important to choose the correct interval.

Generate Matrix from Sections

Generating a reference matrix from sections

A reference matrix that can be used to perform wolume calculations can be created from:

v"a recorded sounding;

v collection of sections, also known as channel design;

v"a vector chart which contains 3D vectors.

Channel Design

When comparing the matrix created from a sounding with a matrix created from a channel design, we

can calculated the amount of material which has to be (re)moved in order to get the result as in the
channel design.
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Generate the matrix

To start creating a matrix from the channel design, right click on the "Sections" folder in the "Project
Explorer* and select the "Generate Matrix..." options as shown below:

Em | Boundaries ‘ |
- ] |
- ] Shoreli \@ Generate Sections...
[:ﬂ Generate Sections from DXF...
B Generate Matric.. -
B Remove All Sections... I
Manage Sections... I

After selecting this option the "Generate Matrix from Sections" will be displayed, as shown in the image
below:
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- =R
Generate Matrix from Sections u

Sections
Indude the following sections:

m

1

| SelectAl || @ SelectNone || @ Select Visible

Output File
Spacdng 10 Meters (valid range: 0.1 ... 10.0)
Clipping Area: || DELDEN_KADE -

Filename: -DICIi.'I'M.xyz "\ Browse..
Please select the coordinate system used in the file,

Select by dicking the "Select” button,

Currently selected:  Amersfoort / RD New

[« ok |[X Cancel |

e

Sections

Select which sections you want to include in the matrix calculation. In most cases you select all
sections, which can be done by clicking the "Select All" button.

To deselect all sections, click the "Select None" button. To select only section that are set as \isible in
the project, click "Select Visible".

Spacing

Set the required spacing. Please note that when using the wlume calculation using matrices, this
spacing should be equal to the one used in the matrix generated from the sounding.

Clipping Area

Select which area or boundary will be used to indicate the clipping area of the matrix generated from the
sections. This value is required.

Filename
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7.3

Click the "Browse..." button to select a folder and file name for the generated matrix. The matrix is saved
as an ASCI! file containing all the XYZ pairs calculated by this tool using TIN.

Projection
To sawe the XYZ data in a different projection then the current one, click the "Select..." button to change

the projection.
Coordinates will be converted during saving to the output file.

Starting generation

When all parameters has been set, the matrix will be calculated and added to the project.
During the generation process, a progress bar will be shown in the status bar.

When finished and loaded, you will see something similar to the image below:

Generate Matrix from CAD

Generating a reference matrix from CAD or vector maps

A reference matrix that can be used to perform volume calculations can be created from:

v a recorded sounding;
v collection of sections, also known as channel design;
v"a vector chart which contains 3D vectors.

CAD drawing

This is perhaps the easiest way to create a reference matrix (DTM), provided that an AutoCAD or
MicroStation CAD drawing of the area is available (and of course, contains elevation information).

From the vectors collected from the CAD file, a TIN model is generated and heights are calculated on the
generated triangles.
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When comparing the matrix created from a sounding with a matrix created from a CAD drawing, we can

calculated the amount of material which has to be (re)mowed in order to get the result as defined in the
CAD drawing.

A sample CAD design of how to construct a basin is displayed below:

Generate the matrix

To start the conversion, right click on the loaded DXF or DGN CAD file, and select the "Export to
Matrix..." option.:
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File View Tools Options Mavigation Cursor He

NS . R R S HE

Project Explorer o X
= E_i:'ro =
-G [ Maps
F-E | Matrice "D Ll KR
D — S “ Map Properties...
- || Waypoi
@ || Commd @@ Set Active
(@ | | Photos _
@D [ Bounds EH Export to matrix...
i Sedlion & Remove Map..
- || Shorelife =
2 M
Generate matrix from vector map M
Vector Data
Vector Map: |ig VERGWESTZ.duf -
Layer Filter: MEBB_VERG Select...
MOTE: To specify which wector layers should be induded,
enter the layer names above, separated by semicolons,
Output File
Spacdng: 1.0 (horizontal units)
Clipping Area: L <No Clipping= -
File: Ci\tempiwergwest, xyz
[/ OK [ X Cancel |
h

Vector Map

Use this control to select the vector map to generate the matrix from. Please note that only vector maps
are displayed here, raster maps do not contain elevation information.

By default the "Active Layer" is selected in this control.

Layer Filter

Enter the names of the layers that should be included in the calculation. To enter multiple names, just
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separate them using semicolons.
This field is required, when left blank, there will be no generation of matrix data.

Spacing

Set the required spacing. Please note that when using the volume calculation using matrices, this
spacing should be equal to the one used in the matrix generated from the sounding.

Clipping Area

Select which area or boundary will be used to indicate the clipping area of the matrix generated from the
sections.

When you want to disable clicking, select the default option "<No Clipping>".

File

Click the "Browse..." button to select a folder and file name for the generated matrix. The matrix is saved
as an ASCI! file containing all the XYZ pairs calculated by this tool using TIN.

Starting generation

When all parameters has been set, the matrix will be calculated and added to the project.
During the generation process, a progress bar will be shown in the status bar.

When finished and loaded, you will see something similar to the image below:
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7.4

Generating Contours

Introduction

Contour lines are lines connecting points with the same depth, height or other data.

During the generation of contour lines from a sounding, the scattered data points are converted to
regularly spaced

data using a TIN (Triangulated Irregularly Network). This TIN is generated using a Delaunay triangulation
algorithm.

After this step, Hydromagic calculates the contour lines by determining the positions where the depth
contour crosses the calculated triangles.

All these lines are connected to each other, and stored as a vector layer, which can be exported as
AutoCAD DXF file.

{2675

.....0e00c ]

ii42850

ladEzs

(42500

L I
25m ‘

Creating Contours

To generate contours, you must have loaded either a valid sounding, or a shoreline containing depth or
height information.
Without sounding or shoreline data, it is not possible to generate depth contours.

Soundings without valid depth or elevation data will be ignored. If you want to clip the generation of
contours to a specific area, you should have created or loaded a boundary as well.

Open the "Generate Contours" tool, by selecting it from the "Tools" menu. The following dialog will
appear:
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Geneinte depth contours om saundings and shorclines | x |
Source Data
Sounding Data: SMDGO0010; I Select .
Shaoreline Data: SHORELIMEOQQO1; . Select...
Sounding Channel: Depth (Hi Frequency) W
Clipping Area: [ 4 BOUNDARYODO1 v
Output Options
Filename: C:\JsersLeon\Documents\Hydromagic\FriesLandMapsiFries) | || Browse...
Write WKT projection file {*.prj)
Contour Options
[ ] Use the following level(s): <Level(s) separated by semicolons = Auta...
IJse the configured color ranges: J Show...
Ilge contour smoothing: Level 5 W
LIse this tool to generate one or more depth contours and save them as AutoCad DXF file,
g Use the "Select...” buttons to select a set of soundings and shorelines from the project.
# Cancel

Sounding data

Select from which sounding(s) you wish to generate the depth contours. By clicking the "Select..."
button, you will be able to select one or more

soundings that will be used to calculate the triangulation from which the depth contours will be
generated.

Shoreline data
Select which shorelines you wish to include in the depth contours calculation.

Shorelines can be used to append extra data near the shoreline, or to clip the depth contours along the
shore.

For more info on how shorelines can be used, please refer to the chapter "Entering Shoreline Data™.
Sounding channel

You can use this setting to select which data of the sounding is used to generate the contours.
This can be one of the following values:

¢ Depth recorded with the low frequency channel of your echosounder;
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¢ Depth recorded with the high frequency channel of your echosounder;

The difference in depth between the high and low frequency channel (Low - High);
The difference in depth between the high and low frequency channel (High - Low);
e Sensor data channel 1;

¢ Sensor data channel 2;

Sensor data channel 3;

The sensor data channels can be used to store either magnetometer data, information on reflectivity,
bottom loss or duration of the returned echo(s).

The data that each channel contains can differ, and depends on the echosounder plugin that was used to
record the data.

Clipping area

When a clipping area has been specified (by using a earlier created boundary), the contour lines will be
clipped at the point they cross the polygon of the boundary.

This way it is possible to only generate contours in a specified area. When the "No Clipping" option is
selected, there will be no clipping and the contours will cover the entire area of the sounding.

In addition to boundaries, you can also use shorelines to clip shorelines along the shore, or to generate
islands (or holes).

Contour levels

You can generate contours using a fixed lewel, or use color ranges. You can also combine the two
options. Using a fixed level can be useful, to display a reference line (for instance the dredging depth) to
see what's above and below this line. When using the color ranges, the levels displayed as colors will be
accentuated.

Contour smoothing

When generating depth contours from a TIN model containing large triangles, it happens often that sharp
edges appear in the contour lines.

To make the lines look more pleasant for the eye, you can enable the "Use contour smoothing" option to
use a B-Spline algorithm to smoothen the lines.

The level settings allows you to set the degree of smoothing. When using lewvel 1, just a little bit of
smoothing is applied, while level 9 applies the most.

A good value to start with is level 5. When contours are starting to cross, you might want to try a lower
level.

Layer name

The layer name can be edited to allow you to create multiple layers, for instance, a separate layer for
different fixed lewvels. Using the project manager, you can select which contours are visible or not.

File name

The generated contour lines will be directly written to an AutoCAD DXF file.
In order to proceed, it is mandatory to select an output file by clicking the "Browse..." button.

Finish
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When all settings are correct, click the "OK" button to finish the process. The software will now create
the TIN model, and generate the contour lines. You will have to wait a couple of seconds, depending on
the number of records your sounding contains. When ready, the dialog will disappear, and the contours
are drawn on the screen.

Managing Contours

Show / Hide contours

To temporary hide or show a collection of contour lines, just click the "eye" icon in front of the contour
name.
When hidden, the contour is still loaded, but just not shown on the screen.

Delete contours

To delete a collection of contour lines, look for the name in the "Project Explorer" and right click on it.
Select the "Remove Map..." option from the popup menu, and confirm the action.

Project Explorer o =

| 5. Project
=-@ [ Maps
. |1} 3T5SCHES.000

— D 1] [STS

s S R
click to show/hide 5@ [ ] Matrices &~ Zoom Map
contours
LoD B theo! )
I Map Properties...
I ¢ 3] ﬁ. Deng ﬁ:‘ B ;
E-@ L Soundin| @  Set Active
@ & Dend
.| Routes |l Show Map Attributes...
- || Waypoin
Y (=]

Remove Map... —
D || Comme Ji

click to remove contours
=@ || Boundaries

7.5 Volume Calculation (Matrix)
Volume calculation using matrix
The matrix volume calculation tool can be used in two ways: to calculate the difference in volume
between
two matrices (for instance, pre-dredge and post-dredge), or between a matrix and a fixed level.

This last option can be used to calculate the area and wlume of a pond or basin or tank.

In order to use this option for volume calculation, make sure you have converted
your corrected sounding to a matrix (see chapter "Generate and Display matrix" ).

This tool calculates wolumes by multiplying the difference between depth in matrix 1 and matrix 2 with
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the size of a single cell (Spacing).

Volume calculation tool

To start the matrix volume calculation tool, select the "Volumes (Matrix)" option from the "Tools" menu.
The following dialog will be shown:

Matrix 1

Matrix: | B FracPitl.xyz

Lewvel:

Matrix 2

Matrix: | B <Use Fixed Level>

Level: | 0.00 | m

Totals

area: %057 | f2 = 2

soacrg: | 100] m

Below Reference

ft3

Brea: | u.ut£| ft2

Above Reference

57 2

L b IJse this tool to calculate volumes and covered area from a sounding and a reference.
# To use this tool, itis required to generate a matrix from your sounding first.

B Repor..

Matrix 1

Use this setting to specify the matrix created from your sounding, or when using two matrices, the
matrix created from the post-dredge sounding.

Matrix 2

Use this setting to specify the matrix created from your pre-dredge sounding or a matrix created from a
3D cad file or channel design.
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In case you are calculate the volume of a basin or pond, select the "<Use Fixed Lewel>" option, and
enter the level of the water surface. When no tide correction is used, this value is 0.00.

Totals

This section will display the total area and volume for the whole sounding.
The processed area means the amount of overlap between the two matrices used.

When a fixed lewel is used, the owerlap is always 100% and the processed area will be the same as the
total area.

Below Reference

Area and wolume below the level found in Matrix 2
Above Reference

Area and wlume abowve the level found in Matrix 2
Calculate

Click the "Calculate" button to calculate area's and wolumes from the selected matrices.
Calculated values are split in totals, above reference (Matrix 2) and below reference (Matrix 2).

Report

Click the "Report" button to calculate area's and wolumes from the selected matrices.
This function creates a PDF report containing the calculated areas and wolumes.

By default PDF reports are generated under the "Reports"” folder in your project folder.

To view reports, you should have a PDF Viewer installed like "Acrobat Reader" or "FoxIt PDF Viewer".
Windows 8 and 8.1 users can use the build in "Reader" application as well.

7.6 Volume Calculation (Stages)
This wolume calculation is used to calculate the volume below various stages (lewvels) of water in for

instance frac pits and other resenwirs.
In order to calculate stages, you have to create a matrix from your processed sounding first.

Start the tool

To start the staging wvolumes tool, select the "Volume Calculations" => "Staging..." from the "Tools"
menu.
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The tool will open with the first or active matrix selected:

Volume Stages “
Matrix and Stages
Matrix: ﬁ FracPitl.xyz W Step: 1.00 Meters
Stage Depth Volume Volume Stages
1 0.00m 44341 m3 dibL T T I B e T s
2 1.00m SeoBAmIE | (i EE e =] " """"
3 2.00m 29595 m3 !
4 3.00m 23627 m3 i
5 4.00m 18570 m3 = |
6 5.00m 14165 m3 =
7 6.00m 10355 m3 =
8 7.00m 076 m3
9 8.00m 4358 m3 = T T T =1 1 1 T =1
10 9.00m 2266 m3 1040 H—— Ju, (R S J., [ — RO L
i1 10.00 m 844 m3 o b _______ ._ _______ ._ ______ _______ ._ _______ ._ ______ _______
12 11.00 m 185m3 | | | | | | | | |
13.00 - - - - - - - -
13 12.00 m Sm3 - =) = —= 5] 1 w w = = 7]
{=] (=) th [} h (=] h =2 Lh [=]
[ ] o (=] (=] [ o (=) (=] (=] [ (=]
o o (=] =] Qo (o] (=] (=] Q (=] Qo
g O O m|= O O O = O O
o (=) o o] [ (=) (=] = [ (=)
(== (=] = o (== o = o o
Vaolume
Use this tool to perform stage-volume calculations. Select a valid matrix as well as depth spacdng and dick the 'Calculate’
g button to update the results, In order to export the data to Excel, you can use the CSV file generated by the export function.
B| Beport.. |[E]| Ewport.. [®  Calculate

Adjust spacing

The spacing between the stages can be selected. The default value is 1.00 meter.

The interval can be selected in the "Step:" field and the minimum value is 0.1 meter.

After changing either the selected matrix or step, click the "Calculate" button to update the results.

Exporting to Excel

To export the calculated stages to Microsoft Excel, click the "Export..." button.
Next choose the file name of the exported data.

The data is stored as comma separated values (CSV) file which can be opened in most software.
Below is an example of the above data stored as comma separated values file:

St age, Dept h, Vol une
1, 0. 00, 44841
2,1.00, 36686
3, 2.00, 29595
4,3.00, 23627
5, 4. 00, 18570
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6, 5. 00, 14169
7,6.00, 10355
8,7.00, 7076
9, 8. 00, 4358
10, 9. 00, 2266
11, 10. 00, 844
12,11. 00, 185
13,12.00,9

Creating areport

In addition to Excel exports, it is also possible to generate a PDF report containing the calculated

stages.

To create a report, click the "Report..." button and supply the software with a valid PDF file name.

By default PDF reports are generated under the "Reports" folder in your project folder.

To view reports, you should have a PDF Viewer installed like "Acrobat Reader" or "FoxIt PDF Viewer".

Windows 8 and 8.1 users can use the build in "Reader" application as well.

il

HYDRON/\GIC

EvedSoftware Hydromagic Survey 7.0
Stages Report (Depth vs Volume)

Metadata

 Mame |
Project Hame Dominicanfep?
Sunveyor
Dale Wednesday, March 11, 2015
Harizontal Units Meters
Vartical Uniis Keters
Frojection WIS B4 ! UTH pone 190

Stages
1 00 m 44841 m3
2 1.00m J5685 md
k] 200 m 29698 m
4 300 m 23627 m3
-] 4,00 m 18570 m3
B 500 m 14169 m3
T .00 m 10358 m3
] 700 m 7078 m3
B 8.00 m 4358 m3
10 .00 m 2266 m3
11 10000 m B44 md
12 11,00 m 185 m3
13 1200 m am3

Changing units

To create a report in other units, for instance cubic feet instead of cubic meters, select the
"Preferences..." option from the "Options" menu and select the "Units and Formats" tab.
In this tab you can select other units for speed, area and wlumes.
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7.7

Preferences “

Map Miscellaneous Alarms ECDIS Grid
Units and Formats Devices Calibration RTE

Inits and Formats

Position Farmat: H DOD,DODODD W

Speed Units: MPH ¥

Area Units: Square Feet L*]

Volume Units: Cubic Feet v/
Horizontal Units: Meters

Vertical Units: Meters

MOTE:  Vertical units (altitude and depth), and horizontal units
{distance) depend on the selected local grid.

Depth and elevations

Display soundings as elevations when tide correction is used

[|reverse sign of elevation values in soundings

= |
= |

Volume Calculation (Sections)

This wolume calculation tool uses cross sections to calculate the total volume of a river section.

Please note that this method is only suitable in scenarios where the cross sections are almost the same
length.

To calculate the wlume, the difference between the depths or elevations is conwerted to an area and
multiplied with the distance between the cross sections.

To calculate wlumes for frac pits, reserwirs or ponds, we recommend the use of the Matrix method.
In order to use this tool, you should already have generated soundings and cross sections.

This tool can be used to:
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v’ Calculate the total volume of a river section;

v’ Calculate the amount of sediment by comparing the same soundings at low and high frequency;
v’ Calculate the wlume difference between two soundings, for instance, post- and pre dredging;

v’ Calculate the amount of volume to be removed compared to a channel design;

v’ Print graphical views of cross sections;

v Generate dredging wlume reports.

Volume calculation tool

To start the matrix volume calculation tool, select the "Volumes (Sections)" option from the "Tools"
menu.

The following dialog will be shown:

Volume calculation using cross sections

Data Selection

Pre-Sounding(s): | SNDGO0001; High Freg v || Select..
Post-Sounding{s): | <Mone selected, optional = High Freq w3 Select..
Shoreline(s): SHORELINEDDO1; . Select. .
Section: 0007 Next ‘Wl Depth Mode
200 Cross Section - 0007

3.60

ooo
ooel
0%'8Z
oo'se
oorss

12.00

o -~ o0 w0
&= & a gl
[, ] o h o
o (=] o o

You can use this tool to calculate volumes by the use of 'Cross Sections'. Set both soundings to the same selection to

¢ caloulate volume difference with the channel profile, or select two different soundings to calculate volume difference.
B  Report.. (- Print ... = | Save Images... w Close

Data selection

Which data has to be selected depends on how to use the tool.
Use the pre- and post soundings to select the soundings to use in the calculation.
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When you want to calculate the amount of sediment, you select the same sounding in both input boxes,
and select different frequencies.
In case you end up with negative values, just swap the selected frequencies or the values selected in the
"Pre-Sounding(s)" and "Post-Sounding(s)" fields.

For dredging wlumes, select the soundings created before the dredging operations in the "Pre-

Sounding(s)" field,

and the soundings created after the dredging operations in the "Post-Sounding(s)" field.

Seleet Sounding Data | x ||

. SMNDGOO0001
, SNDGO0002
. SMNDGO0003
, SNDGOO004
. SMNDGOO005
, SNDGO000S
. SNDGO000Y
, SMNDGOO00E
. SMNDGOO00S
, SMNDGO0010

CLAULLLLSRR S

&  Select Al

@ Select Mone

| @ Select Visble

ﬁ Cancel

The use of shorelines is optional. The same shorelines will be used for the pre- and post soundings.
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Select Shoreline Data H

o g SHORELINEDOO1
o |, SHORELINED0O2

&  Select Al & Select Mone || @ Select Visible

X Cancel

View cross sections

When the data has been loaded, you can check the result in the graph by using the "Prev' and "Next"
buttons.

When "NO DATA" is displayed in the graph, it means that there are no soundings or shorelines near the
cross section.

The pre sounding will be displayed in red, the post sounding in green, while the channel design is
displayed in blue.

You can click the "Depth Mode" button to switch between depth and elevation.
Reporting

To generate a wlumes report, click the "Report..." button.
Please note that this function does not work in the demo version of the software.

Next, you have to provide a location and file name for the PDF report to be generated.
By default PDF reports are generated under the "Reports"” folder in your project folder.

To view reports, you should have a PDF Viewer installed like "Acrobat Reader" or "FoxIt PDF Viewer".
Windows 8 and 8.1 users can use the build in "Reader" application as well.

Print
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7.8

When clicking the print button, graphs for all sections will be send to the printer.
Together with the PDF report generated, you have a full report on for instance the performed dredging
operations.

Save Images

To sawe all the graphs as image files, use the "Save Images..." option. This will generate image files
containing 4 graph views each in the specified folder.
These images can be used to include in other documents.

Entering Shoreline Data
Shoreline Data
The shoreline data option can be used to enter depth data for places you cannot reach using your vessel,

for instance, because the water is to shallow.
It can also be used to specify a line of equal depth, for instance where the water reaches the shore.

For instance, in the example below, you would set the depth for all points on the line to zero:
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Drawing a shoreline

In order to draw a shoreline using hand, for instance when it is possible to use a accurate map, select
the "Draw Shoreline" option from the "Cursor" menu.

Now you can click the points that make the line segments for the shoreline. When finished, just click the
right mouse button to store the line.

Shorelines will appear as green lines on top of your background map(s).

ol £ wRrE %

-

Entering Manually

When you want to enter the shoreline manually, for instance when you have measured the shoreline
coordinates from the shore using a RTK rover, right click on "Shorelines" in the "Project View" and select
"Add Shoreline".

The following dialog should now appear, allowing you to enter all measured coordinates in the
spreadsheet. Click the "Add..." button to add new records.
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Shoreline Properties

Mame: | SHORELINEDDD3

Water is RIGHT of shoreline (shoreline is drawn CW around the water)
[ |wateris LEFT of shoreline {shoreline is drawn CCW around the water)
[ ]1gnore Zdevels, uze shoreline as boundary or igland only

[ Ignore drawing direction, use shoreline as collection of Zdevels only

Slﬁrdne ﬁab

X-Coord
0.000
0.000
0.000
0.000

[ oK ]| X Cancel |

Setting depth values

When the shoreline connects points with the same depth value, for instance zero, you can set all Z
values at once by clicking the "Lewel..." button and entering the value.

<Enter Value:
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Modifying shoreline data

To modify the positions in shoreline data, you can use the mouse to drag and drop the positions on the
map.

When you want to modify positions manually, or you want to alter the depth values, you have to use the
"Edit Shoreline" dialog.

To open this dialog, right click on the shoreline you want to modify in the "Project View" and select the

"Edit Shoreline..." option.

.:'-(I:r Shorelines
..... .. j SHORELINEOO02

----- B sonungey

_____ LD e SHOREI_IN Zoom Shoreline
& | Set Active

/" Edit Shoreline...
& Remove Shoreline...

|

Applying shoreline data

Shoreline data can be used when generating matrices, and thus also calculating volumes (using
matrices).

When generating a matrix, you can specify which shorelines you want to include by clicking the
"Select..." button.

In the dialog that appears, check the shorelines you want to include and click "OK":
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7.9

Select Shoreline Data H

o g SHORELINEDOO1
o |, SHORELINED0O2

&  Select Al & Select Mone || @ Select Visible

X Cancel

Export to Google Earth
Introduction

KML (Keyhole Markup Language) is an XML format used by Google Earth to load overlays.
KML files can contain point, poly line and polygon data, as well as one or more references to raster

owerlays.
It is also possible to script complete Google Earth presentations into a KML file.

At this moment, Eye4Software Hydromagic supports point, line and polygon features, as well as
attributes, styles and ground owerlays.
Eye4Software Hydromagic is able to both import and export Google Earth KML files. This document

describes how to export them.
Exporting Data
In Hydromagic, it is possible to conwvert tracks, vector maps, matrices, boundaries, comments,

waypoints and sections to KML files.
When exporting a matrix, an image file is generated and loaded in Google Earth as a so called "ground
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overlay".

To start exporting data, select the "Export KML Data" from the "File" => "Export" menu as shown below:

Import L4
Export *| [y Export ASCIl Data...
§ | 63 ENC Permits.. O] PPt DEE DR«
&Y Export KML Data...
_ FIRE. SR B Export Current View...
[m | Print Preview T ™

Selecting data to export

In the dialog that appears, you will see a list of all items that can be converted to KML.
Just check the items you wish to export. By default, all visible items are selected.
To reset the selection, click "Select None", to select all items, click "Select All".
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Select Items

[ Maps
|_| Matrices

o B Frachitlyz
|| RawData

& -, RAWO0DO1

o . RAWDODO2
| Soundings

& -, SNDGODOO1
[ waypaints

& W WPTDO1
|_| Comments

o "0 Hello World |
|| Boundaries

o [ BOUNDARYOOO1
|_I Sections

@ SelectMl || @ SelectNone | @ Select Visble

Output Options
Filename: | <dick 'Browse...' to select an output file > | | || Browse...

After exporting data, show file in Google Earth

Itis recommended you to save Google Earth data as KMZ file when it contains matrices.
This allows you to distribute the Google Earth data as a single {compressed) file.

[ 0K ]| % Cancdl |

Select output file

The next step is to select a location to store the exported data. You can sawe the data as KML or KMZ
file. Click the "Browse..." button to open a sawe file dialog, and enter the name for the file. In the sawe file
dialog, you can also choose between the "KML" or "KMZ" formats. When you choose to export a matrix,
the file extension will default to "KMZ" which allows you to store the KML and image data into a single
KMZ file.
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@ + 4 | « DemoProject » Maps v O Search Maps e

Organize = Mew folder B ow @

“.r Favorites Date modified Type

Mo items match your search.
B Desktop

File name:

Save as type: | Google Earth KMZ Files (*.kmz)

Google Earth KML Files (*.kml)
Google Earth KMZ Files (*.kmz)

% Hide Folders

KML Format

When using the KML file format, a KML file is generated as well as an image file (PNG) for each
exported matrix. The image files are stored in the same folder as the location of the KML file.
When not exporting matrices or large amounts of vector data, KML is probably the best option for you.

KMZ Format
If you are going to export matrices, or large amounts of vector data, KMZ is the best choice.
A KMZ file is a zipped archive containing a main KML file (doc.kml) and, in case of exporting image data

such as matrices, some image files.
When using the KMZ file format, you can always transfer the data by distributing a single KMZ file.

Exporting the data
Just click "OK" to start the export. For small files, this takes only a couple of seconds, for large projects
it can take a couple of minutes. You can watch the progress in the status bar at the bottom of the

screen.

Examples of exported KML files
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¥ Search
Search |
ex: 37 25.818'N, 122 05.36' W
Get Directions History
¥ Places
; Q My Places
- @E Temporary Places

m (s +]a]
¥ Layers Earﬂ.l.GaI.l.erv »
4 F!l@ Primary Database

s & 'P Borders and Labels

i Places

'f’ ¥ = photos

- [[= Roads

> E ’m’ Weather

s D\é}_‘ Gallery

s D@ Global Awareness
b DD More

Tour Guide % 20

Example of a single matrix exported as KMZ file

3
(.mugh_' e
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-
&5 Google Earth =
File Edit View Tools Add Help

¥ Search

ex: 37 25.818'N, 122 05.36' W

Get Directions History

¥ Places
; Q My Places
» @& Temporary Places

¥ | |+ + ||lez"]
¥ Layers Earth Gallery »»
# @@ Primary Database

el 'P Borders and Labels
Places

b+ ¥ = Pphotos

- [[= Roads

t (D 30 Buildings

g v Ocean

(| ’m’ Weather

g E\}? Gallery 3 » ogle

s D@ Global Awareness U Image € \erodata International S C 2O ):.\J(_' earth

> [ [ Mare

Tour Guide % | 2005 |Imagery Date: t 52.9 lon 5.530416° elev -7t eyealt 4164 ft.(

ILExampIe of a single matrix with vector Ch-art exported as KMZ file
7.10 Exportto CAD

Introduction

After a sounding has been completed, it is possible to export both the background map (vector maps

only), and the regularly spaced soundings (matrix) to an AutoCAD DXF file for further processing.

AutoCAD DXF files can be opened using AutoCAD, or you can use other CAD software such as QCad,

or import the data in other GIS packages.

After you have created a matrix of your sounding, sections or map, you should have something like this:
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N —|
100

Starting the DXF Export tool

The DXF Exporting tool can be started by selecting the "Export" => "Export DXF Data" from the "File"

menu.
The following window should appear:

i

Export to AutoCad DXF

===

Output Settings
Map: |E& VERGWEST.DXF x
Matrix: fEH VERGWEST. XYZ ¥
Filename: <dick 'Browse’ to select an ou L\ Browse
|:| Export Map Texts
Please select the coordinate system used in the output file, .@
Select by dicking the "Select...” button., Select...
Currently selected:  Amersfoort [ RD Mew
¢ ok ][ ¥ cancel |
b
Map
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The background map can be selected using the first selection box. You can also choose to export only
the depth information by selecting the "Do not export a map" option.

Please note that not all background maps can be exported to AutoCAD DXF. Only vector charts like S57
ENC, ESRI ShapeFile, DXF, Microstation DGN and ARC/INFO can be used.

The matrix can be selected using the second selection box. In case you want to export the map only,
you can select the "Do not export matrix" option here.

In the third input field, you have to select the file name of the CAD file to be generated. This file should be
a valid file name at an accessible location with the extension ".DXF".

When your background map contains a lot of text, it is recommended to turn off the "Export Map Texts"
function, to prevent the map text from interfering with the depth values.

If needed, you can write the DXF file using another local grid by changing the grid displayed at the
bottom of the window. By default, the current local grid is used.

When all parameters are setup correctly, click "OK" to start the export. A progress indicator will appear
at the bottom at the screen, and the window will close after a couple of seconds.

You can now open the DXF file in most CAD programs, it is also possible to use the generated DXF file
as a background map in Hydromagic.

Opened in a CAD editor, the result will be (depending on your settings):

164200

T

pened in QCad
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7.11

75

Opened in Hydromagic

Export current view
Introduction

Using Hydromagic, it is possible to save your current map view (including overlays like tracks, photos,
comments, waypoints and routes) as an image file. The software can also generate the world and
projection files for you, so you will be able to load the image file directly in other GPS or GIS mapping
software, without the need to calibrated the map. For exporting, the following vector map formats are
supported:

Graphics Interchange Format;
Portable Network Graphics;
JPEG Image Files;

Tagged Image Format Files;
Windows Bitmap Files.

NENENENAN

Loading the source data

In order to load the map, used as background, select "Import" => "Import Map..." from the "File" menu.
Because the map is just exported as an image file, all formats can be used. Please not that attribute
information is not saved on export, because a simple image format is used.

After loading the map, you can add overlays, like photos, comments and waypoints. To import such
owerlay data, select "Import" => "Import GPS Data..." from the "File" menu.

Hydrographic data such as soundings, matrices, cross sections and boundaries will also be visible in the

© 2015 Eye4Software B.V.



Post Processing

192

exported final product.
Exporting the view

In order to export the current map view, select "Export" => "Export Current View..." from the "File"
menu.

;  File | Edit View Tools Options Survey MNavigation Cursor Help
||| mport Map.. LI ey
;q Download Map... - o X
| 1 Mew Project. Ctrl+N
£+ | Open Project... Ctrl+ O
= save Al Ctri+5
Import b
. Export M| [ Export ASCII Data...
| 563 ENC Permits.. B ErposE DR Dok
: & Export KML Data...
PH. s | Export Current View..,
ﬁ Print Preview T ™

Export Current View Dialog

After a few seconds (needed to capture the image), the following dialog will appear:

Destination

Format: | Portable Metwork Graphics (*.pnag) W |
File: | Ci\Templexport.png | | |_T-:.L Browse...

Export Cptions
Generate World File Generate ESRI WKT Projection File
Show image after export [ | Generate PROI.4 Projection File

| You can use this tool to export the current view as an image file. Enabling a world
and projection file, allows you to import the data in other (GI5) mapping software.

(¥ 0K | X Cancel |

Output file
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First, you have to select the output format and the filename of the image file. After selecting the format,
use the "Browse..." button to select the folder and file name.

In cases where you want to import the exported image file into another GPS or GIS mapping software
product, you have to enable this option. The software stores the upper-left coordinates and the pixel
sizes (scale) in the world file. Depending on the image format you are using, the world file will have the
following file extension:

GIF World File - gfw;
PNG World File - pgw;
JPG World File - jgw;
TIF World File - tfw;
BMP World File - bpw;

AN NN

3.726715

0

0

-3.726715
242435. 599588
476855. 346680

sample world file

The software can generate a ESRI WKT or PROJ.4 projection file for you. Together with a world file for
geo-referencing the image, this enables the screenshot to be imported in most GPS/GIS software
packages.

The generated projection file will always have the ".prj" extension, irrespective of the selected format.

PRQICS[ " Aner sfoort / RD New',
GEOGCS[ " Aner sf oort ",
DATUM " Amer sf oort ",
SPHEROI D[ " Bessel 1841",6377397. 155, 299. 1528128,
AUTHORI TY[ " EPSG', "7004"]11],
AUTHORI TY[ "EPSG', "6289"]],
PRI MEM " Gr eenwi ch", O,
AUTHORI TY[ "EPSG', "8901"]],
UNI T[ " degree", 0. 01745329251994328,
AUTHORI TY[ "EPSG', "9122"]],
AUTHORI TY[ "EPSG', "4289"] 1],
UNI T["metre”, 1,
AUTHORI TY[ " EPSG', "9001"]],
PRQIECTI ON[ " Obl i que_St er eogr aphic"],
PARAMETER[ " | ati t ude_of _ori gin", 52. 15616055555555] ,
PARAMETER] "central _meridi an",5. 38763888888889] ,
PARAMETER] "scal e_factor", 0. 9999079],
PARAMETER[ "f al se_easti ng", 155000] ,
PARAMETER[ "f al se_nort hi ng", 463000] ,
AUTHORI TY[ "EPSG', "28992"],
AXI S[ " X", EAST] ,
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8.1

AXI S[ " Y", NORTH] ]

sample ESRI WKT projection file
Exporting the map
Just click "OK" to start the export. The software will now write the selected files. You can monitor the

progress in the status bar at the bottom of the screen. Depending on whether you checked the "Show
image after export" the created image will be shown in the Windows Photo Viewer.

Utilities
License Updater

Hydromagic Licensing

Licensed versions of the Eye4Software Hydromagic software are protected against unauthorized use with
a dongle or hardlock device.

When purchasing of the software, a dongle will be shipped to you containing licenses for the products
you bought, and for the most recent versions only.

When you decide to purchase an additional product later (for instance, adding a surwey license to a
dredging package), an additional license has to be added to the dongle.

To do so, the "License Updating Tool" is required to add this license to the dongle remotely, so we do
not have to provide you with a whole new dongle.

License Updater

The tool is installed in the "Program" folder under the installation folder of the software.
It can be started using Windows Explorer, or by locating the software under the Windows Start Menu.
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Eye4Software Hydromagic - License Updating Tool

Select Hydromagic dongle to update

Serial Mo: L§ 23308763 W -’j'__:*;; Befresh
License Files
(®) Generate a license request for us

Filename: <Click 'Browse..." to select a file = . Browse...

() Import a new license which has been emailed to you:

<Click 'Browse..." to select a file > Browse ..

HYDRONM/\GIC

Adding alicense

In order to add a new license to your existing Hydromagic dongle, purchase from your local reseller, or
using the sales page on our website.

In case you want to upgrade the software you are using to the latest version, all you need is a valid
support contract.

After purchasing the license, you have to email a license request file to us.
This request contains the encrypted contents of your dongle, and is needed to add licenses.

To generate a license request, select the "Generate a license request for us" option, and select an
output file.

It is recommended to store the file in the "My Documents" folder using the default name as displayed in
the "Sawe As" dialog box.

Click the "Sawe" button to select the file, and click the "Start" button to generate the license request file.
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v Save As “

T :3 ¢ Libraries » Documents v & Search Documents 0
Organize « Mew folder S 7]
bl Eaniiis Mame Date modified Type
Carmntasia Studio 310/2015 &57 PM File folder
| I B Desktop . Custom Office Templates 3/8/2015 3:56 AM File folder
. Hydromagic 3/16/2015 %32 AM  File folder
. My HelpAndManual Projects 3/8/2015 231 AM File folder
) Wisual Studio 2013 3/8/2015 205 PM File folder
£ 4 >
File pame: | 2-2308763.WibuCrmRaC W
Save as typer | License Context File (" WibuCmRac) L

= Hide Folders Cancel

Emailing the license request

After the license request has been saved, you have to email the license request file ( .wibuCmRaC
extension ) as an attachment to our support desk at support@eye4software.com.

You will receive the license after it has been processed by our staff. Please note that this is a manual
process so it can take up to 24 hours until you receive the email with the license update.

Applying the license update

After receiving the email with the license update file ( .wibuCmRaU extension ), please sawve the
attachment to a folder accessible to the license updating software, for example your "My Documents"
folder.

If you have closed the application in the mean time, just start it again. This time you have to select the
"Import a new license which has been emailed to you" option.

Next, click the "Browse..." button to locate the received license file and click "Open" after you selected
the received file.
Now click the "Start" button to program the new license(s) in your Hydromagic dongle.
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S Open | = |
T I;,D ¢ Libraries » Documents » v & Search Documents 0
Organize + MNew folder == - I @
ol Eriias Mame Date modified Type
Camtasia Studio 3/10/2015 8:57 PM File folder
| I B Desktop | Custom Office Templates 3/8/2015 3:56 AM  File folder
Hydromagic 316/20159:32 AM File folder
My HelpAndManual Projects 3/8/2015 2231 AM File folder
; Visual Studic 2013 3/8/2015 5:05 PM File folder
=y 2-2308763.wibucmrau 3/8/201511:36 AM  WIBU Control File
€ >
File name: | 2-2308763 WibuCmRal w| |License Update File (" WibuCm v
8.2 Geoid Converter

Geoid Conversion

The "Geoid File Conversion Utility" is a freeware utility which can be used to convert geoid files between
different formats.
The utility is shipped with Hydromagic, but can be used as a stand alone tool as well.

The main goal of the software is to enable Hydromagic users to convert their geoid files to a format which
can be read by the Hydromagic software.

There are so many different geoid file formats around that we decided to use our own format, and create
an external tool to get files converted to our internal format.

The following geoid file formats are supported (both reading and writing):

v Eye4Software Geoid File Format (GEO Files);

v Trimble Geoid File Format (GGF Files);

v’ Carlson Geoid File Format (GSF Files);

v'US National Geodetic Survey (NGS) File Format (BIN Files);
v Natural Resources Canada Files (BYN Files);

v’ Surfer V6 Binary Grid Files (GRD Files);

v ASCIl Geoid Files.

Geoid Converter

The tool is installed in the "Program" folder under the installation folder of the software.
It can be started using Windows Explorer, or by locating the software under the Windows Start Menu.
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(% Eved4Software Hydromagic - Geoid File Conversion Utility H
Source File
Format; Hydromagic Geoid File (*.geo) W
Filename: = Click 'Browse..." to select a file» | Browse...

Destination File

Format: Hydromagic Geoid File (*.geo) W

Filename: <Click 'Browse..." to select a file > | Browse. .

HYDRON/\GIC TR

Converting Files

Converting geoid files with the Geoid File Conwersion Utility is very straightforward. All you have to do is
to select a source and destination format.

You can use any combination of source and destination formats (although it doesn't make sense to set
the source and destination formats to the same).

After selecting the formats, use the "Browse..." buttons to select an input and output file.

In order to use geoid files in Hydromagic, the destination file has to be written in the Hydromagic
"Geoids" folder which is selected by default.

For destination files other then the Hydromagic Geoid Files, you can select another location as well.

When done, click the "Start" button and the conversion process should start. Converting files usually
only takes a couple of seconds.

ASCII Files

The Geoid File Conversion Utility supports two kinds of ASCII geoid files at this moment.
Because there is no real standard for ASCII geoid files, the supported files are described below:

ASCII Geoid Height Grid File (*.grd)

You should use this option for a file which contains a header value contained by separation values for
each cell.

The header contains six values in the following order: South boundary, north boundary, west boundary,
east boundary, vertical cell size and horizontal cell size.

27.00000 36. 97500 -14. 00000 - 0. 02500 0. 02500 0. 02500
5155.7383 52. 342 52. 302 52. 257 52. 205 52. 147 52.073
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51. 864 51. 742 51. 619 51. 498 51. 378 51. 261 51. 144
5158?816 50. 805 50. 695 50. 588 50. 484 50. 391 50. 301
505%?%22 50. 029 49. 930 49. 821 49. 700 49. 571 49. 437
4943??55 49. 006 48. 853 48. 697 48. 539 48. 379 48. 220
4849?812 47.767 47. 631 47.503 47. 385 47.275 47.175
j;4§:§98 46. 917 46. 838 46. 760 46. 682 46. 606 46. 534

This option is used for geoid files which consist entirely out of ASCIlI XYZ pairs as shown in the example
below.

These files do not have a header and calculate the number of rows, columns, boundaries and cell sizes
directly from the XYZ records in the file.

41449. 795 3845328. 858 24. 700
43449. 799 3845328.878 24.613
45449. 803 3845328. 897 24.516
47449. 807 3845328. 916 24.429
49449. 811 3845328. 935 24. 342
51449. 815 3845328. 954 24. 255
53449. 819 3845328. 973 24.178
55449. 823 3845328. 992 24.091
57449. 827 3845329.012 24. 004
59449. 831 3845329. 030 23.917
61449. 835 3845329. 049 23. 830
63449. 839 3845329. 068 23. 743

Plugins

9.1 Hydromagic Simulator Plugin

The Hydromagic Simulator Plugin is a plugin with graphical user interface designed to simulate various
types of hardware.
This allows you to test drive or demonstrate the software without the need to connect actual hardware.

v GPS Position;

v’ Speed over ground;

v True heading;

v Echosounder depth (high frequency);
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v Echosounder depth (low frequency);
v Vertical ladder (inclination) sensor (dredging);
v Horizontal ladder (yaw) sensor (dredging).

It is possible to simulate tide as well, using the manual tide buttons in the main toolbar.
The simulator can be used in both Hydromagic Suney and Hydromagic Dredging.

Loading the simulator plugin

To load this plugin, open the preferences window by selecting "Preferences...” from the "Options” menu.
In the window that appears, select the "Devices" tab. Next click the "Add..." button.

Map | Miscellaneous | Alarms | ECDIS
Units and Formats | Devices | Calibration

Device

.-_;') Remove... || & Corfigure.., | B2 Monitor...

|| Cancel

A list of available plugins will be displayed. In this list, select the "Hydromagic Simulator Plugin" and
click "OK" to load and display the simulator.
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Driver

CEE HydroSystems CEESCOPE plugin

ELAC Hydrostar LAZ4300 Echosounder Plugin
ELAC LAZ4100 Echosounder Plugin

Garmin LISE PYT plugin for Hydromaagic
Geodimeter Total Station Plugin
Hydromagic AIS plugin

Hydromagic LadderSensor Plugin £1
Hydromagic LadderSensor Plugin £2
Hydromangic LadderSensar Plugin #3
Hydromagic MMEAD183 plugin #1
Hydromagic MMEAD 183 plugin #2
Hydromagic NMEAD183 plugin #3
Hydromagic MMEAD 183 plugin #4
Hydromagic Simulator Plugin

InnerSpace 443 Plugin for Hydromaagic
Knudsen 320 Plugin for Hydromagic
OceanSdence Z-Boat Plugin for Hydromagic

Odom DigiTrace Plugin for Hydromagic
Nidnm FrhnTrac SETMRT Bloain frr Hedramanic

Filename

Ceescope.dl
LAZ4300.dll
LAaZ4100.dll
garminush, dll
Geodimeter.dll
als.di
LadderSensor 1.dll
LadderSensor2.dll
LadderSensor3.dll
nmez000 1. di
nmeaioo 2, di
nmead003. di
nmead004. di

Version

7.0.64. 50225
7.0.64. 50225
7.0.64.50225
7.0.64.50225
7.0.64. 50225
7.0.64.50225
7.0.64.50225
7.0.64. 50225
7.0.64.50225
7.0.64. 50225
7.0.64.50225
7.0.64. 50225
7.0.64.50225

Simulatar, dll 7.0.64. 50225

InnersSpace44s.di
Knudsen320.dll
zhoat.dl

DigiTrace. dll
FrhnTrac All

7.0.64.50225
7.0.64. 50225
7.0.64. 50225

7.0.64,50225
70 A4 GN7IE

Lo

Using the simulator

|&# 0K | ¥ Cancel |

In order to start pushing the simulator data into the application, click the "Start" button.
To stop the simulation press "Stop". When started, the simulator will send data with 500 millisecond

intervals.
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Initial Pasition

Longitude: | E 004.11188800" | gmmm
DD, MM. MMM
|

()DD.MM.55.55

Latitude: | M 51.92553500

Movement

Heading: : % dearees

[=]
=] knots

=]
= meter

=]
=] meter

[=]
0.5 =] degrees

[=]
0.5 =] degrees

Heave: 0.15 % meter

Ladder Sensor {Dredging)

Vertical: 0.0 % dearees

Yaw: 0.0 % dearees

Click the "Reset” button to return to the initial position.
When simulating a ladder sensor, make sure this
plugin is configured under the dredging settings !

Stop @  Heset

Unloading the simulator

To unload the simulator, open the preferences window by selecting "Preferences..." from the "Options"
menu.

In the window that appears, select the "Devices"” tab. Next select the "Hydromagic Simulator Plugin™ and
click the "Remowe" button.
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